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Pref ace 

The SunView 1 Beginner's Guide helps you get started using Sun View windows 
whether you're a brand-new user or an expert. This manual is organized in two 
sections: 

o The Lessons section takes you step by step through some of the most impor­
tant window operations. You'll acquire a working knowledge of Sun View 
and be able to perform useful work when you're done. 

o The Reference section describes SunView fully, including many advanced 
features that are not covered in the lessons. After you're comfortable with 
the contents of the lessons, it's a good idea to read the Reference section 
carefully to add additional skills to your repertoire. 

If you 're new to SunOS™ and UNIXt operating system commands, make sure 
you read Getting Started with SunOS: Beginner's Guide before you begin this 
manual. 

If you 're new to window-based systems, the lessons will get you started editing 
text and using SunOS command interpreters in a window environment. Win­
dows are fun to work with- don't be afraid to try things out! The lessons pro­
vide a painless way to get started. 

Other manuals for beginners are: 

Mail and Messages: Beginner's Guide 
Doing More with SunOS: Beginner's Guide 
Using the Network: Beginner's Guide 
Setting Up Your SunOS Environment: Beginner's Guide 
Self-Help with Problems: Beginner's Guide 

If you 're an experienced user, you'll probably want to jump rightin ... ancl YO.U. 
can. But do take time to skim the Reference sectionso you \V()n'tl11iss o\ltbn 
some of Sun View's most attractive new features. You '11 find additional iriforma.~ 
tion on SunView and its tools in the SunOS Reference Manua/,.alsok.nowna,&the 
"Man Pages." The SunOS Reference Manual is available orilme t1lr6ughthefoan 
command. 

t UNIX is a registered trademark of AT&T. 
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PART 0 E: LESSONS 





1.1. Starting Sun View 

The command prompt that appears 
throughout this manual is venus%. 

Figure 1-1 

1 
Getting Started with Sun View 

Sun View is a window-based environment that lets you run Sun OS command 
shells, editors, debuggers, and other tools, each in its own window or "frame." 
Sun View lets you look at several files or directories at the same time and run 
several commands at the same time. 

This lesson teaches you how to: 

o Enter the Sun View environment from a Sun OS command line. 

o Use the three-button mouse. 

o Work with icons, frames, windows, and menus. 

o Select and edit text. 

o Create and save a file. 

o End a work session. 

To bring up Sun View: 

o Reply to the command prompt by typing the commands cd (for change 
directory) and sunview, as shown in Figure 1-1. Press the [Return) key 
after each command. 

Starting Sun View from a SunOS Command Line 

The cd command puts you in your home directory before starting Sun View. The 
illustrations in this manual will be easier to follow if you start Sun View from 
your home directory. 

For more information on cd and other SunOS commands referred to in this 
manual, see the SunOS Reference Manual, which is also available online through 
the man command. 

After a few seconds the screen turns gray and images appear one by one. This is 
the SunView startup screen. The top part of the screen is shown in Figure 1-2. 

SU 
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4 Sun View 1 Beginner's Guide LESSONS 

Figure 1-2 

The rest of the startup screen is gray. The gray part is known as the background. 

Top of Sun View Startup Screen 

D "'-''-'•-AU'U.LV frame 

D A icon (a clock face -

your 

messages are usually displayed). 

move to display the time). 

o A Command Tool icon (a nautilus with scrollbar). 

o A Text Editor icon (a document a pencil). 

o A Mail Tool icon (a mailbox - the flag is up when there's mail for you). 

Each of the images is aframe belonging to a tool, or window application pro­
gram. The Console frame is open, and the other frames are closed. In other 
words, open frames display windows and closed frames are represented by icons. 
You'll hear more about closed frames later in this lesson. When a frame is open, 
its windows are ready to receive input from the keyboard and mouse. You can 
close a frame to an icon and the command it's processing continues to process. 

Frames can contain several windows. The Text Editor frame, which you '11 be 
learning about throughout this manual, contains two windows. The Console 
frame, described in the next section, contains only one. 

sun Revision A of 9 May 1988 
microsystems 



1.2. The Mouse and the 
Pointer 

Figure 1-3 

Started with Sun View 5 

'-"<J•'•>Jt.J, ...... is a Command (a tool that contains a command interpreter) 
with a special function: this is where the SunOS operating system, Sun View, and 
some applications display messages. For example, if you 're having network 
problems, the error messages appear in the Console window. That's why it's a 
good idea to leave the Console just as it is at startup. If you need a Command 
Tool, you can always open another one. You'll find out how to do this in a few 
pages. 

Look in the middle of the screen for a black arrow pointing "northwest." 

The Pointer 

This arrow is known as the pointer. The mouse moves the pointer around the 
screen so that you can open icons, bring up menus, select text, and perform other 
Sun View tasks. 

First make sure the mouse pad (the silver plate with the blue grid) is on the right 
of the keyboard with its wide side facing you. Place the mouse on the mouse 
pad: buttons up, red light down, perpendicular to the wide side of the pad. 1 

To move the pointer, move the mouse around on its pad and note the correspond­
ing movement of the pointer on the screen. Try that now. Your fingers should 
be resting comfortably on the mouse buttons, with the "tail" facing away from 
you. 

The pointer can take many shapes. No matter what shape the pointer is, it can be 
moved by the mouse. 

1 This description of the optical mouse doesn't apply to the mechanical mouse. If you have a mechanical 
mouse with a rolling ball on the bottom, you don't have to align the mouse to the pad. 

Revision A of 9 May 1988 
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Figure 

Left-Handed Mousing 

What to Do When the Pointer 
Won't Move 

The Mouse Buttons 

Moving the Mouse on Its Pad 

If you 're left-handed, you can use the mouse on the left side of the keyboard. 
You can also change the function keys so that the functions are accessible from 
the right side of the keyboard. With left-handed mousing, the LEFT mouse button 
is the one under your index finger, closest to the keyboard. See Chapter 4, All 
About Keyboards, in the Reference section for more information about Sun View 
options for left-handed users. 

If the pointer doesn't respond to the mouse, moving the mouse rapidly in 
large circles on the pad several times. This initializes the mouse. It should then 
start to control the pointer position. 

If the pointer still won't move, check to make sure the mouse is plugged in to 
your workstation without a loose connection. If that fails to solve the problem, 
unplug the mouse from the workstation and plug it in again. 

If the mouse still doesn't work, the mouse or the workstation may be defective -
contact your System Administrator. 

Here's how the three-button mouse works: 

o The LEFT mouse button - LEFT for short - is used mainly to select text, 
open icons, and push buttons in panels and alert windows. 

o The MIDDLE mouse button - MIDDLE for short - is used mainly to extend 
or adjust a selection, move a frame or icon, and scroll in a window. 

o The RIGHT mouse button - RIGHT for short - is used mainly to bring up 
and choose from menus. 

There are two actions you can take with a mouse button: click or hold down. To 
try the buttons, first move the mouse so that the pointer moves into the Console 

sun 
microsystems 
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To bring up a menu, hold down the 
RIGHT mouse button. 

Figure 

Started with Sun View 7 

the screen. 

gray background, the MIDDLE mouse button, 
can do this as many times as you like. Noth-

o With the pointer over the gray background, hold down the MIDDLE 

mouse button by pressing it (you'll hear a single click) and not releasing. 
Move the pointer around while continuing to hold down the MIDDLE mouse 

change as it moves over on 
re1em;e the mouse button. 

Holding do\\-TI the mouse button while moving the pointer is a ..,....,,, ..... ..., ..................... .. 
using in 

Read this section you the instructions it contains. It's 
them exactly to avoid choosing a menu action you didn't intend to"' .... ,..,...,""'· 

tools don't show you a menu until you request one. The location of the 
IJ'V.LJLI. .. ..., .. determines which menu comes up. 

o With the pointer in the white part of the Console window, hold down the 
RIGHT mouse button. Don't let go until you either choose a menu action or 
dismiss the menu without making a request - you'll leam how in this sec­
tion. 

Bringing Up a Menu 

File '* 
Edit :::i-

!ll'ill!!!!!'!!!ll!l'!!!!l!!!lll!!!!!!!!!!!!!!!!!!l!l!l!iiiiiiii .. ;:: ~=:des : 
Figure 1-5 shows a menu- a list of actions you can request. The 'Display=:)' 
menu item is highlighted. 

When a menu item is highlighted, it's ready to be chosen. Highlighted text is 
displayed in inverse video (white characters on a black background). 
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Sun View 

To dismiss a menu- close it without 
taking any action - move the 

off the menu so that no 
h1nhl11"11htc~r1 then 

D 

D 

menus. 

0 

D 

menu, move over 
re1 1eas:e the mouse button. But don't do that 

Now 

you 
..,., ..... uvr• cJviarne1"'s assume you have nor-
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Figure 1-6 

Figure 1-7 

Started with Sun View 9 

The Frame Menu 

i!l!!l!!l!l~I·!!l!!!!!!l!!!!l!l!!!!!!!!!!!!!i!!l!!ii!i!i!i!!:!l.:. _~l;n~~--~-1 !_~~_-p_l_a_y_!i!i!li!i!i!i!i!1i!i!iii!!!!l!~~1!!!i!i!!!i!i 
When you bring up a menu, the pointer changes shape again. It's now pointing 
direct! y "east." 

o Still holding down the mouse button, move the pointer slightly to the right 
until one of the menu items is highlighted. 

o Now move the IXJinter slowly up and down the list. Different items are 
highlighted. 

To close the Console frame, choose 'Close' from the Frame menu: 

o Move the pointer over the 'Oose' menu item to highlight it. 

o Release the mouse button. The frame closes to an icon like the one in Figure 
1-7. 

Did you notice that lines flashed from the comers of the Console frame to the 
place where the icon is now? You'll see a similar effect when you open an icon 
- lines temporarily flash from the comers of the icon to the place where the 
open frame will be. These flash lines will help you locate the frame or icon on a 
crowded screen. 

The Console Frame Closed to an Icon 

The Console icon went to the top of the screen because SunView's default icon 
gravity is north. The icon gravity determines which edge of the screen an icon 
will "fall" toward you close its frame. You can change the icon gravity by 
using the Defaults Editor, in Chapter 10. 
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Toggles 

Grayed Menu Items 

Now bring the Text Editor's Frame menu. You've already learned how to do 
this: 

o Move the pointer over the Text Editor icon so that the pointer becomes a tar-
get. 

o Hold down the RIGHT mouse button. The Frame menu pops up. 

This is the standard way to get a Frame menu. From now on we'll just say, 
"Bring up the Frame menu." You can do this whether the tool-(the Console, 
the Text Editor, or any other Sun View application - is open (in window fonn) 
or closed (in icon fonn). 

The Frame menu for the Text Editor icon has 'Open' at the top, while the Frame 
menu for the Console frame has 'Oose' at the top. 'Open' and 'Close' toggle 
back and forth. You only see one aspect of a toggle at a given time. After you 
choose it, its opposite is listed in the menu. Toggles are common in Sun View in 
menus and function keys, so you'll be hearing more about them. 

o Dismiss the Frame menu by moving the pointer off the menu (usually left­
ward works best) until no menu item is highlighted, then releasing the 
mouse button. 

You the menu item in the Frame menu is in gray, 
not black, '\Vhen a menu item is gray, not available. It 
AAAJ:-,,AAAA.f""!AA .. when you and can't choose it. 

in case 

0 up the Console Frame menu. 

D 

To choose a menu From now we'll the Frame menu." 
the item and release the mouse but-
ton. o Now 

menu. 

menu. 

the Text 

has own Frame menu, and 

With the Console and the 
ure 

from Text Frame 

the screen should look like 
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The Text Editor Frame 

Table 11-1 in the All About Tools 
chapter contains a list of Sun View 
tools and their corresponding com­
mand names. 

Text Windows 

Let's begin by taking a look at how the 
screen. 

1 - Getting Started with Sun View 11 

Text Editor frame appears on the 

Like the Console, the Text Editor tool has a frame with a frame header at the top. 
The name of the tool appears on the left side of the frame header. The name 
shown is the command name by which the tool is known to the SunOS system. 

Unlike the Console frame, which contains only one command window, the Text 
Editor frame contains two text windows shown in Figure 1-8: 

o The small scratch window just under the frame header is used as a work area 
for filenames, directory names, and other short text items. 

o The large edit window below the scratch window is used to display the file 
you 're editing. The text in the edit window is known as the document. 

Figure 1-8 An Open Text Editor Frame 

The scratch window and the edit window are both text windows. Each has 
slightly different properties, but they have a lot in common. 

SU 
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The Text Menu 

Previewing a Menu 

Guide LESSONS 

One thing all text windows have in common is the Text menu. Almost every­
thing you learn about working with the Text Editor can be applied to text win­
dows in other tools. The Mail Tool has two or more text windows, the Defaults 
Editor has one, and so on. Although the Console window is a command window, 
it also has a Text menu. The Text menu in command windows contains some 
additional menu items. 

If the menu associated with a window looks like the one in Figure 1-9, it's a Text 
menu. (The resemblance doesn't have to be one hundred percent. The Console 
window's Text menu contains an extra line, but it's still a Text menu.) All Text 
menus contain 'File=>', 'Edit=>', 'Display=>', 'Find=>', and 'Extras=>' menu 
items. 

To preview a menu, hold down the RIGHT mouse button, then highlight the menu 
items. When you 're finished previewing, either choose a menu item or dismiss 
the menu. 

One reason for previewing is to examine the pull-right menus. A pull-right menu 
is a menu that belongs to a menu item with a pull-right symbol(=>) at the end of 
its name, such as 'File=>'. 

o To preview a pull-right menu, highlight the pull-right menu item, then move 
the pointer to the right and highlight its menu items. 

Another reason to preview a menu is to find out which menu items require a 
selection. (More about selections later.) 

o Move the pointer into the scratch window and preview its Text menu. 
Notice that the pull-right menus contain pull-right menus of their own. Pre­
view them too. When you're done previewing, dismiss the Text menu 
without choosing an item (move the pointer back to the left so that no menu 
item is highlighted, then release the mouse button). 

o Move the pointer into the edit window, preview its Text menu, then release 
the mouse button. 

o Move the pointer into the Console window, preview its Text menu, then 
release the mouse button. Notice that the Text menu in the Console window 
has an extra pull-right menu at the bottom, 'Cmd Modes=>'. 
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Figure 1-9 Previewing the Text Menu 

The Keyboard Focus 

Click-to-type is a different way of 
setting the keyboard focus. See 
Chapter 4, All About Keyboards, for 
more information. 

Before typing, make sure the key­
board focus is in the corrept win­
dow. To set the keyboard focus in 
a window, move the pointer into the 
window. 

COl~Y 
Extras Paste 

Cut 
Show Clipboard::$ 
Copy th(m P~H~te 

It's time to begin typing. But wait a minute-there are three open windows. 
Where will the typing go? 

The window that receives whatever you type is said to have the keyboard focus. 
There are three ways to tell which window has the keyboard focus: 

o The window border thickens. When a window receives the keyboard focus, 
its border changes to a bold black line. When the keyboard focus is not in 
the window, its border is a thin line. 

o The pointer is in the window. The way you change keyboard focus is to 
move the pointer. If the pointer is not in a text window - if it's on a frame 
or on the background or in a window that can't receive text - whatever you 
type is lost. 

o The caret blinks. The insertion point - the place in the text window that 
receives the next character you type - is marked by a small black blinking 
triangle. This triangle is known as the caret. When the keyboard focus is 
not in the window, its caret appears as an unblinking gray diamond. (This is 
not true in canvases or tty windows, which are described in Chapter 5, All 
About Frames and Windows, in the Reference section.) 

To see how the keyboard focus works, try these experiments: 

o Move the pointer into the edit window, the large window in the Text Editor 
frame. Notice that its caret is blinking and its border is black. The pointer 
can be anywhere in the edit window. 

o Type your first name. It appears at the upper left corner of the edit window, 
because that's where the caret was. The caret moves to a point just after 
your name. 

o Move the pointer into the scratch window. (The pointer is almost as tall as 
the window - make sure the tip of the pointer is in the window.) The edit 
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Make sure the pointer is in a text 
window before you start typing, or 
whatever you type will be lost. 

The Key 

You can change the backspacing 
key from ~to ( Back Space ) 
with the Defaults Editor, described 
in Chapter 10 in the Reference sec­
tion. 

The 'File::::>' Pull-Right Menu 

window loses its bold border. Its caret turns gray, changes to a diamond, 
and stops blinking. 

o Type your last name, making sure scratch window has the keyboard 
focus. Your name appears in front of the words Scratch window, with 
the caret at the end of your name. 

o Move the pointer onto the clock so that the pointer shape becomes a tar-
get. Type your nickname. Look in all the windows and you won't see your 
nickname anywhere. When no window has the keyboard focus, what you 
type goes nowhere. 

time to type something else in the edit window, so let's get rid of what's 
there now. There are several ways to do this. are several ways to do 
almost everything in Sun View. That makes it a bit harder to learn, but nice to 
work with because you get to use it just the way you prefer.) 

( Delete ) is the default key for erasing the character to the left of the insertion 
point. You'll find it on the right side of the alphanumeric part of the Type4 key­
board, above the (Return I key. Other keyboards have a I DEL) key - it's the 
same thing. 

If you 're not sure which keyboard you have, see Chapter 4, All About Keyboards, 
for drawings of the various keyboards and instructions on how to label a Type2 
or Type3 keyboard to match the Type4 keyboard references in this manual. 

o Move the pointer into the edit window, where you typed your first name a 
few minutes ago. 

o Press the I Delete l key once, and the last letter of your name disappears. 
Unless your name has only one letter, press the I Delete I key again until all of 
the name is erased. 

o Now erase your last name from the scratch window. Hint: Remember to 
move the keyboard focus first. 

When you previewed the Text menu, you discovered that a pull-right menu can 
contain lower-level pull-right menus. The 'File::::>' pull-right menu is three levels 
deep. It's called the 'File===>' pull-right menu because you bring it up by pulling 
the pointer to the right of the 'File::::>' menu item in the Text menu. 

Here's a way to use the 'File::::>' pull-right menu to erase all the text in a window. 

o With the pointer in the edit window, type your name again. Now you're 
going to erase it by choosing a menu item. 

o Bring up the Text menu. 

o Highlight the 'File::::>' menu item by moving the pointer onto it. 

o Move the pointer slightly to the right. The pull-right menu appears, 
.... ~ ........ ...,,L.L File' at the and 'Finishing Up::::>' at the bottom. 
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Figure 1-10 

Alert Windows 

Figure 1-11 

Started with Sun View 15 

o Choose 'File:::::}Empty Document', as shown in Figure 1-10. 'File:::::}Empty 
Document' is shorthand for "the 'Empty Document' menu item in the 
'File:::}' pull-right menu." 

You choose a menu item in a pull-right menu the same way you choose 'Open' 
and 'Close' from the Frame menu: by moving the pointer over the item so that 
it's highlighted in inverse video, then releasing the mouse button. 

The 'File::=}' Pull-Right Menu 

Save Current File 
~~t0~'(1 (H~ ~(1W n 1 (1 

L OHd f>~ 1 (~ 
Jnc hHfo f=·~ h~ 

'Empty Document' tells the Text Editor to give you a fresh start: 

o If you 're creating a new file, the Text Editor throws away the editing you did 
in memory. 

o If you 're working on an existing file, the Text Editor throws away your edits 
(since the last time you saved the file) and forgets the file name. The file 
itself is still on the disk- 'Empty Document' doesn't remove it. 

When you choose 'Empty Document', the Text Editor alerts you to the fact that 
you have made some changes in the text window that you haven't saved. It 
beeps and brings up the following message: 

An Alert Window 

The text has been edited. 
Empty Document will discard these edits. Please confirm. 

'rm, discard edits 

The arrow alerts you to read what's in the box. The lozenge-shaped buttons at 
the bottom of the alert window give you the opportunity to choose an action. All 
alert windows in SunView work this way. 
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1.5. Selecting Text 

Guide LESSONS 

o The Confirm, discard edits button tells the Text Editor to empty the win­
dow and forget the file without saving the changes you've made. This but­
ton, the yes choice, has a double outline. The pointer moves automatically 
to the button with the double outline to make it easy to respond yes. 

o The Cancel button tells the Text Editor to cancel the 'Empty Document' 
request and preserve your changes. 

You choose an action in an alert window by pushing a button. Since you'll 
remember your name even if the Text Editor forgets it, it's okay to push the 
Confirm button. 

Here's how to push a button in an alert window: 

o Move the pointer over the button you want to push. In this case, Confirm, 
discard edits is the yes choice, so the pointer has already been automatically 
moved there. 

o Click the LEFT mouse button. The alert window disappears, and your name 
is gone from the text window. 

You've learned how to erase text. There are also ways to delete text. The differ­
ence is that deleted text is saved on the Clipboard. (More about the Clipboard in 
a few pages.) 

You can delete a selection by using: 

o The 'Edit=>' pull-right menu (described below). 

o The (Cut l function key (described in the next lesson). 

o An accelerator - a menu choice made from the keyboard. (These useful 
shortcuts are described in the Reference section in Chapter 9, All About 
Accelerators). 

We can't really discuss selections until there's some text to select, so let's enter 
some. 

o Move the pointer into the edit window and type the following limerick. 
Press ( Return ) at the end of each line. Press ( Tab ) to begin an indented line. 

All Hail, Electronic Mail! 

There once was a workstation fan 
Who networked, but only on LAN-­

Till he chanced to discover 
An Ethernet lover--

Now he's linked by e-mail to Japan. 

Don't worry if you made some typing errors. You're about to learn how to make 
editing corrections. When you 're done, the edit window looks something like 
Figure 1-12. 
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Figure 1-12 

Selecting a Word 

Chapter 1 - Getting Started with Sun View 17 

The Electronic Mail Limerick 

Mai 1 ! 

There once was a workstation fan 
Who networked, but only on LAN--

Ti 11 he chanced to discover 
An Ethernet lover--

he's linked by e-mail to Japan. 

The caret (the blinking black triangle) is now positioned after the period follow­
ing the word Japan. Whenever you enter text from the keyboard, the caret 
moves to a point just after the last character you entered. 

Suppose you want to change Japan to Siam. You can press the I Delete) key 
repeatedly until Japan is deleted and then type Siam. But that won't work if 
you want to change a word at the beginning of the text. 

You can change any part of the text by selecting it, deleting it, and typing the 
replacement. To select text, you move the pointer over the text and click LEFT. 

To change a word anywhere in the text: 

o Move the pointer so that the head of the arrow is anywhere in the word. 

o Double-click the LEFT mouse button to select the word. The selection is 
highlighted. 

Double-click means click twice in rapid succession. You click to select a 
character, double-click to select a word, triple-click to select a line, and 
quadruple-click to select all the text in a document. 

o Bring up the Text menu and choose 'Cut' from the 'Edit=>' pull-right menu. 
The word is removed from the window. 

o Type the replacement. 

Now try replacing Japan with Siam by following the instructions you just read. 
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Extending the Selection 

The MIDDLE mouse button is used to 
extend a selection. 

Figure 1-14 

Fi le =(> 

Again 
There once was a workstation fan Displa Undo 
Who networked, but on 1 y on LAN-- find 1--C-op-y------llllE 

Till he chanced to discove Extras Paste 
An Ethernet lover-- ..._ __ '\1111111111111111 

Now he's linked by e-mail to 1111· Show Cli pbo 
Copy then P 

The MIDDLE mouse button is used to extend a selection by adjusting its length. If 
you selected a word by double-clicking the LEFT mouse button, the selection is 
extended in units of a word. If you selected a line by triple-clicking the LEFT 

mouse button, the selection is extended in units of a line. 

To get an idea of how extending a selection works: 

o Select the word There at the beginning of the limerick by double-clicking. 

o Move the pointer to anywhere in the word was and click the MIDDLE mouse 
button once. The selection There once was is highlighted. 

o Delete the selection by choosing 'Cut' from the 'Edit=>' pull-right menu. 

o Type I once knew to replace the deleted text. The result is shown in 
Figure 1-14. 

Result of Cutting and Typing 

window 
Hail, Electronic Mail! 

I once knew a workstation fan 
Who networlted, but only on LAN--

Ti 11 he chanced to discover 
An Ethernet lover--

he 1s linked by e-mail to Siam. 

You can also extend a selection by wiping the pointer through the text in either 
direction while holding down the MIDDLE mouse button. The adjustment 
becomes final when you release the mouse button. You can adjust a selection as 
often as you like by wiping or clicking MIDDLE. 
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Where you click determines which 
end of the selection gets the caret. 

Inserting Text 

The caret shows the position of the 
insertion point. 

Started with Sun View 19 

When you move the insertion point by pointing and clicking LEFT, you automati­
cally select a single character. 

o Try clicking LEFT various places in the text. A single character is 
highlighted each time. The character can be a space, a Return character 
(which looks like a space), or a Tab character (which looks like several 
spaces). 

Whether you select a character, a word, or a line, the caret appears at the end 
closest to where you clicked. To see how this works: 

o Select the word workstation by pointing to the beginning of the word 
and double-clicking LEFT. The caret appears before the w. 

o Select the word networked by pointing to the end of the word and 
double-clicking LEFT. The caret appears after the d. 

Imagine a vertical line precisely in the center of the text to be selected. If you 
click anywhere to the right of the center, the right end of the selection gets the 
caret, and vice versa. 

o Try double-clicking LEFT in a word and see how close you can get to the 
center before the caret switches sides. 

o Try the same experiment with a single character by single-clicking LEFT. 

There are also some very useful editing shortcuts that work with secondary selec­
tions, which are temporary selections you make while holding down a function 
key. They're covered in the Reference section in Chapter 6, All About Selections. 

If you' re just going to delete the word you selected, you won't care which end 
the caret is on. But if you 're going to insert text instead of deleting, you can use 
the position of the caret to help you. 

To move the insertion point to the beginning of the line, you can carefully move 
the pointer in front of the first word and click, or you can point anywhere in the 
first half of the line and triple-click, which may seem a lot easier. Try it both 
ways and see which you prefer. 

Change the first line of the limerick to read, Gee, I once knew a 
workstation fan: 

o Move the pointer somewhere near the beginning of the first line and triple­
click the LEFT mouse button. 

o Type Gee, . 

In SunView, you can choose the way that's easiest for you. Once you've used 
Sun View for a while, you may decide to change to a different style of working. 
That's why it's a good idea to read the Reference section and become familiar 
with all the options available to you. 
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Extending 

More About the 

Figure 1-15 

to 

0 

o Move 

seen how to choose text. 
to 

D 

Showing the Clipboard 

Gee, I once knew a workstation fan 
~ , but only on LAN--
Again iscover 
Undo ~ 

Co~~y Siam. 

Paste 
Cut 

can extend it backward 

of the limerick. 

are 

If you've been 
was, as in 

e once was 

To put text on the Clipboard, select the text, then choose 'Edit:::::>Copy': 

o Select the word Ethernet. 

0 onto the Clipboard. 
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'Copy', 'Paste', and 'Cut' 

You can paste repeatedly from the 
Clipboard. 

Some Menu Items Require a 
Selection 

Figure 1-16 

Started with Sun View 

it is. 

'Edit=>Copy' puts the selection on the Clipboard. 'Edit:::::>Cut' deletes the selec­
tion and puts it on the Clipboard. 'Edit=>Paste' inserts the contents of the Clip­
board at the insertion point. So .... 

To move text from one place to another: 

o Select the text. 

o Choose 'Edit=>Cut'. Now the deleted text is on the Clipboard. 

o Click LEFf to set the insertion point where you want the text moved to. 

o Choose 'Edit=>Paste'. The text on the Clipboard is pasted at the caret. 

The first line of the limerick contains the phrase I once knew. Change it to 
once I knew: 

o Cut once. (Include the space after once by extending the selection.) 

o Paste in front of I knew. Now the line reads, Gee, once I 
knew .... 

Now paste the contents of the Clipboard before the word knew so the line reads 
Gee, once I once knew .... 

o Move the caret to the right of the space between I and knew. 

o Paste. 

The Clipboard won't change until you choose 'Cut' or 'Copy' again. 

Open the 'Edit=>' pull-right menu. Notice that 'Copy' and 'Cut' appear in light 
gray letters. And they're not highlighted when you preview the menu. Usually a 
menu item is grayed because it requires a selection and there isn't one currently. 
For example, after a 'Paste' operation there's no current selection. 

Copy and Cut Require a Selection 

Again 
Undo 
Cop, -+ 

Extras Paste 
Cut 
Show Clipboard =:i­

Cn~~:y then P~H~te 

Select some text - you might try quadruple clicking to select the entire limerick 
- and preview the 'Edit=>' pull-right menu again. Now 'Copy' and 'Cut' are 
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Now a wonderful even better, wouldn't you to 
it for inspiration on days? 

To save the contents a text window: 

o Type the filename of the new file. name it lessonl. limerick. 
The Editor's scratch window is handy for that purpose, as shown in 
Figure 1-17, but you could type the filename in the Console window or any-
where else in Sun View that can text. 

o Select the filename you typed. need to extend the selection with the 
MIDDLE mouse button to select the whole name. 

Be sure to move the pointer back into the edit window. If the pointer is in the 
scratch window, the contents of the scratch window, not the edit window, will 
saved. That's probably not what you want. 

o In the edit window, bring up the Text menu and choose 
~•u---.rLPL'LHv as New 

Saving a New 

Gee, once I once kn 
Who networked but 

Til 1 cha 
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Figure 1-18 Filename in the Frame Header 

About the Directory 

Undoing Edits 

Gee, once I once knew a workstation fan 
Who networked, but only on LAN--

Ti 11 he chanced to discover 
An Ethernet lover--

he~s linked by e-mail to Siam. 

On the right side of the frame header in Figure 1-18, you'll see dir : followed 
by the name of the directory where the limerick file was saved. That's the 
default directory for the Text Editor frame. The Text Editor uses the default 
directory when you load or store a file with a partial pathname. 

On your workstation, the default directory is your own home directory. If you 
want to save the file to another directory, you can do it in one of two ways: 

o You can type the full pathname of the file in the scratch window, beginning 
with a slash(/), and select that pathname for 'Store as New File'. If you do 
this, the default directory will still be your home directory, but when you 
choose 'Save Current File' you'll save to the full pathname you specified. 

o If you want to change the default directory, you can select the new directory 
name and choose 'File~Set Directory'. The new name will appear on the 
right side of the frame header. 

For more information on setting the directory, see the 'File~Set Directory' 
menu item in the All About Menus chapter. 

The Text Editor lets you know when the current file has been edited. 

o Select All Hail in the limerick title. 

o Choose 'Edit~Cut'. 

o Type Oh Swell to replace words you cut. 

The frame header now contains the word (edited} after the filename. 

As soon as you change the text in a text window after saving the file, the frame 
header shows that the file has been edited as shown in Figure 1-19. This can 
serve as a reminder to save your file. It's a good idea to do that fairly often. 
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I once knew a workstation 

The Text Editor (or any application that uses the Text menu) lets you change 
your mind by undoing edits. 

To remove the words you just typed: 

o Choose 'Undo:::::}Undo Last Edit' from pull-right menu. The 
line disappears. The word (edited) in the frame header also disappears. 

'Undo Last Edit' undoes the most recent edit action. It can undo: 

o 'Paste', 'Cut', or 'Again' in the 'Edit::::}' pull-right menu. 

o Typing, including pressing the I Delete J key. Everything you typed since the 
last selection is undone. (Remember, clicking to set the insertion point 
makes a one-character selection.) 

CAUTION It's possible to accidentally undo a great deal of typing at one fell swoop, so 
be careful. You can't undo 'Undo'! 

1. 7. The Sun View Menu The location of the pointer determines which menu comes up when you hold 
down the RIGHT mouse button. If the pointer is in a text window, the Text menu 
comes up. If it's on a frame or an icon, the frame menu comes up. If it's on the 
gray Sun View background, the Sun View menu comes up. 

Figure 1-20 The Sun View Menu 

The Sun View menu lets you start all the tools you now have - Mail Tool, Text 
Editor, Command Tool, Console, and Clock- and provides several other handy 
tools and services. 
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Printing from the Sun View 
Menu 

Figure 1-21 

Locking the Screen 

Started with Sun View 25 

One of the services in the Sun View menu gives you an easy way to print the 
selection. 

Printing the Selection 

To print the limerick: 

o Select the limerick by quadruple-clicking in the edit window. The entire 
document is highlighted. 

o Choose 'Print Selected Text' from the 'Services=>Printing=>' pull-right 
menu. Selection printed will appear in the Console window­
don 't make another selection until you see this message. 

o Go to your local printer and pick up your poem. (If you don't know which 
printer has been assigned to your workstation, ask your System Administra­
tor.) 

Ready to take the limerick and run? Before you head out the door, there's just 
one more thing to do. If you leave your workstation screen up for long periods of 
time without changing the display, the image will "bum" into the tube and make 
the screen hard to read. That's one reason why it's a good idea to lock the screen 
before leaving work. 'Lock Screen' displays a moving image that protects the 
screen. 

Another reason to lock the screen is to protect your privacy. You can leave all 
your frames open in Sun View, and 'Lock Screen' will keep idle passersby from 
reading their contents. No one can unlock your screen without knowing your 
password. 
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Figure 1-22 

When to lesson: 

o Text menu and choose 'Save Current File' from 
pull-right menu. save your work when you're going to 

your workstation 

o Choose 'Empty Document' from pull-right menu. This isn't 
usually necessary, but it gives you a clean start for the next lesson. 

o Choose 'Close' from the Frame menu to prepare for the next lesson. Nor­
mally you would keep frames open. 

o Bring up the Sun View menu. 

o Choose 'Lock Screen' from the 'Services=>' pull-right menu. Your screen 
gets dark, as shown in Figure 1-22. 

The Locked Screen 

At the beginning of the next lesson, you '11 learn how to unlock the screen. 
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2.1. Introduction to 
Accelerators 

Sun View Accelerated 

In the first Sun View lesson, you learned how to perform window operations 
using menus. This lesson teaches you how to use accelerators that make Sun­
View operations faster and easier. You will learn how to: 

o Use SunView shortcuts. 

o Load a file in the Text Editor. 

o Make frames larger or smaller and move them around. 

o Look at different parts of a document in a window by scrolling. 

o Find and replace text. 

o Use panels to make choices and perform actions. 

Many Sun View actions can be initiated in more than one way. Some alternative 
methods are known as accelerators because they're faster than the standard tech­
nique. There are accelerators that let you perform menu operations from the key­
board, accelerators that let you move the caret from the keyboard, and accelera­
tors that use the mouse and the keyboard instead of a menu. 

You can start using a few accelerators right away and add more to your repertoire 
as you become accustomed to Sun View. In this chapter you 'U learn how to use a 
few of the powerful accelerators that are available. There are many more, and 
they're covered in the Reference section in Chapter 9, All About Accelerators. 
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Figure 2-1 

If you change your mind and want 
to relock the screen, click LEFT in 
the black box. 

You ended lesson locking screen to ensure privacy while preserv-
ing the state of your windows. To unlock the screen: 

o mouse or press or~. screen 
changes from black to white and a 
Figure 

prompt appears, as shown 

Unlocking the Screen 

s 

Enter to unlock; select to lock. 

o To unlock the screen, type your password, press the I Return I key. 
words Validating login .... appear. 

If your password was correctly typed, the Sun View screen appears, just as you 
left it. you made a typing error, Lock Screen gives you another chance to enter 
the correct password. 
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Figure 2-2 
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In the previous lesson, you had two frames open at the same time: the Console 
frame and the Text Editor frame. They didn't overlap, and the Console frame 
was up in the comer, out of the way. Often in Sun View you will have several 
frames open at the same time, and working with them requires some window 
management techniques. 

Let's get some frames open and work with them. 

o Move the pointer to the Text Editor icon. 

o Choose 'Open' from its Frame menu. 

Now open the Command Tool using a point-and-click accelerator for Open: 

o Move the pointer to the Command Tool icon. 

o Click the LEFT mouse button. You can open any frame by clicking LEFT on 
its icon. 

The Sun View screen now contains three open frames, as shown in Figure 2-2: the 
Console frame, a Text Editor frame, and a Command Tool frame. 

Three Open Frames 

sun 
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menu items in menu you manage the over-

o 'Back' hides the overlapping part of a frame moving the frame to the 

o 'Front' exposes the overlapped part a frame moving the frame to the 
front. 

To change the overlap of a frame, move the pointer onto the frame border and 
choose 'Back' or 'Front' from the Frame menu. 

NOTE It's possible for a frame to be completely hidden. To rescue a small frame from 
the back, send all the visible frames to the back by choosing 'Back' for each one, 
and the hiddenframe will float to thefront. 

Try exposing the Text Editor frame, which is partly hidden: 

o Move the pointer onto the frame border of the Text Editor frame. 

o Choose 'Front' from the Frame menu. The overlap changes, as shown in 
Figure 2-3. 

Revision A of 9 May 1988 



Figure 2-3 

Function Keys 

2-SunView Accelerated 33 

Exposing a Partly Hidden Frame 

You could have performed the same action by choosing 'Back' from the Com­
mand Tool's Frame menu. If you have several layers, though, keep in mind that 
'Front' sends a frame all the way to the top, and 'Back' sends it all the way to the 
bottom. 

At the left side of your keyboard are the ten main Sun View function keys. These 
keys act as accelerators that enable you to perform various menu operations 
without opening a menu. Some additional keys on the top and right side of the 
keyboard perform special functions in Sun View; they're described in Chapter 9, 
All About Accelerators. 
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Table 2-1 

Back and Front accelerators. 

Moving and Resizing Frames 

The Left Function 

Key Menu Item Menu 

(]1Qii) none -

~ 'Props' Frame 
(Front I 'Front', 'Back' Frame 
(Qiiffi) 'Open', 'Close' Frame 
!Find] 'Find=>Find Selection=> Forward' Text 

'Find=>Find Clipboard=>Forward' Text 
(Again I 'Edit=> Again' Text 
(Undo) 'Edit=>Undo=>Undo Last Edit' Text 
(Paste I 'Edit=>Paste' Text 
CQfilYJ 'Edit=>Copy' Text 
CTd!D 'Edit=>Cut' Text 

Among the function keys described in Table 2-1, you'll find accelerators for 
'Copy', 'Paste', and 'Cut' as well as 'Open' and 'Front'. Some of the function 
keys accelerate the 'Edit=>' and 'Find=>' pull-right menus in the Text menu, 
while others accelerate the Frame menu. The keys are marked with the names of 
the lowest-level menu items.2 

Pressing a function key is the equivalent of opening a menu and choosing an 
item. Some function keys toggle just as some menu items toggle. The (Qiiffi) 
function key toggles to Close, and the ( Front I function key toggles to Back. 

o Move the pointer anywhere in the Text Editor frame (not just the frame 
border) and press the I Front I function key. The Text Editor frame moves to 
the back, behind any overlapping frames. 

o Press ( Front) again. The Text Editor frame comes forward again. 

'Move=>' and 'Resize=>' in the Frame menu let you change the location and size 
of a frame. You'll leam how to do this from the menu and by using accelerators. 

When you move or resize a frame, an empty rectangle known as the bounding 
box shows you the new position. As long as you continue to hold down the 
mouse button, you can continue to adjust the position of the bounding box. The 
frame moves to the position of the bounding oox when you release the mouse 
button. 

'Unconstrained' -the default in the 'Move=>' and 'Resize=>' pull-right menus 
- lets you adjust both dimensions, height and width, at once. In unconstrained 

2 There are two reasons why your function keys may not look or work as described in this section: either 
you don't have a Type4 keyboard, or your function key functions have been remapped (customized). 

Chapter 4, All About Keyboards, shows you the differences among Type2, Type3, and Type4 keyboards, and 
tells you how to customize - or uncustomize -your keyboard. Left-handed people can customize the 
keyboard layout so that the functions can be accessed from the right side of the keyboard. 
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resizing, the part of the frame border you grab becomes the movable comer of 
the boooding box. You grab the frame by moving the pointer over a part of the 
frame border and holding down the MIDDLE mouse button. 

A 'Constrained' move or resize lets you adjust only one dimension, either height 
or width. The direction the frame moves depends on where you grab it with the 
pointer. If you grab the frame when the pointer is on a side, the frame moves 
sideways. If you grab it when the pointer is on the top or bottom edge, the frame 
moves up and down. 

Here are the general rules for resizing a frame: 

1. Choose 'Unconstrained' (the default) or 'Constrained' from the 'Resize=>' 
pull-right menu in the Frame menu. 

2. Grab the frame by moving the pointer onto the frame border, then holding 
down the MIDDLE mouse button. 

3. Drag the frame with the pointer while continuing to hold down the MIDDLE 
mouse button. (Reminder: The MIDDLE mouse button is for extending, 
adjusting, and moving SooView objects.) 

4. Release the mouse button when the boooding box is at the location you want 
the frame to move to. 
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Step One 

Figure 2-4 

Figure 2-5 

Let's rearrange the screen so that it looks like the one shown a few pages ahead 
in Figure 2-8. You can try this on your own, or you can follow the detailed 
instructions below. 

o Choose 'Resize=>Constrained' from the Text Editor's Frame menu. The 
following alert window appears: 

'Resize=>' and 'Move=>' Alert Window 

Press and hold the middle mouse button 
near the side or corner you want to resize 
and hold the button down while adjusting 
the bounding box to the shape you want; 
then release the mouse button. 

Otherwise, push "Cancel" button. 

Cancel 

o Following the instructions in the alert window, grab the bottom edge of the 
Text Editor frame and shrink it by about one-third, as shown in Figure 2-5. 

Rearranging the Screen-Step 1 

tt\s ~~ microsystems 
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Step Two 
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To move an icon or open frame to a new position on the screen: 

1. Choose 'Move~Unconstrained' or 'Move~Constrained' from the Frame 
menu. 

2. Drag the frame with the pointer while holding down the MIDDLE mouse but­
ton. 

3. When the bounding box shows the location you want the frame to move to, 
release the mouse button. 

Here's the second step in detail: 

o Choose 'Move~' from the Text Editor's Frame menu. ('Unconstrained' is 
the default.) 

o Following the instructions in the alert window, grab anywhere on the Text 
Editor frame border and drag the frame down to the bottom right comer of 
the screen, as shown in Figure 2-6. 

Figure 2-6 Rearranging the Screen-Step 2 

• venus 
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is to MID-

o Hold 

D 

D Text 

and the mouse button. 

3 
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Step 

Figure 2-8 

Moving Icons 

Zoom and FuHScreen 

2 - Sun View Accelerated 39 

All that's left to do now is to use an accelerator to move the Command Tool 
frame to its final position. 

o Move the Command Tool frame to the right by grabbing the middle of the 
right border and dragging to the location shown in Figure 2-8. 

Rearranging the Screen-Final Step 

One advantage of the new arrangement is that the windows no longer overlap. 
This means less redrawing of the screen, therefore faster response time. In addi­
tion, you now have room for another frame or two. As you gain confidence in 
using Sun View, you '11 often find it handy to work with several open frames. 

You can't resize icons, but you can move them just the way you move frames. 

o Fori>ractice, try moving the Oock icon around with the Move accelerator. 
You may decide you'd prefer to keep it in another location. 

There are two additional menu items in the 'Resize=>' pull-right menu: 'Zoom' 
and 'FullScreen'. 'Resize=> Zoom' expands a frame vertically to the height of 
the screen. 'Resize=>FullScreen' expands a frame to the full size of the screen. 
Both of these menu items toggle to 'UnZoom', which restores the frame to its 
previous size and location. 'Zoom' and 'UnZoom' have the same accelerator: 

o Hold down the ( Control ) key while you click LEFf in the frame border. The 
shorthand notation for this keyboard-mouse combination is I Control J-LEFf. 
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Before choosing 'Load File', select 
the filename. The selection can be 
in any window. 

To these out, 

D Frame menu. 

D 

The name file is les sonl . limerick. To 

o Select its name in Command Tool The name is con-
sidered two words, so you'll have to extend the selection. Move the pointer 
into the Text Editor's edit window. 

o the Text menu and choose · t<IJLe=:>LClaa . The is loaded, 
and the file name appears in the header. 

In order to learn scrolling, you need to fill up the edit window with text. An easy 
way to do that is to put more copies of the limerick file into the window by 
choosing the 'File=:>Include File' menu item, as shown in Figure 2-9, or by copy­
ing and pasting in the window. You'll have a chance to try both methods. 
Unlike 'Load File', which clears the window before it loads the file, 'Include 
File' inserts the specified file into the window at the insertion point (the caret), in 
addition to whatever else is in the window. 
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Figure 2-9 

2 - Sun View Accelerated 41 

Loading the Limerick File 

original .limerick 

Gee, once I once knew a workstation fan 
Who but only on LAN--

Ti 11 chanced to discover 
An Ethernet lover--

Now he's linked by e-mail to Siam. 

Save Current File 
Edit Store as New File 
Displa Load F1le 
Find 
Extras Set Directory 

Er1pty Docooent 
Fin1sh1ng Up -. 

Add some additional copies of the limerick by following these instructions: 

o Select the filename lessonl. limerick if it isn't already selected. 

o Choose 'File=> Include File' from the edit window's Text menu. Another 
copy of the limerick appears. 

o Quadruple-click the LEFf mouse button to select the entire document. 

o Press the CCQllYJ function key to copy the selection onto the Oipboard. Now 
there are two limericks in the document and two on the Clipboard. 

o Press the I Paste I function key to copy the Oipboard into the document. 
Now there are four copies of the limerick in the document. 
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2.6. Scrolling 

Guide LESSONS 

o Repeat the last step twice. Now there are eight copies of the limerick in the 
document. 

There's more text in the document than you can see in the edit window. You 
could make the window taller by choosing 'Resize=> Zoom' from the Frame 
menu, but that wouldn't help if you had a really large file. The Sun View way to 
see all the text in a document is by scrolling. 

The vertical bar on the left side of the edit window is called the scrollbar.3 Every 
text window contains a scroll bar. The Command Tool has a scrollbar also. The 
scrollbar lets you make all of a document visible by moving it through the win­
dow - it's similar to the way you wind film past the lens of a camera. The 
difference is that you can only wind the film forward, one frame at a time. Using 
the scrollbar, you can move a document backward or forward through the win­
dow a line at a time or a windowful at a time. There are several additional scrol­
ling techniques that let you show a specific part of the document, and there are 
scrolling accelerators. This lesson covers the basics; the advanced techniques are 
described in Chapter 7, All About Scrolling. 

Since the scratch window in the Text Editor is a text window, it has a scrollbar 
too. Because the window is only one line high, there isn't room to show the 
entire scrollbar, so only a scroll box is displayed, as shown in Figure 2-10. The 
scroll box has the same function as the scroll boxes at either end of the edit 
window's scrollbar. The function of the scroll boxes is described in the next sec­
tion. 

Figure 2-10 Scrollbar in the Scratch Window 

Using the Scroll Boxes 

I~ 

•t .... 

The scroll boxes at either end of the scrollbar are identical in function. They're 
in both places for convenience, so you don't have to move the pointer very far to 
reach one. 

The upward- and downward-facing triangles in the scroll box indicate that you 
can move the text up or down in the window. 

3 This chapter describes the scrollbar's standard appearance. There are many interesting ways to customize 
the scrollbar. See Chapter 7, All About Scrolling, and Chapter 10, The Defaults Editor, in the Reference section 
for more information. 
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Scrolling by the Line 

The LEFT mouse button scrolls lines 
upward. The RIGHT mouse button 
scrolls lines downward. 

Scrolling by the Windowful 

The MIDDLE mouse button scrolls 
upward by the windowful. 
With the rn1ill[) key pressed, the 
MIDDLE mouse button scrolls down­
ward by the windowf ul. 

Chapter 2-SunView Accelerated 43 

o Move the pointer into one of the scroll boxes in the edit window's scrollbar. 
The pointer changes to a diamond shape, indicating that you can scroll in 
either direction. 

o Hold down the LEFT mouse button. The document scrolls upward in the 
window, and the pointer changes to an upward-facing arrow. Release the 
mouse button after you've scrolled several lines. 

When you hold down the mouse button in a scroll box, the document scrolls con­
tinuously, a line at a time, until you release the mouse button. 

o With the pointer in the scroll box, click the RIGHT mouse button. The docu­
ment scrolls downward in the window by one line, and the pointer briefly 
changes to a downward-facing arrow. 

When you click the mouse button in a scroll box, the document scrolls one line. 

o With the pointer in either scroll box, click the MIDDLE mouse button. The 
text scrolls upward by one windowful, and the pointer changes briefly to a 
right-facing triangle. 

o With the pointer in either scroll box, hold down the (filllID key while click­
ing the MIDDLE mouse button. The text scrolls downward by one window­
ful, and the pointer changes briefly to a right-facing triangle. 

When you click the MIDDLE mouse button in a scroll box, the text scrolls one 
windowful. 

When you hold down the MIDDLE mouse button in a scroll box, the text scrolls 
continuously, a windowful at a time, until you release the mouse button. 
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The Bar and the Bubble 

a 

Guide LESSONS 

Besides the scroll buttons, the scrollbar contains two additional parts: 

o bar is the tall light-gray rectangle bounded on either end by scroll 

o part of the bar. The bubble's size relative to the 
what the document is visible. The 

rinr"'""'"""'" the "' ....... ........._,.,, .. 

like the 

l.n.,...,.,.1"1F'•n in a ,-t,...,, .. ,......,,,,. ..... ,. 

text 

o Move MID-

ment. 

o Move the pointer to the bottom the bar, just above the bottom scroll box. 
Click the MIDDLE mouse button. You see the end of the document. 

NOTE Scrolling doesn't change the location of the caret. 

Scrolling in the Command Tool window works just the way it does in the Text 
Editor. Try it out and see. 
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File : I Edit 
iil!lllMIL"11illl!f:ll.' Select line at Number 

Find What Line Number? 
Extras Split View 

Destro, v·i ew 
I I 

Move Caret to Start 
Move Caret to End 
Change Line Wrap =} 

2.8. Finding and Replacing 
Text 

Figure 2-11 
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Occasionally when you 're scrolling, you may lose track of where the caret is. 
The 'Display=>' pull-right menu in the Text menu contains some handy ways to 

or move caret the containing it in the 

o 'Display=>Show Caret at Top' displays the caret near the of the window. 
This is handy if you just want to see where the caret is. it. 

o 'Display=>Move Caret to Start' positions the caret at the beginning of the 
document and displays the first line in the document at the top of the win­
dow. Try it. 

o 'Display=>Move Caret to End' positions the caret at the end the document 
and displays the last line in the document at the bottom of the window. This 
is handy if you want to add text at the end of the document. Try it. 

Now you know a number of ways to move around in a document of any size. 

You know how to use the Text menu or the function key accelerators to paste 
text into a document. The Find and Replace frame does that, and more. It lets 
you look for a specified set of characters and replace one or some or all 
occurrences. 

The Find and Replace frame is a panel that the Text Editor brings up when you 
choose 'Find=> Find and Replace' from the Text menu. A panel is another type 
of window. The panel in the Find and Replace frame contains buttons like the 
buttons in an alert window, a cycle item that lets you make choices, and text 
items where you can type and do limited editing. 

o Bring up the Text menu and choose 'Find=> Find and Replace'. The 
Find and Replace frame, shown in Figure 2-11, appears above the Text Edi­
tor frame. 

The Find and Replace Frame 

Rind anB Replace 

1 Find ] : • 

I Replace] : 

I Find then Replace I (Replace then Find) (Rep 1 ace A 11 ) 

c Done ) 
v All Text 

(Blink Olt.iner) 

Like other frames, the Find and Replace frame has a frame menu, but it isn't 
quite the same as the Text Editor's frame menu. 

o Preview the two frame menus. Notice that the Find and Replace frame's 
Frame menu doesn't have 'Quit' at the bottom, and it has 'Done' instead of 
'Close' at the top. 
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2-12 Frame and Replace Frame 

Pushing Panel Buttons 

Replacing Text 

A text item in a panel is usually pre­
ceded by a colon (:). 

In most other respects, the 
usually comes up just above its owner -
which it was chosen - but you can 

Done 
Move 

leave the 
Jl'-'-·llJl'•"'ji,"""' frame to an icon. When 

disappears, but the Text Editor 

other frame. It 
frame containing the window from 

it or move it to a new location. 

If the Find Replace frame doesn't where you expect you can 
easily find it. Just choose 'Find and Replace' again, and the Find and Replace 
frame will blink. 

A button in a panel represents an action. To choose the action, move the pointer 
onto the button and click the LEFT mouse button. This is known as pushing the 
button. It's just like responding to an alert message, which you learned how to 
do in Chapter 1. 

o Push the Blink Owner button in the and Replace frame. 

Blink Owner causes the frame that owns this Find and Replace frame to 
highlight rapidly three times. When there's more than one Find and Replace 
frame on the screen, Blink Owner lets you find out which owner each pop-up 
frame belongs to. 

o In the edit window, choose 'Find=> Find and Replace' again. 

The Find and Replace frame blinks to let you know it's already available. 

Let's replace all the occurrences of workstation. 

o Select the word workstation anywhere in the document. 

o Choose 'Find=>Find and Replace'. 

If text is selected when you choose 'Find=>Find and Replace', the selection is 
automatically pasted into the Find: text item. (You could also click LEFT in a 
text item to set the insertion point and type the text you want. Or you could put 
the text on the Clipboard and paste it the text item in the panel.) 
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To move from one text item ta the 
next in a the ~=,,_., 

or the 

After you push a panel button, the 
button turns gray while the action is 
taking place. 

2 - Sun View Accelerated 4 7 

When the it 

sure caret is 

o Sun-2. text items 
look like those in Figure 2-13. 

Finding and Replacing Text 

o Push the button (not the [ Find ) function An occurrence of 
workstation is now highlighted in the edit window to indicate that it has 
been found. It looks just like a normal selection, and in fact it is. 

o Push the button to change workstation to Sun-2. 
tion is replaced, and the caret in the edit window moves to the right of the 
replacement. 

o Move the pointer into the panel and change the text item from 
Sun-2 to Sun-3. The caret is positioned after Sun-2 because that was 
the last text you typed in the panel. 

o Press the ( Delete I key once to erase the 2 , then type 3 . Now the Replace: 
text item contains Sun - 3 . 

o Push the 
selected. 

button again. The next occurrence of workstation is 

o Push the Replace then Find button. The selection changes from works­
tation to Sun-3 and yet another occurrence of workstation is found. 

o Move the pointer into the panel and change Sun-3 to Sun-4 by erasing 
the 3 and typing 4. 

o Push the Replace All button. The remaining occurrences of works ta -
tion are replaced by Sun-4. 

o Push the Find button. 

Since workstation no longer exists in the edit window, the window blinks 
and beeps to tell you the Find: text item wasn't found. 

o Scroll through the document in the edit window to see the changes you 
made. 
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Menus in Panels 

Figure 2-14 

Menus in panels work just like 
menus in other windows. 

2.9. Wrapping Long 
of 

Panel items often have menus associated them. 

items, the End in the and Replace panel, 
always have menus. The current choice is checked in the menu and appears to 
the right of the cycle item. 

o End means search from the caret to the end of the document. 

o AH Text (the default) means search from the caret to the end of the docu­
ment, then from the beginning of the document back to the caret. 

A Cycle Item's Menu 

To a menu in a panel, move the to the item and hold down the 
RIGHT mouse button. To dismiss the menu without choosing an item, move the 
pointer menu so that no menu is highlighted (moving the pointer 
leftward usually works best), and release mouse button. 

o There's a second menu in the and panel. Can you find it? 
Move the pointer onto each button and other item in the panel, and preview 
to see if there's a menu behind 

The Find button contains a menu that lets you specify 'Forward' or 'Backward' 
as the direction of the search. . 'Forward' is the default. 

Other tools with panels include the Mail Tool and the Defaults Editor. When 
you start to use them, check for menus so you won't miss out on some nifty 
features. 

o You've finished the part of the lesson that uses the Find and Replace frame, 
so click LEFT on the Done button to put the frame away. 

The limerick you've been working with has very short lines. If you will be work­
ing with documents that contain text in paragraph form, or that contain long 
lines, you'll want to know about the 'Display=)Change Line Wrap=)' pull-right 
menu in the Text menu. 

First let's get some long lines into the document by replacing all the Return char­
acters with spaces. Since the ( Return I key has a special function - moving the 
caret between the Find: and Replace: text items there's no way to search for 
the Return character using the Find and frame, but you can use other 
Find features to do this search. 
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o Click LEFT after the last character in the first line of the limerick to select the 
Return character. 

o Choose 'Find=>Find Selection=>' to find the Return character in the next 
line. 

o Press the ~ function key, then type a space. Cutting puts the Return 
character on the Clipboard. 

Now that you've replaced the first Return character with a space, you can easily 
repeat the sequence of actions. 

o Press the I Agam I function key. (Or choose 'Edit=>Again' from the Text 
menu.) 

Each time you press ( Agam ), the next replacement occurs. I Again I lets you 
repeat a series of edit operations. 

o Press I Again I repeatedly until the window blinks and beeps. That's the sig­
nal that 'Find' can't find any more Return characters. 
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'Wrap at Character' 

The CtlQ:aJ function key is an 
accelerator for 
'Find~Find Selection~·. 

Figure 2-15 

Now the document is a single long line. You can type normal text - letters and 
memos - this way, without inserting Return characters except at the end of a 
paragraph. The Text Editor displays text on a new line in the window when the 
current line is about to overflow. 

o Try getting rid of the Tab characters the same way you got rid of the Return 
characters, using I Find), (QllJ and (Again). (When there's a selection- in 
this case, when you select a Tab character - pressing the ( Find ) function 
key is the equivalent of choosing 'Find=>Find Selection=>Forward'.) The 
edit window should then look like the one in Figure 2-15. 

A Document with Character Wrap 

cratch window .... 
All Hail, Electronic Mail! Gee, once I once knew a Sun-4 fan Who networked, but 

only on LAN-- Till he chanced to discover An Ethernet lover-- Now he's linked 
by e-mail to Siam. All Hail, Electronic Mail! Gee, once I once knew a Sun-2 fa 

n Who networked, but only on LAN-- Till he chanced to discover An Ethernet lov 
er-- Now he's linked by e-mail to Siam. All Hail, Electronic Mai fl Gee, once I 
once knew a Sun-3 fan Who networked, but only on LAN-- Till he chanced to disco 
ver An Ethernet lover-- Now he's linked by e-mail to Siam. All Hail, Electronic 
Mail! Gee, once I once knew a Sun-4 fan Who networked, but only on LAN-- Till 
he chanced to discover An Ethernet lover-- Now he's linked by e-mail to Siam. 

All Hail, Electronic Mail! Gee, once I once kn~~ a Sun-4 fan Who networked, but 
only on LAN-- Till he chanced to discover An Ethernet lover-- Now he's linked 
by e-mail to Siam. All Hail, Electronic Mail! Gee, once I once knew a Sun-4 fa 

n Who networked, but only on LAN-- Till he chanced to discover An Ethernet lov 
er-- Now he's linked by e-mail to Siam. All Hail, Electronic Mail! Gee, once I 
once knew a Sun-4 fan Who networked, but only on LAN-- Till he chanced to disco 
ver An Ethernet lover-- Now he's linked by e-mail to Siam. All Hail, Electronic 
Mail! Gee, once I once knew a Sun-4 fan Who networked, but only on LAN-- Till 
he chanced to discover An Ethernet lover-- Now he's linked by e-mail to Siam. 
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'Wrap at Word' 

Figure 2-16 

NOTE 

2 - Sun View Accelerated 51 

The text in the document wraps at the right edge of the window. If a word 
doesn't fit on a line, it wraps the remaining characters around to the next line. 
That's kind of hard to read because words at the end of the line may be broken in 
strange places, so let's change the way the line wraps: 

o Choose 'Display:=>Change Line Wrap=> Wrap at Word'. The window 
changes to look like Figure 2-16. Notice that words are no longer split 
between lines. If a word is too long to fit at the end of a line, it is moved to 
the beginning of the next line. 

A Document with Word Wrap 

... 
: Scratch window 
~All Hail, Electronic Mail! Gee, once I once knew a Sun-4 fan Who networked, but 

only on LAN-- Till he chanced to discover An Ethernet lover-- Now he's linked 
by e-mail to Siam. All Hail, Electronic Mail I Gee, once I once knew a Sun-2 fan 
Who networked, but only on LAN-- Till he chanced to discover An Ethernet 
lover-- Now he's linked by e-mail to Siam. All Hail, ElectronitMail ! Gee, once 
I once knew a Sun-3 fan Who networked, but only on LAN-- Till he chanced to 
discover An Ethernet lover-- Now he's linked by e-mail to Siam. All Hail, 
Electronic Mail! Gee, once I once knew a Sun-4 fan Who networked, but only on 
LAN-- Till he chanced to discover An Ethernet lover-- Now he's linked by 
e-mail to Siam. All Hail, Electronic Mail! Gee, once I once knew a Sun-4 fan 
Who networked, but only on LAN-- Till he chanced to discover An Ethernet 
lover-- Now he's linked by e-mail to Siam. All Hail, Electronic Mail I Gee, once 
I once knew a Sun-4 fan Who networked, but only on LAN-- Till he chanced to 
discover An Ethernet lover-- Now he's linked by e-mail to Siam. All Hail, 
Electronic Mail! Gee, once I once knew a Sun-4 fan Who networked, but only on 
LAN-- Till he chanced to discover An Ethernet lover-- Now he's linked by 
e-mail to Siam. All Hail, Electronic Mail! Gee, once I once knew a Sun-4 fan 
Who networked, but only on LAN-- Till he chanced to discover An Ethernet 
lover-- Now he's linked by e-mail to Siam . 

.... .... 

The actual text hasn't changed. Only its appearance on the screen is different. 

In Mail Tool and certain other tools, and in some SunOS commands such as 
lpr, 'Wrap at Word' looks great in the window but may give unsatisfactory 
results if you print the contents. For better printed output, control the line length 
yourself by pressing the I Return J key at the end of each line, as you did when typ­
ing the limerick. 
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'Clip Lines' 

Guide LESSONS 

Instead of wrapping text, you can clip it so that whatever doesn't fit on a line of 
the screen doesn't show. It appears to be truncated on the right. Clipping 
doesn't actually snip off the part of the text that isn't shown - it just hides it. 

o Choose 'Display::::>Change Line Wrap::::>Oip Lines'. Only the first few 
words of the document appear in the window. 

Figure 2-17 A Document with Clipped Lines 

Scratch window" 
All Hail, Electronic Mail I Gee, once I once knew a Sun-4 fan Who networked, but 

.... .... 

Remember that we took out all the Return characters, so the Text Editor regards 
the document as one long line. It has clipped off the part that couldn't be 
displayed. If you widen the frame with 'Resize::::>', you'll see more of the line. 
Or you can change the line wrap back to the way it was: 

o Choose 'Wrap at Character' from the 'Display::::>Change Line Wrap=>' 
pull-right menu to go back to the default setting. 

It's time to end this lesson. If you'd like to save the document in its present 
form, you can either choose 'File::::>Save Current File' or type a new name in the 
scratch window, select it, and choose 'File=>Store as New File'. 

o Preview the 'File::::>Finishing 
interesting ways to save a 
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2.10. Exiting Sun View 

2.11. A Word to the Wise 

2-SunView Accelerated 53 

The normal way of ending a work session is to lock the screen. You don't have 
to go back to the SunOS shell, since you can execute commands from a Com­
mand Tool. Occasionally, though, you may want to restart Sun View in order to 
change the startup options. 

To exit and restart Sun View: 

o Move the pointer over the gray background. 

o Bring up the Sun View menu and choose 'Exit Sun View'. 

o Follow the instructions for starting Sun View at the beginning of Chapter 1, 
Getting Started with Sun View. 

You now know all of the SunView basics plus some fancy twists. But there's a 
lot you can do to make your Sun View environment more efficient and personally 
pleasing. You'll miss out on many attractive features unless you read the Refer­
ence section, especially the chapter on The Defaults Editor. 

To whet your appetite, here are some features you might like to try: 

o Stay-up menus let you preview menus without having to keep holding down 
the mouse button. You click to bring the menu up and click again to choose 
a menu item or take the menu down. 

o Pending-delete is a way of selecting text so that you can replace it without 
having to delete it first. This feature makes the Text Editor work more like a 
personal computer's word processor. 

o I cons can be displayed in the Sun View menu instead of toolnames. The 
'Clock=>' pull-right menu in the Sun View menu shows you how this looks. 

o If you' re left-handed, you can rearrange the standard function keys and add 
special functions of your own. 

o 'Split View' in the Text menu lets you divide a window into two or more 
sections and scroll them individually. 

a Reduced mousing is possible by using keyboard accelerators instead of the 
mouse to move the caret around. 

o Find Marked Text is a pop-up frame that you bring up from the 'Find=>' 
pull-right menu. It finds text that's enclosed in certain standard delimiters, 
like parentheses and quotation marks. 

o The 'Extras=>' pull-right menu contains lots of formatting shortcuts for 
source programs and other text. 

If nothing on this list caught your attention, you probably have everything you 
need to be happy in Sun View right now. Go to! 

If you saw something you'd like to try, read on. And happy exploring. 

sun 
microsystems 

Revision A of 9 May 1988 





sun 
microsystems 

Revision A of 9 May 1988 





3 
Starting and Exiting Sun View 
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Starting Sun View 

Customizing the Background 
Pattern 

To start Sun View from a SunOS command line, 
the command prompt: 

sunview in response to 

The directory you 're in when you start Sun View is the directory that Sun View 
tools come up in. This manual shows Sun View starting from your home direc­
tory, but you can start Sun View in any directory. For more details, follow the 
instructions in Chapter 1, Getting Started with Sun View. These instructions tell 
you how to bring up Sun View with the standard options. 

There are various ways to modify the Sun View display, as described under the 
sunview command in the SunOS Reference Manual. Two of the more interest­
ing options are shown below. 

The Sun View background doesn't have to be plain gray. Using the 
-background option, you can display a picture on the screen to serve as the 
background. 

o To display a background picture, type the following command line: 

The filename file contains the picture you want to use as a background. This file 
is a standard raster.file, a graphics file that you can produce using screen­
dump, the Icon Editor, or other image-producing software.4 

For example, suppose you have a file called eel tics that contains the back­
ground pattern shown in Figure 3-1. 

4 For more information about screendump, see the screendump command in the SunOS Reference 
Manual. 
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Figure 3-1 

Background in Inverse Video 

o To start Sun View with the eel tics file as the background, type the fol­
lowing command: 

The frames and icons will be displayed over the eel tics background. 

A Cheering Background 

You may prefer inverse video - black windows on a dark gray background, with 
text and frame borders in white - rather than the default of white windows and 
black text on a light gray background. Some people think inverse video is easier 
on the eyes. 
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Figure 3-2 

3.2. Saving the Layout 

Chapter 3 -Starting and Exiting Sun View 61 

o To display the custom background screen in inverse video, add the - i (for 
inverse) option when you start Sun View: 

Here's what inverse video looks like: 

The Customized Screen in Inverse Video 

You don't have to have a special background to use inverse video. You can use 
the - i option all by itself to get the standard Sun View screen in inverse video. 

If you like the way you've set up your screen and don't want to go to the trouble 
of starting tools and moving and resizing frames every time you start Sun View, 
you can have Sun View recreate your personal environment automatically. 

The 'Save Layout' menu item in the Sun View menu saves a map of the screen in 
the . sun view file in your home directory. (If the file already exists, its con­
tents are replaced.) The next time you start Sun View, the infonnation in the 
. sun view file is used to recreate your environment just the way you like it. Or 
you can save several layouts and specify the one you want-see Section 5.7 for 
details. 
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4.1. Which Sun Keyboard 
Do You Have? 

4 
All About Keyboards 

This chapter tells you: 

o How to tell which model keyboard you have. 

o How to label the function keys using the stickers provided with your Sun 
documentation. 

o How to notify the Defaults Editor that you're a left-handed user of the key­
board and mouse. 

o How to change your keyboard focus to Click-to-Type. 

o How to "map" (customize) the unused function keys. 

The use of the keyboard for menu and mouse shortcuts is described in Chapter 9, 
All About Accelerators. 

Diagrams of the Type4, Type3, and Type2 keyboards are provided on the follow­
ing pages. Compare the diagrams to your keyboard to determine which type you 
have. 

This manual assumes you have a Type4 keyboard. If you have another type, use 
the labels provided with your documentation to label your keyboard so that it 
looks like a Type4 keyboard. (See Section 4.2 for details.) Then you'll be able 
to follow the keyboard references in this manual. 

If you're a left-handed keyboard and mouse user, you'll need labels even if you 
have a Type4 keyboard. 
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Figure 4-1 The Type4 Keyboard 

Num Caps Scroll Com 
Lock Lock --
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Figure 4-2 The Type3 Keyboard 
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Figure 4-3 The Type2 Keyboard 

EJ~I F3 II F
4 II FS II FG II F7 IEJEJE:j 

fEsClCJ l@l nn 1$11%1r"l1&11*1DJrn8 r:-i r:::l BACK 
L_J 1 LLl LJ.J LJ.J LJ.J LJ_J LLl LLI 9 L_g_J L:_J L::.J L:J SPACE 

~EJEJ~r:JLlrJEJ~EJr=JrnrnEJn 
~tJtJ~C:JrJrJCJc:=JtJDCJDJ~ 
I lsHIFrj lr=J[J~~t][:JEJITJITJDJI lsH1FTI 1rn; 
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4.2. How to Label the 
Keyboard 

4.3. Left-Handed 
Keyboard Use 

NOTE 

4-AllAbout 69 

This section applies only to Type2 and Type3 keyboard users and to left-handed 
Type4 keyboard users. The Type4 keyboard is already labeled correctly for 
right-handed users. 

Your workstation model number may differ from your keyboard model. For 
example, it's possible to use a Type2 keyboard with a Sun-3™ workstation, and 
vice versa. 

Other keyboards must be labeled with the stickers that come with your Sun docu­
mentation. The labels make your keyboard look like a Type4 keyboard so that 
you can follow the instructions in this manual and related manuals. 

Here's how to label your keyboard (if you 're left-handed, read Section 4.3 on 
Left-Handed Keyboard Use before following these instructions): 

o Compare your keyboard with Figures 4-1 through 4-3 to find out what kind 
of keyboard you have. 

o Follow the labeling diagram that corresponds to your keyboard type - see 
Figures 4-4 through 4-6. 

o Move the pointer over the gray background as you affix the labels to the 
keys so you won't accidentally cause a function key operation to be per­
formed. 

o Affix the appropriately sized and marked labels provided with your Sun 
documentation. 

You can remove and restick the labels, if necessary, without damaging the labels 
or the keyboard. 

The Defaults Editor, described in Chapter 10, lets you specify which side of the 
keyboard you want the function keys on. 

If you like moving the mouse with your right hand, you don't have to change 
anything. Right-handed people use the keys located on the left of the keyboard 
as their function keys. 

However, left-handed people sometimes prefer having function keys on the right 
side of the keyboard and moving the mouse on the left. They use keys in the 
right-hand keypad, IBD through I R15 l, as their function keys. 

When you set up your system for left-handed use, the LEFf and RIGHT mouse but­
tons switch so that the mouse button you click with your index finger is always 
LEFf whether you're right-handed or left-handed. 

To set up the keyboard and mouse for left-handed use: 

o Label the keyboard, as described above. Put the function key stickers on the 
right side of the keyboard. 

o Notify the Defaults Editor that you 're using left-handed mousing and func­
tion keys on the right by setting the default value for the Left_ Handed 
default line in the Input category to Yes. 
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Figure 4-5 How to Label the Type3 Keyboard 

Type3 Keyboard 
Either LI LIO 

I Stop I IAgaml 

88 
I Front 11 Copy I 

88 
EJB 

Right-Handed User 
labels on left, mouse on right 

Fl Key 

orRJ-R15 

BOB 
808 
BOB 
EJOB 
BOEJ 

Left-Handed User 
labels on right, mouse on left 

The Type3 keyboard has a pre-labeled ~ key, but the CED key acts as a 
~ key for individual windows, so put the ~ label on the CED key also. 

The "diamond" ( •) labels are for the Meta keys - the keys on either side of the 
space bar. On the Type3 keyboard, these keys are marked Left and Right. 
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61.___ _cu_t ___. 

Right-Handed User 
labels on left, mouse on right 

Fl Key 

Left-Handed User 
labels on right, mouse on left 

The even-numbered function keys between WJ and (LIO) on the left side of the 
Type2 keyboard are narrower than the odd-numbered function keys, so use the 
narrow labels for those keys. 

The "diamond" ( •) labels are for the Meta keys - the keys on either side of the 
space bar. On the Type2 keyboard, these keys are marked LEFT and RIGHT. 

The Type2 keyboard has no built-in~ key. Put the ~label on the CED 
key. 



4.4. Click-to-Type 
Keyboard Focus 

Why Use Click-to-Type? 

Chapter 4 - All About Keyboards 73 

The window that receives whatever you type is said to have the keyboard focus. 
Here's how you can tell which window has the keyboard focus: 

o The window border thickens. When a window receives the keyboard focus, 
its border changes to a bold black line. When the keyboard focus is not in 
the window, its border is a thin line. 

o The caret blinks.5 The caret represents the insertion point- the place in the 
text window that receives the next character you type or paste. When the 
keyboard focus is in a window, its caret is a small black blinking triangle 
just below the line of type. When the keyboard focus is not in a window, its 
caret appears as an unblinking gray diamond. 

Normally you set the keyboard focus - choose the window you want to type in 
-by moving the pointer into the window. This is called Pointer-in-Window or 
Mouse-to-Type keyboard focus, ap.d it's the default in SunView. 

Click-to-Type is an alternative method of setting the keyboard focus. With 
Click-to-Type, you click the LEFT or MIDDLE mouse button inside the window 
you want to have the keyboard focus, without pressing any function key. Then, 
no matter where you move the pointer, the keyboard focus stays in the window 
you clicked in. In fact, you can even type into a frame that's been closed to an 
icon when you have Click-to-Type. 

When copying text from one window to another with Pointer-in-Window key­
board focus, you must be careful to press the ( Paste ) key with the pointer in the 
destination window before moving the pointer to the source window to select the 
text to copy. Then you have to remember to move the pointer back to the desti­
nation window before continuing to type. 

Similarly, when using Dbx Tool, you can't move the pointer into the source win­
dow to select a breakpoint location and immediately type a command - you 
have to return the pointer to the command window first. 

Instead, you can use Oick-to-Type keyboard focus. Oick-to-Type allows key­
board input and mouse input to have different destinations. 

When you use Click-to-Type, the destination for keyboard input isn't changed 
until you click with the pointer in another window: 

o You click LEFT in a new window to change the keyboard focus, set the caret, 
and make a selection. 

o You click MIDDLE in a new window to change the keyboard focus while 
retaining the current selection. 

With Oick-to-Type, for example, you can move the pointer outside the text win­
dow where you 're typing in order to push buttons in a control panel or make a 
secondary selection in another window. Then you can continue typing without 
having to move the pointer back into the text window. 

5 You can fine-tune performance by turning off the Text/Blink_ caret option in the Defaults Editor. If 
you do, the caret will be a black unblinking triangle. 
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4.5. Mapping Functions to 
Keys 

Tty Windows and the 
. ttyswrc File 

D 

o To set 

o To go back to Pointer-in-Window (Mouse-to-Type) keyboard focus, type: 

You can change the way text windows and tty windows respond to some of the 
function keys and other nonalphanumeric keys by associating them with func­
tions or text filters. This is known as mapping or binding filters to keys. 

Text windows are remapped through a . textswrc file. Tty windows are 
remapped through a . ttys wr c file. In order to cause remapping, the files must 
be in your home directory. 

Which keys can be remapped depends on whether you 're operating Sun View in 
the normal right-handed mode or have set Input/Left_Handed to Yes in 
the Defaults Editor. 

With a . ttys wr c file in your home directory, you can assign alternate func­
tions to keys and change the default page mode of your tty windows . 

Table 4-1 shows the keys that are not available to be remapped. 
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Enabling Page Mode 

Fonnat of the . ttyswrc File 

Ll-LlO, Fl 

With arrow keys enabled: 
R8, RlO, Rl2, Rl4. 

4-AllAbout 

Ll,Fl 
R7, RlO, R13, 

R6, R9, R12, R15. 
With arrow keys enabled: 
R2, RS, R8, R14 

If your file tries to remap a key that can't be remapped, you'll see an error mes­
sage like this: 

.ttyswrc error: keyname cannot be mapped. 

75 

This message means that the . ttyswrc file contains function key specifications 
that conflict with the standard Sun View function key assignments. Be careful 
about trying to assign new functions to the function keys used by text windows 
or to the arrow keys. When you start a Sun View tool, Sun View takes control of 
your function keys, disallowing any other functions you may have assigned to 
those keys. 

Page mode refers to the mechanism in a tty window that lets you look at one 
windowful at a time. It's described under the 'Enable Page Mode' menu item in 
the Tty menu, in Chapter 8, All About Menus. 

By default, page mode is disabled in tty windows until you choose 'Enable Page 
Mode'. However, you can set the default to "enabled" by including the follow­
ing line in your . ttyswrc file. 

set pagemode 

The fonnat of the . ttyswrc file is: 

# Starts comments line. 
set pagemode Enables page mode. 
map i key text Inputs text when key is pressed. 
mapo key text Outputs text when key is pressed. 

Key can be any function key not shown in Table 4-1. Text may contain escape 
strings, such as \E for escape, \n for newline, and ... X for ( Control-X J. 
See termcap in the SunOS Reference Manual for the fonnat of escape strings 
recognized by tty windows. 

A tty-based program can send special escape sequences, shown in Figure 4-7, to 
perfonn certain operations. These escape sequences may also be sent using the 
mapo function shown above. The escape sequences are received by the tool that 
owns the tty window, not by the command shell that's running in the tty window. 
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Figure 4-7 Tty Escape Sequences 

\E [lt - open 
\ E [ 2 t - close (become iconic) 
\ E [ 3 t - move, with interactive feedback 
\E [ 3; TOP; LEFTt - move, to TOP LEFT (pixel coordinates) 
\ E [ 4 t - stretch, with interactive feedback 
\E [ 4; WIDTH; HTt - stretch, to WIDTH HT size (in pixels) 
\E [St - front (expose) 
\E [ 6t - back (hide) 
\E [ 7t - refresh 
\E [ 8; ROWS; COLSt- stretch, to ROWS COLS size (in characters) 
\ E [ 11 t - report if open or iconic by sending \ E [ 1 t or \ E [ 2 t 
\E [ 13t report position by sending \E [ 3; TOP; LEFTt 
\E [ 14t - report size in pixels by sending \E [ 4; WIDTH; HTt 
\E [ 18t - report size in characters by sending \E [ 8; ROWS; COLSt 
\E [20t -report icon label by sending \E] Llabel \E\ 
\E [21t report frame header by sending \E] llabel \E\ 
\ E] 1 <text>\ E \ - set frame header to <text> 
\E] I <file> \E \ - set icon to the icon contained in <file>; 

\E] L<label>\E\ 
\E[>OPT; ... h 
\E[>OPT; ... k 
\E[>OPT; ... 1 

<file> must be in iconedi t output format 
- set icon label to <label> 
-turn OPT on (OPT= 1 => pagemode), e.g., \E [>1; 3; 4h 
- report OPT; sends \E [>OPTl or \E [>OPTh for each OPT 
- turn OPT off (OPT= 1 => pagemode), e.g., \E [>1; 3; 41 

The following aliases use escape sequences. You can type them from the key­
board, or you can put them into your - I. cshrc file: 

* dynamically set the frame header of the tool: 
alias header 'echo -n "A[]l\!*A[\"' * dynamically set the label on the icon: 
alias iheader 'echo -n "A[]L\!*"[\"' * dynamically set the image on the icon: 
alias icon 'echo -n ""[]I\!*"[\"' 

the current working directory into 
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. textswrc File 

4-AHAbout 

file that 

venus% cat .rru~w~·~ 

* * startup file 
# 
set pagemode 

* Move: 
mapo T3 E[3t 
it Stretch: 
mapo T4 E[4t 
:jf Refresh: 
mapo TS E[7t 
it Move (non-interactive) to top left: 
mapo T6 E[3;1;1t 
:jf Stretch in chars (non-interactive) to half high: 
mapo T7 E[8;10;80t 
# Stretch in chars (non-interactive) to normal size: 
mapo T8 E[8;34;80t 
it Mail: 
ma pi Rl 
ma pi R2 
ma pi R3 
# Editing: 

dt 
s +planning\ndt\n 
s +bugs\ndt\n.sp 

it Bracket word in italic escapes while in ri: 
ma pi R4 iEeaE 
it Bracket word in bold escapes while in ri: 
ma pi RS iEeaE 
venus% 

Whenever you bring up a text window, Sun View looks for a . text swrc file in 
your home directory. This file lets you bind filters to unused function keys - by 
pressing the function key named in the file, you pipe the primary selection to a 
text filter as st din. The resulting output (stdout) is inserted at the caret. If 
the selection is pending-delete, the output from the filter will replace it. 

A simpler <.JU. ..... , .... u .. , ..... 

fying 
Menus. 

is to add filters to the 'Extras=>' pull-right menu by modi­
men u file, as described Chapter 8, All About 

of9 
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Format of the . textswrc 
File 

List the sample file, /usr I lib/. textswrc, to see an example of filters used 
with a right-handed keyboard. 

You can copy the sample file into your home directory and modify it. 

Here is the basic format of each . text swrc file entry: 

key-name FILTER 
command-line 

For example, 

KEY_RIGHT(S) FILTER 
\ ( \) 

causes a pending-delete selection to be enclosed in parentheses by the 
s command when is pressed. 

The filter you specify must appear in a directory accessible by your search path. 
If the command is not found, or if there is some other failure in the invocation of 
the filter, no change occurs in the document. 

The keys listed in Table may not remapped. 

Table 4-2 Keys Not Available for Remapping in . textswrc 

,_,,.,,,,,,,,.,,,,,. Keyboard 

U\;JLUUJ..Li), use 
_keyboard_accelerators and 

,.... ..... 1,.,...,. .. ., .. in the Editor. 

Do not :remap the arrow /Arrow Keys to No. 
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5.1. Anatomy of a Frame 

Figure 

Point anywhere in the frame border, 
then hold down the RIGHT mouse 
button to bring up the Frame menu. 

5 
All About Frames and Windows 

Every tool that runs in Sun View has one or more frames. An open frame con­
tains at least one window. A closed frame appears as an icon. Figure 5-1 shows 
a Command Tool frame open and another Command Tool frame closed to an 
icon. The Find and Replace frame is a pop-up frame belonging in this case to 
the open Command Tool frame. (You can bring up a Find and Replace frame 
from any text window or command window.) 

The Parts of a Frame 

• o you want to enter a caption 

ii•. b, or c : b l~l ~~t~:~~;:~~:~:~r~? 
j Do you want to specify size by Height, 
m H, W, or S : w 

What is Width of illustration? 
Width (inches) • 5 

Wi 

Resize => 
Front 
Sack 
Prop~> 

Redisplay 
? Quit 

The perimeter of the frame, known as the frame border, is where you bring up 
the Frame menu. 

Frames contain windows, where you edit text, type commands, push buttons, 
draw pictures, or do whatever the application that owns the frame lets you do. 
There are five types of windows: 

o Text windows - for displaying and editing text. 
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The Frame Header 

Pop-Up Frames 

5.2. Text Windows 

Guide REFERENCE 

o Panels - for controlling applications. 

o - for running SunOS commands. 

o Tty windows - for emulating a tty dialog. 

o Canvases - for displaying images. 

The types of windows are described later in this chapter. 

When the pointer is in a window, the can receive input from the key-
board and is said to have the keyboard focus. The window that has the keyboard 
focus has its border thickened to a bold black line. 

The wide black stripe at the top of the is called theframe header. 

The left side of the frame header contains the name of the tool that "owns" the 
frame. The rest of the frame header contains valuable information about the 
frame. For example, the Text Editor frame header tells you: 

o The name of the current file-or (NONE). 

o Whether the current file has been edited since it was last saved. 

o The default directory - the directory that is searched to store, load, or 
include a file with a relative pathname. 

As soon as you edit in the Text Editor's edit window, (edited) appears in the 
frame header. If the Text Editor frame is closed, a greater-than symbol (>) 
appears in front of the filename on the icon if you've done some editing you 
haven't yet saved. 

Pop-up frames are usually used for temporary tasks like finding and replacing 
text. Pop-up frames have 'Done' instead of 'Quit' in the Frame menu. If its 
Frame menu contains 'Done', the pop-up frame is actually a subframe. Unlike a 
regular frame, a subframe can't be closed to an icon. The Find and Replace 
pop-up frame is actually a subframe, but the Reply to or Compose Mail pop-up 
frame is a regular frame that you can close to an icon. 

Text windows let you display and edit text. 6 

Many applications are built on text window capabilities, such as Text Editor for 
files, Command Tool for command interpretation, Mail Tool for mail operations, 
and Dbx Tool for debugging. 

The text window is where you bring up the Text menu, which provides opera­
tions for loading and saving files, editing, changing how text is displayed, and 
finding and replacing text. 

6 Documentation on the programming interface for text windows is found in the Sun View 1 Programmer's 
Guide. 

sun 
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CAUTION Nothing prevents you editing a file in more than one window at the 
same time, but this is not a good idea! If you change the file in one window 
and then go on editing in another window, you wm destroy the integrity of 
the file. This is true whether you change the file using Text Editor, vi, or by 
any other means in text windows, command windows, or tty windows. 

Scratch Windows Some applications contain a special kind of text window called the scratch win­
dow, which provides a work area for the application. The scratch window has all 
the editing capabilities of a regular text window, since it has its own Text menu, 
but some of the file capabilities are disabled. 

Changing the Scratch Window 
Size 

Changing Direction with the 
Shift Key 

You can't choose 'Load File' in a scratch window, and you can't choose 'Set 
Directory'. These features, which update the frame header, are reserved for regu­
lar text windows. 

You can choose 'Store to Named File' to save the contents of the scratch win­
dow. When you want to retrieve them, choose 'Include File' from the 'File=>' 
pull-right menu in the Text menu. 

Another limitation of the scratch window is that it doesn't change the frame 
header when you save or include a file. This is actually an advantage, since you 
probably are much more concerned about the state of the document you 're edit­
ing than about the electronic scratch pad. 

You can specify the number oflines in the Text Editor's scratch window by 
using the Defaults Editor. The default is one line. 

You can also increase the number of lines in the scratch window with the Resize 
accelerator: 

o Move the pointer to the bottom edge of the scratch window. The pointer 
changes to a target. 

o Hold down the I Control) key. 

o Hold down the MIDDLE mouse button and drag the scratch window down­
ward. 

o When the scratch window is big enough, release the mouse button and the 
(Control) key. 

The (]filill key often lets you reverse an action or apply the action in the opposite 
direction. For example: I Shift-Find I means search in the Backward direction. 
(]filill in scrolling means scroll with respect to the bottom of the window, rather 
than the top. I Shift-Delete), I Sfoft-Control-W I, and I Shtft-Control-U I erase the next 
(not previous) character, word, or line. 

sun 
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You don't have to wait for an operation to be completed before you start the next 
one; you can mouse ahead. As you become more adept at working in Sun View, 
you will probably start to mouse ahead more and more. 

However, you may not get the results you expect when you mouse ahead, since 
the text window doesn't immediately figure out the location where you click-it 
finishes processing the first operation first. By the time it processes the click, the 
display may have changed, causing a different selection from the one you 
thought you made when you moused ahead. 

You can cut a word in one line, then mouse ahead and cut a word in the next line 
before the display has been updated to reflect the first cut. It doesn't matter when 
the display of the first line is updated - there won't be any effect on the next 
line. 

If you mouse ahead and make a cut later in the same line, the first cut causes the 
rest of the line to move left and your second selection may be misinteipreted. 

To mouse ahead safely in a text window, do the operations bottom to top and 
right to left. Then you can be sure of the results. 

Afilter is a command that transforms text. For example, indent and capi­
ta 1 i z e are text filters. There are three ways to filter text in Sun View: 

o You can add a text-filtering command to the 'Extras~' pull-right menu, 
which already contains a standard set of text filters. See Chapter 8, All 
About Menus, for information on how to add filters to the 'Extras~' pull­
right menu. 

o You can use the get_selection command on a command line to pass 
the selection to a text filter such as a spelling checker. get_selection 
sends the selection to a filter and inserts the resulting output at the caret. If 
it's a pending-delete selection, the output from the filter replaces it. See 
Chapter 6, All About Selections, for a discussion of pending-delete selections 
and the get_selection command. 

o You can associate a text filter with an unused function key. See Chapter 4, 
All About Keyboards, for inf01mation on how to "map" a function key to a 
filter. 

5.3. includes a command intetpreter and 
displays a command window. 
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The text on the command in a command window can edited the way 
you edit in a text window - you can and use secondary selec-
tions. (In a window, contrast, editing is limited.) 

text that's not on the command line is nonnally read-only. You can't edit it 
unless you specifically ask to do so by using the pull-right menu 
in the Text menu. in text Text 

- it lets you turn 

menu 
'llnM.,,.'ll11" in text pull-right menu. 

Nonnally you can edit only the command pull-right 
menu lets you change the transcript in the command window editing text 
in the window. The transcript is a dialog between 
user and the shell. 

You can also run tty-based programs in a command window. Well-behaved tty­
based programs cause the scrollbar to disappear when they start, and restore it 
when they're done. If you want to run a program that doesn't do this for you 
automatically, the 'Cmd Modes=>' pull-right menu lets you disable and reenable 
scrolling in the command window. See Chapter 8, All About Menus, for more 
infonnation on 'Cmd Modes=>'. 

A panel is a that lets control an application by means of various 
items such as panel buttons, choice items, and panel text items. 

You can set a i.iuJ.u.vvi 

to 

D 

o Check 

0 
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Figure 

Frame 

You can a panel text item, with 

o You or 

o You of a panel text item. When you click LEFT on any part 
a panel text item, the entire panel text item is selected. This means that 

'Copy' can't copy part of a panel text item. 

o to the restrictions you can copy and paste between 
text windows, command windows, and panel text items; and you can use the 
quick-editing features of secondary selections with Copy, Paste, and Cut. 

For more about secondary see Chapter 6, All About Selec­
tions. For more information about text-handling differences among windows and 
panels, see Table 6-3. 

Alert windows are actually panels and work the way other panels do. A large 
black arrow sweeping in from the left readily identifies a window as an Alert 
window. 

Alert windows contain a message and one or more buttons that you push. 

Alert Buttons 

Are you sure you want to 



Accelerators for Alert Buttons 

What to do if a tty application leaves 
your Command Tool without restor­
ing the scrollbar. ... 

Canvases 

5.7. Managing Multiple 
Frames 

5 - All About Frames and Windows 87 

If the alert button you want is labeled or another obvious yes, you can 
press the ( Return ) key instead of pushing the button. 

The alert button that's activated by the (Return I 
line, like the Confirm button in Figure 5-3. 

is accented by a double out-

If the alert button you want is labeled 'l....<a1u\..11:;11. or another obvious no, you can 
the (filQilJ function key instead button. 

teletype) windows give you all the bells and whistles of SunView, 
but some applications can't run in any other environment. Shell Tool provides 
an environment for applications that need a tty window. You can also request a 

window in Command Tool by choosing 'Cmd Modes===> Disable Scrolling' 
from the Text menu. 

A tty window is essentially a command window without scrolling. Editing in the 
tty command line is limited. The only deletion allowed in the command line is 
backspacing from the end of the line. You can make secondary selections in a tty 
window and you can store the primary selection on the Clipboard, as in text win­
dows. You can also copy text between tty windows and text windows. 

tty window has its own insertion called a block cursor. It's a black 
rectangle when the tty window has the keyboard focus; when the focus is else­
where, it's an outline of the cursor's rectangle. Like the caret in a text window, 
the block cursor represents the insertion point. Unlike the caret, the block cursor 
never blinks. 

When you run a command in Command Tool that requires a tty window, the 
change is usually made for you automatically, and when the command has com­
pleted, it changes the window back. For example, when you run vi in Com­
mand Tool, the scrollbar disappears. When you type : q, the scrollbar returns. 

If you need to run a non-standard program that doesn't do its own setting up, you 
can change Command Tool to a tty window yourself by choosing the 'Cmd 
Modes===>Disable Scrolling' from the Text menu. To change back, choose 
'Enable Scrolling' from the Tty menu. 

A canvas is a window that displays unformatted images. It's used for drawing. 
For example, the Icon Editor contains a canvas where you can draw and erase 
images by using the mouse. For more information about the Icon Editor, see 
Chapter 11, All About Tools, and the iconedit command in the SunOS Refer­
ence Manual. 

Deciding how to arrange your Sun View screen is as personal as deciding how to 
arrange your living room. Everyone has a slightly different idea of what works 
best. (And a few people have radically different ideas.) A few things to keep in 
mind are discussed below. 

sun 
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'Move=>' and 'Resize=>' in the 
Frame menu let you rearrange 
frames to suit your needs. 

'Back' and 'Front' in the Frame 
menu expose and hide nui:.r1:::~nn.1nn 
frames. 

'Services=>Save 
View menu saves 
of the screen. 

'HE~dl~>PlclV All' in the SunView menu 
entire screen. 

'He1d1sp1av· in the Frame menu 
display of the frame. 

to 
concerned about 

want 

A 
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6.1. Mouse, Pointer, Caret, 
and Block Cursor 

About the Mouse 

All About Selections 

This chapter covers the following information: 

o The mouse and the pointer. 

o The caret and the block cursor. 

o Selecting text and extending a primary selection. 

o Erasing text. 

o Copying, pasting, and cutting selections. 

o Pending-delete selections. 

o Quick editing with secondary selections. 

o The get_selection command. 

When you select text, you identify it to the system so that it can be recognized 
for use in editing and other operations. 

Here's a quick summary of terms. 

The mouse is used to move the pointer on the screen. To make a selection, you 
move the pointer with the mouse and click LEFT. The caret marks the insertion 
point in a text or command window. You set the caret by making a selection. 
The block cursor marks the insertion point in a tty window. In a tty window the 
block cursor is always at the end of the command line. 

The mouse translates physical motion into electronic signals so that you can 
move the pointer on the screen. For example, you use the mouse to point to text 
in a window that you want to select. 

The mouse sits on a pad, a silver plate with a blue grid. The tail of the mouse is 
a wire connected to the back of your workstation. The mouse should be posi­
tioned so that its short side is parallel to the long side of the pad, with the red 
light facing down and the three lozenge-shaped mouse buttons facing up. 7 

7 This description of the optical mouse doesn't apply to the mechanical mouse. IT you have a mechanical 
mouse with a rolling ball on the bottom, you don't have to align the mouse to the pad. 

SU 
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About the Pointer 

0 

Scrollbar Pointer Shapes 

Grip the sides of the mouse with your thumb and pinkie, with your fingers resting 
on the mouse buttons. Move the mouse in circles on the pad and the pointer 
makes circles on the screen. 

You position the pointer over Sun View objects to make selections, choose menu 
items, push panel buttons, and so on. 

The pointer's shape changes as you move it. The shape gives you information 
about where the pointer is positioned and what action is taking place. 

Each pointer has a hot spot-the place on the pointer that actually does the 
pointing. For example, the hot spot in an arrow pointer is the tip of the arrow, 
and the hot spot in a target pointer is the middle of the target. The pointers are 
designed so that you'll intuitively use the hot spot correctly. 

Here are some standard Sun View pointer shapes (some applications may use 
additional shapes). 

The basic pointer shape, which you see when you bring up Sun View, is the 
"northwest" arrow. This is the shape that appears in most windows and on the 
background. 

The pointer changes to a target when it's over an icon, a frame header or any part 
of the frame border. You can't bring up the Frame menu unless you see a target. 

When a tool is busy with an action, such as retrieving new mail in Mail Tool, the 
pointer in its frame may change to an hourglass. This means the tool won't 
respond to you until it's finished, but you can mouse ahead or type ahead. You 
can also continue working in other frames where the pointer shape is normal. 

When you choose 'Enable Page Mode' from the Tty menu, the pointer in the tty 
window changes to a stop sign whenever there's more than one windowful of 
text to display. The stop sign means, "The display has stopped but there's more 
to come." 

The right arrow pointer for menus reminds you to pull right on pull-right menus. 

The pointer changes to a diamond when in a scroll box. 
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About the Block Cursor 
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The pointer changes to a right-facing arrow when the pointer is in the scrollbar 
(anywhere except the scroll boxes) . 

When you click or hold down the LEFf or RIGHT mouse button, during scrolling 
the pointer changes to an up or down arrow to tell you the direction of scrolling. 

you 
scrollbar, 

or hold down MIDDLE mouse button in any part of the 
scrolling the pointer changes to a right-facing triangle. 

caret is 

terms caret and insertion 
in text, move 

or text: 

o The text is where caret was. 

o The caret is at the right of the inserted text. 

The block cursor is found only in windows. It represents the insertion point, 
which in a tty window is at the end of the command line. 

Unlike the caret, the block cursor sits on the line, not below it, and it never 
blinks. Its shape is a tall rectangle - solid black when the keyboard focus is in 
the tty window, outlined when it's not. 

To make a selection in a window, move the pointer to the location you want 
and click the LEFf mouse button. You can then extend the selection with the 
MIDDLE mouse button . 

...... ...,,,...,..., .... v .... .., are a way specifying operands 
:SeJlec1tlor1s also act as operands for some 

V'3'1:Tnn."lrr1 accelerators, 
AAAA•JAAU ....... A .. ;U on the Meta ) 

menu operations like 'Load 
operations, like 
Chapter All About 
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Here are 
View. 

To 

D 

In a 

To 

0 

D 

0 

a candi 

text the text 

a id 

down the MIDDLE mouse 

o pointer to the end 
mouse button. 

a selection as many 
selection. you hold 

to know text in 

you LEFT. 

to start 

and release the 

and you can ad just either 
selection 

is adjusted. You can make a ~1;;-..1.1.;..1,.,1...1vu or smaller 
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When you click the LEFT or MIDDLE mouse button, two things happen: 

o One or more characters are selected. 

o insertion point is specified. 

The insertion point is the place where the next character you insert will go. The 
caret, a blinking triangle, represents the current insertion point. When you make 
a selection, the caret appears at the end of the selection closest to the pointer. 

The insertion point is always between characters. For example, to place the 
insertion point between letters m and u in the word muse, position the pointer 
anywhere between the middle of m and the middle of u, then click LEFT. 

I can always get a pointer from my m se. 

To insert text, just type. Here's what happens if you type o: 

I can always get a pointer from my mouse . 
.& 

The basic editing operations are: 

o Insert - type or paste. 

o Erase remove text from the document. 

o Delete - remove text and place it on the Clipboard. 

o Duplicate - make a copy of text at another location. 

o Move- remove text from its present location and place it somewhere else. 

o Replace - delete text and move or duplicate other text to take its place. 

Text windows let you do any kind of editing. Command windows, tty windows, 
panel text items are subject to a restrictions, as summarized in Table 

Text Handling in Windows later in this chapter. 

no 

at caret 
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erase 

To erase 

has no effect. 

text .. .,, ... ,,.....,,..r1. 

the,..=..,;:="-' 
to caret. To erase 

caret 

text 

To 
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6.4. Copying, Pasting, and 
Cutting 

Table 6-1 

Chapter 6 - All About Selections 97 

Editing frequently requires copying and pasting or cutting and pasting. You can 
perform these operations in any of the ways shown in Table 6-1. Here are a few 
examples: 

o When you have a long pathname in a command window that you don't want 
to retype, you can copy and paste. 

o When you want to duplicate a format you've used earlier in a document, you 
can copy and paste in a text window. 

o You can cut and paste in a Mail Tool composition window to move a para-
graph from one place to another. 

Copying doesn't affect the text you copy. Cut removes the selection from its 
current location. Paste puts it in a new location. Copying and cutting both put 
the selection on the Clipboard. Paste inserts the contents of the Clipboard at the 
caret. 

Copy, Paste, and Cut-Alternative Methods 

Menu Item Function Key Menu Accelerator 
'Edit=>Copy' ~ ~ 
'Edi t=>Paste' (Paste I (+-VI 
'Edit=>Cut' ~ I +-X) 

The examples in this chapter use the function keys to copy, paste, and cut, but 
you can use any of the methods shown in Table 6-1. The Meta ( •) keys are 
described in Chapter 9, All About Accelerators. 
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The key stores selected text on Clipboard without deleting it 
from the document. example to filename 

. limerick a to the com-
mand in the same window. (The head -1 command lists the first line of a 
file. See the SunOS Reference Manual more information about the head 
command.) 

To copy text from one location to another: 

o Select the text you want to copy and press ~. 

original .limerick0
/., 

o Select to set the new insertion point if necessary. 

o Press ( Paste J to copy from the Clipboard to the insertion point. 

.... venus0
/, cd "" 

~\: /usr /nutmeg/sages 
r~ venus% ls *lim* 
\~lesson! .1 imerick original.limerick 
~ venus% head -1 original .limeri 

sun 
rnicrosystems 

original. limerick"/ .. 
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The CTdit] function key deletes selected text from the document and stores it on 
the Clipboard. The example shows how to delete the word Cajun, together with 
the space following it, and paste them in front of the word catfish. 

To move a selection from one location to another: 

o Make the selection and press CTdit]. The selection is deleted and placed on 
the Clipboard. 

1 ary, 
This is the third day of my California Yuppie Diet. 
Today I ate blue cornmeal pancakes for breakfast,~ 
~sushi for lunch, and catfish for dinner. ~ 
+omor:~w, will have sprouts and sun-dried tomatoes. 

o Select to set a new insertion point if necessary. 

ow 
Diary, 
is the third day of my California Yuppie Diet. 

Today I ate blue cornmeal pancakes for breakfast, \ 
sushi for lunch, andl~atfish for dinner. 
Tomorrow, will have ~routs and sun-dried tomatoes. 

o Press ~ to copy from the Clipboard to the insertion point. 

sun 
microsystams 

Dear Diary, 
This is the third day of my California Yuppie Diet. 
Today I ate blue cornmeal pancakes for breakfast, 
sushi for lunch, and Cajun catfish for dinner. ~ 
Tomorrow, will have sprout~and sun-dried tomatoes. 
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As soon as you've cut text, you 're ready to start inserting a replacement. The 
example shows you how to change salad to soup. 

To replace a selection by typing: 

o Select the text you want to replace. 

ear 1ary, 
California Yuppie Diet, day 10. Let 1 s see ... ~ 
tomorrow I'll have watercress 

o Press a&D. insertion point is now where the deleted text was. 

D 

ear Diary, 
California Yuppie Diet, day 10. Let 1 s see... ~ 
tomorrow I'll have watercress 

.I. 

the reorncement text. 

e Diet, 10. Let s see... ~ 
watercress soup . 

.I. 
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Copying Text Between 
Windows 

6 - All About Selections 101 

You can copy or move a selection from one window to another window the same 
way you did within a single window. The example shows you how to copy 
watercress salad from a listing in a Command Tool window into a Text 
Editor document: 

o Make the selection in one window and press CQIDY]. 

Dear Diary, 
California Yuppie Diet, day 10. Let's see ... 
tomorrow I'll have .. 

o Move the pointer into the other window. Select to set the insertion point if 
necessary. (In this case, the caret is already where you want to Paste.) 

~ venus o cat 
?:: pine nuts 
:/:: rad i cch i o 

+~.!! 

natercress salad 

day 10. 

baby carrots 
purple potatoes 

Let's see ... 
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6.5. Undoing Editing 
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: venus% cat yuppie_ ood 
::) pine nuts 
·.-:.: radi cchio 

venus% 

a baby carrots 
purple potatoes 

You can also move text from one window to another in the same way, using 
I Cut I instead ~. 

Sometimes you realize that you've just edited something you wish you hadn't. 
The Undo operation is a way of restoring the text window to its previous state. 
Undo undoes whatever editing you did since the last time you either made a 
selection or performed a Copy, Paste, or Cut. 

window keeps its own Undo information - unlike the Clipboard, which all 
windows share. 

o To undo the most recent editing, choose 'Undo Last Edit' from the 
pull-right menu in Text menu, or press the I Undo ) func-

tion key. The keyboard accelerator for 'Undo Last Edit' is ____ ...,._,. 

D 

D 

ment. 

D 

is no way to Undo an Undo. 

undoes the made since the previous 
change. You can continue to undo by "changed insertion 

one of the following limits, whichever comes first: 

File'. 

want to undo your edits at once, 
...,,,,. ............ ,, ........ , you save your .......... .., ........... ..,,, .. .. 

default limit is intervals). 

to the last time you saved the 
the button 

discover you inadvertently 
dint throughout the 

whichever is most 
LJ~A ... AA~AAL menu. 
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Selecting 
Clicking 

Multi-

You can double-, triple- or 
quadruple-click to select words, 
lines, or the entire document, 
respectively. 

Extending a Multi-Click 
Selection 

6 - All About Selections 103 

Multi-clicking is a short-cut that lets you select a word, a line, or the whole docu­
ment without having to extend the selection. 

When you make a selection by multi-clicking, the caret appears at whichever end 
of the selection is closest to where the pointer was. For example, when you 
double-click anywhere to the left of the letter u the word pet uni a, the 
caret appears before the letter p. 

Using multi-clicking, you can easily position the caret before or after a or 
at the beginning of a line. 

When you click LEFT, a character is selected. 

To select a word: 

o Point at any character in the word and double-click LEFT. main attrac-
tion of word selection is speed and convenience you don't have to care­
fully select the first and last characters in the word. A word is one or more 
alphanumeric characters plus underscore ( _ ) bounded by non-alphanumeric 
characters, or vice versa. For example, yankees /mickey_ mantle con­
tains three words (yankees, I, and mickey_mantle), while 
yogi_ berr a_ and _j oe _ dimaggio _and_ case y _ s tenge 1 contains 
only one word. 

To select a line: 

o Point anywhere in the line and triple-click LEFT. 

To select the entire document: 

o Point anywhere in the window and quadruple-click LEFT. 

Whether two clicks are interpreted as a double-click or not depends on the time 
between clicks. You can adjust Sun View's sensitivity to multi-clicking by 
changing the Defaults Editor's Text/Multi_ click_ space and 
Text/Multi_ click_ timeout settings. 

When you select a word by double-clicking and extend the selection, the selec­
tion is extended in units of a word. Similarly, when you select a line by triple­
clicking, the selection is extended in units of a line. This means you don't have 
to get too precise when pointing to the end of the extended selection, but it also 
means that the extension is only as precise as the multi-click unit (words or 
lines). 

There is a way to adjust a multi-click selection precisely: 

o Point to the very end of the selection-whichever end you want to adjust. 

o Hold down the MIDDLE mouse button and wipe through the selection until 
it's the way you want it. You can wipe one character at a time. 

SU 
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~n,.irn:1n,PrP in 

the word gone and click 

No matter how 
f"'l1r•IT1.,..,,,.. MIDDLE 

a 

D 
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o Click LEFT to set the caret where you want the text copied. 

vanilla 
coffee 
strawberryl 
chocolate ?hip 
coconut almond fudge 
maple banana nut 

o Hold down the ( Paste ) key while selecting the text to be copied. The text is 
underlined to indicate that it's a secondary selection. 

vanilla .._ 
coffee ·\ 
strawberryl 
chocolate chip 
coconut almond fudge 
maple banana nut 

o Release the I Paste ) key. The secondary selection is pasted at the caret. 

vanilla 
coffee 
strawberry vanilla ~ 
choco 1 ate chip ., 
coconut almond fudge 
maple banana nut 

NOTE When you use secondary Paste to get text from another window, be sure the 
pointer is in the "to" window when you first press the key; otherwise the 
keyboard focus will shift and you' II paste in the "from" window. The secondary 
selection is pasted into the window that has the keyboard focus at the time you 
press 
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Stopping a Secondary 
Selection 

6.8. Pending-Delete 
Selections 

Guide REFERENCE 

NOTE 

D 

D 

To set the ......... ,.,,,...._.,,.,..,... 

use sel:onaa1.-y 

o Make a 

o Hold down the \,...::::::.!:;JJ;:..J._,,J 

text you want to delete. 

on 

caret clicking LEFT. 

o Release the The primary is copied to or 

The 

of secondary selection, depending on which you clicked nearest to. 
caret moves to the end of the """'"",...._,,,.,...,. 

To search for a secondary selection, hold down the key while selecting 
text. secondary selection is searched when you release the function key, 

the first occurrence that's found is highlighted. The search is in a forward 
direction, but you can reverse it by holding down (Shift-Find I while selecting 
text. This is a handy way to search without changing the Oipboard or the current 
primary selection. Note that the search begins at the caret, not at the secondary 
selection. 

When you start a secondary operation - example, hold down ( Paste ) and 
select some text - and then decide you don't want to complete the operation, 
press the [filQfil key to reset the window. 

If a text window gets stuck so it makes only secondary selections, press the G51QQ) 
key to reset the window. 

When you want to replace a selection immediately after you make the selection, 
pending-delete selections make your job easier. A pending-delete selection is 
replaced the next time you type or Paste. 

Pending-delete primary selections are highlighted in dark gray. Think of the 
characters as less visible because they are fading away, soon to gone 
altogether. 

'Load File'. 

o make a primary selection pending-delete, hold down the· I Control) key 
while selecting or adjusting the seit~cnon. 

s 
microsystems 

ae1ere:a only when you insert or type some­
"'"' .. ''"''-' ... JLVU. without performing any operation 
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or inserting any characters the pending-delete selection isn't affected. 

You can change an existing selection to a pending-delete selection by holding the 
I Control I key down and adjusting the selection, in other words, clicking MIDDLE 
while pointing at one of its endpoints. The original selection becomes a 
pending-delete selection. 

You can remove the pending-delete status of a selection by performing the 
reverse operation: adjust the selection by pointing at one of its endpoints while 
the r Control I key is not held down. 

Pending-delete secondary selections are underlined and highlighted in light gray. 

o To make a secondary selection pending-delete, hold down the (Control) key 
together with the function key. 

The following example shows you how to use a pending-delete secondary selec­
tion to move the word positive from the middle of the sentence to the end. 

To move text from one location to another: 

o Set the caret at the destination. 

tuate t e pos1t1ve a vantages o t e 
our sales curve will be.JI ~ 

o Hold down the ( Control I and ( Paste] keys. 

o Select the text you want to move. The selection is underlined to indicate 
that it's a secondary selection and highlighted to indicate that it's pending­
delete. 

centuate thej;~:P.~~Jt::f;!t~ advantages of the pr'"'~~·~ v .. 

d your sales~curve wil\ bel 

o Release the ( Control l and [ Paste I keys. The secondary selection is inserted 
at the caret. 

What's more, if the destination is a pending-delete primary selection, the primary 
selection is deleted and placed on the Clipboard. 

SU 
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6.9. Quick Editing with 
Secondary Selections 

The use of secondary and pending-delete selections provides a streamlined way 
of moving, copying, and replacing text. Here's a summary: 

o Use pending-delete selections to mark text for deletion (hold down the 
I Control I key while making the selection). 

o Use secondary Paste to move or copy text there-to-here, in other words, 
from somewhere else to the caret. When you 're working in a tty window 
such as Shell Tool, secondary Paste is the equivalent of 'Stuff'. 

o Use secondary Copy to move or copy text here-to-there, in other words, 
from the caret to somewhere else. 

o Use secondary Cut to delete text without affecting the caret. 

o Use swapping to make the primary selection and the secondary selection 
change places. 

In the techniques described below, here means where the caret is, there means 
elsewhere. I Control-Paste ) means hold down the (Control I key and the ~ 
key at the same time. 

These methods work for text and tty windows as well as panels, although tty win­
dows do not support deletion. 

Table 6-2 summarizes all the quick-edit techniques that use secondary selections. 
To use these techniques, first make the primary selection, then make the secon­
dary selection. The techniques are described in detail following the table. 
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Table 6-2 Quick Editing with Secondary Selections 

To 

HERE: 
Copy secondary selection 
to caret. 

MOVE HERE: 
Move eoor•nnrl "'""'' i.)\.,.Lv\ .... t..l\.,IU. 

to caret. 

MOVE AND REPLACE HERE: 
Move secondary 0v.L•vvl..lVJ.A 

to replace primary selection. 

DUPLICATE THERE: 
Copy primary selection 
to left or right of secondary selection 
without moving caret. 

MOVE THERE: 
Move primary selection 
to left or right of secondary selection 
without moving caret. 

DUPLICATE AND REPLACE THERE: 
Copy primary selection 
to replace secondary selection 
without moving caret. 

MOVE AND THERE: 
Move primary "'-'.L''-''-''-1v.u..u. 

to replace secondary selection 
without caret. 

DELETE 
secondary se1ject:mn 

without "1T'"'"'f',,.,....,,. 

primary selection or caret. 

Make primary 

nonnal or none 
(sets caret) 

pending-delete 

nonnal 

pending-delete 

nonnal 

Chapter 6 - All About Selections 109 

Make secondary 
seliectiwn using ... 

I Control-Paste ) 
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the caret. 

D text. 

D at caret. 

To move text from its onJQ;Incu location to the caret: 

o Press Willlllrn!:!:illrn;tJ 

lined 

D text 

D 

D 

0 

D 

o Press Willlllrn!:!:illrn;tJ replacement text. replace-
ment text is underlined and 

o selection is placed 
on the text is moved from its former 
location to where the primary selection was. 
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Secondary Copy operations let you edit here-to-there. The location of the caret 
doesn't change. 

Duplicate There 
To copy the primary selection to another location without moving the caret: 

o Make a primary selection. 

o Hold down ~' then click LEFf at the new location. The new loca­
tion is underlined. 

o Release ~- The selection is copied to the new location - to the 
left or right of the underlined text, depending on which end you clicked 
nearest to. The caret stays where it was. 

Move There 
To move the primary selection to another location without moving the caret: 

o Make the primary selection pending-delete (hold down I Control J while 
selecting). 

o Hold down ~ while selecting the new location by clicking LEFf. 
The new location is underlined. 

o Release ~. The primary selection is moved to the new location -
to the left or right of the secondary selection (the underlined text), 
depending on which end you clicked nearest to. The caret stays where 
the primary selection was. The Clipboard is not changed. 

Duplicate and Replace There 
To copy the primary selection to replace text at another location without 
moving the caret: 

o Make a primary selection. 

o Hold down I Control-Copy I while selecting the text to be replaced. The 
text to be replaced is underlined and grayed. 

o Release ( Control-Copy I. The primary selection is copied, replacing the 
secondary selection (the text to be replaced), and the secondary selec­
tion goes on the Clipboard. 

Move and Replace There 
To move the primary selection to replace text at another location without 
moving the caret: 

o Make the primary selection pending-delete (hold down I Control ) while 
selecting). 

o Hold down [ Control-Copy ) while selecting the text to be replaced. The 
text to be replaced is underlined and grayed. 

o Release I Control-Copy I. The secondary selection (the text to be 
replaced) is deleted and placed on the Oipboard. The primary selection 
moves to where the secondary selection was. The caret stays where the 
primary selection was. 
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Secondary Cut erases text anywhere in the document without changing the inser­
tion point. 

Secondary is useful when you 're typing along and notice something you 
want to delete. It lets you delete the text without moving the caret, so you can 
delete someplace else and go right on typing. 

Delete There 
To erase text without moving the caret: 

o Press [Ciii:) while selecting the text to delete. The secondary selection is 
underlined and grayed. 

o Release (1d!D. The secondary selection is deleted and placed on the 
Clipboard. The caret stays where it was. 

S ll fl Revision A of 9 May 1988 
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Here's a fast way to swap text using secondary selections. The example shows 
you how to exchange items in a list. 

Swap Here and There 
To exchange the primary selection with other text: 

o Make the primary selection pending-delete (hold down I Control J while 
selecting). You don't have to worry about which item in the swap is 
which. Just pick either one to be the primary selection. 

o Press I Control-Copy I while selecting the text to swap. The secondary 
selection is underlined and grayed. 

o Release The secondary selection is deleted and placed 
on Oipboard. The selection moves to where the secondary 
selection was. The caret stays where the primary selection used to be. 

coffee. 

teeth.~ 

o Press (This is regular Paste, not secondary Paste.) The text on 

SU 
microsystems 

the Clipboard - the former secondary selection - is inserted at the 
completing the swap. 

Drink coffee. 
Get out of bed.~ 
Brush teeth. .t. 
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Description 

Insertion point 

Menu 

Select text 
Insert text 

Erase text 

'Copy' 
'Paste' 

'Cut' 

'Undo' 

Pending-delete 
selection 
Secondary selec-
tion - source 
Secondary selec-
tion - destination 

Guide REFERENCE 

respect 
to C'PIPf'f-1f"\TlC' 

Text are share the Text 
menu. In general, whatever editing you can 
on the command in a command Whatever is not on the command 
line is normally "read-only," but you can edit all of the command window if you 
first choose 'Enable Editing' from the Modes~' pull-right menu. 

In tty windows and panels, you can do a subset of text window editing. In these 
windows you can insert or erase text only at the end of the command line or 
panel text item. Certain other restrictions apply, as shown in the table. 

If you choose 'Services~Remote Login~Command Tool' from the Sun View 
menu or type the r login command in a command window, text handling in the 
command line follows the rules for tty windows in Table 6-3. The rest of the 
command window follows the rules for command windows-that is, it's read­
only unless you choose 'Enable Editing'. 

Table 6-3 Text Handling in Windows and Panels 

Text Window Command Window Tty Window Panel Text Item 

Caret Caret Block cursor Caret 

Text menu Text menu with Tty menu No 
'Cmd Modes~' 

1 or more chars 1 or more chars 1 or more chars Entire item 
Anywhere Anywhere in com- At end of com- At end of item 

mand line mand line 
Anywhere Anywhere in com- From end of com- From end of item 

mand line mand 

1 or more chars 1 or more chars 1 or more chars Entire item 
Anywhere Anywhere in com- To of com- To end of item 

line mand line 
Anywhere Anywhere in com- No Entire item 

mand line 
Anywhere Anywhere in com- No No 

mand line 

Anywhere Anywhere in com- No No 
mand line 

1 or more chars 1 or more chars 1 or more chars Entire item 

Anywhere Anywhere in com- End of command End of item 
mand line line 

SU 
microsystems 
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Using selection command, which is described in the SunOS 
"'""""'' ... , ......... gives lots of nice ways to work with selections. 

o To save the selection in a file (especially useful when you want to save part 
of a mail message): 

Piping is a way of stringing commands together. The pipe symbol is a vertical 
bar ( I). The output of the command on the left of the pipe is passed as input to 
the command on the right of the pipe. 

o To pipe the selection to a print command: 

o To pipe the selection to a spelling checker: 

o To use the selection - for example, a directory name - on the command 
line: 

The backquotes ( ' ') mean "not the thing, but the meaning of the thing." In 
other words, the command line ls -a 'get_selection' tells the com­
mand interpreter to evaluate 'get_ selection' before making the list. 

NOTE When using get_selection in a command, you mustwai; until the command 
completes before making another selection. 

Whenever you type, the current selection is deselected if it's in the same window. 
Therefore you may lose the selection that you want get_ selection to work 
with. You can get around the problem by copying the selection to the Clipboard 
and using it from there. 

sun 
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o To preserve the current selection, copy the selection to the Oipboard by 
pressing ~' then type: 
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7 .1. Anatomy of the 
Scrollbar 

7 .2. Basic Scrolling 

Scrolling Up or Forward 

All About Scrolling 

Often the document you 're editing is too large to be entirely visible within the 
text window. You can resize the window, but most often you'll want to scroll 
the text through the window. To access parts of the document that aren't visible, 
you scroll to move the document relative to the window. 

The infonnation about scrolling in text windows in this chapter also applies to 
command windows, panels, and all windows with scrollbars that you'll encounter 
in this manual and in other Sun View manuals. 

At the left of each text window is a gray column called the scrollbar. The light 
gray area is called the bar. 

The bar contains a darker gray area called the bubble. The bubble indicates the 
relative size and location of the the visible text within the document. For exam­
ple, if the bubble is about one-fourth the size of the bar, the document is about 
four windows in length. 

At the top of the scrollbar is a square that contains up/down arrows. It's known 
as a scroll box. There's an identical scroll box at the bottom of the scrollbar. 

Both scroll boxes operate the same way; the bottom scroll box is a convenience 
when you 're editing near the bottom of the window. 

The figures in this manual show the default scrollbar. However, you can change 
the appearance of the scrollbar, whether it's there all the time, what color it is, 
what side of the window it's on, how wide or narrow it is, and so on, by changing 
scrolling options in the Defaults Editor. 

Basic scrolling takes place with the pointer in a scroll box. Direct, or advanced, 
scrolling takes place with the pointer in the bar. 

When you move the pointer into the scroll box, its shape changes to a diamond. 

o To scroll the document up one line, click LEFT in the scroll box. 

The pointer shape changes to an upward-pointing arrow while scrolling, and the 
document moves through the window. 

sun 
microsystems 
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Scrolling Down o:r 

Scrolling a Windowful at a 
Time 

Continuous Scrolling 

7 .3. Direct Scrolling 

Thumbing in the 

The line closest to the start of the document disappears at the top of the window 
and a new line appears at the bottom. 

You can of this as scrolling forward. 

o To scroll document down one RIGHT in the scroll box. 

The pointer shape changes to a downward-pointing arrow while scrolling, and the 
document moves through the window. 

The line to the end of the document disappears at the bottom of the win-
dow and a new at the top. 

You can think this as scrolling om:Kwara 

You can scroll at a faster pace by .,...,A,,_,~,UA- a windowful at a time. This is some­
times called "paging." 

o To scroll up or forward by one windowful, click MIDDLE in a scroll box. 

o To scroll down or backward by one windowful, hold down the (filiill) key 
while you click MIDDLE in a scroll 

By holding down the mouse button instead of clicking and releasing, you can 
automatically repeat any scroll box operation. 

clicking the mouse buttons in the bar, rather than in a scroll box, you can 
scroll directly to anywhere in the document. The direction you scroll is con­
trolled by the mouse buttons. 

You can use direct scrolling to move a large distance in the document by thumb­
ing, or to make small adjustments in the window by fine tuning. 

Thumbing lets you flip to a page in the document as you would flip through a dic-
tionary or telephone book. You use MIDDLE mouse button for thumbing. 

0 To thumb, click MIDDLE in the bar. 

The actual distance scrolled depends on where you click in the bar. Click MID-
DLE down in the bar to scroll to middle of the document, click MID-

bar to scroll to the start the document, and so on. 

o To undo thumbing, click (filiill)-MIDDLE in the bar. 

When you undo thumbing, the document scrolls to the last click-MIDDLE, the last 
Find that a scroll, or the last ( Shift )-MIDDLE, whichever is most recent. 

For example, you can thumb to another part of the document, paste or type, and 
undo thumbing to return to the previous location. 

I End I keys are another way of scrolling directly. 
to the beginning aoc:umem. and CE!ia] scrolls to the end. 

1-1""1"''""'r ,....,,,.,,...--.. and I End I also move caret, while thumbing leaves the caret 
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at its current location. 

You can use direct scrolling to adjust the placement of text in the window. For 
instance, you may want to see the lines that precede the line at the top of the win­
dow. 

o To move the line at the top of the window to the pointer, click RIGHT in the 
bar. 

Clicking RIGHT in the bar lets you see preceding lines. The further down in the 
bar you click, the more preceding lines you'll see. 

o To move the line opposite the pointer to the top of the window, click LEFT in 
the bar. 

Clicking LEFT in the bar lets you move a line directly to the top of the window 
and exposes more text at the bottom of the window. 

Hold down the [ Shift) key to fine tune with respect to the bottom of the window. 
is especially useful when the upper portion of a window is overlapped by 

another frame. 

o To move the line at the bottom of the window to opposite the pointer, click 
in the 

o To move the line opposite pointer to the bottom of the window, click 
in the 

undoes (]]ill[)-RIGHT, and vice versa. 
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Menus General 

How to Bring Up a Menu 

All About 

This chapter describes all the standard Sun View menus: 

o The SunView menu. 

o The Frame menu. 

o The Text menu (including command window menu items). 

o The Tty menu. 

The menu items described in the chapter are in the same order as they appear in 
the menus, so you can use the menus themselves as an index to the chapter. 

This section discusses features common to all menus in SunView. 

You can bring up any menu by holding down the RIGHT mouse button. Which 
menu pops up depends on where the pointer is: 

o The Sun View menu pops up when the pointer is over the Sun View back­
ground. 

o The Frame menu pops up when the pointer is over any part of the frame 
border. When the pointer is over the frame border, its shape changes to a 
target. 

o The Text menu pops up when the pointer is in a text window or a command 
window. 

o The Tty menu pops up when the pointer is in a tty window or a command 
window with scrolling disabled. 

When the menu appears, keep holding down the mouse button until you make a 
choice from the menu or dismiss it. The pointer changes to a right arrow as a 
reminder to move the pointer right to preview pull-right menus. 

o To choose from a menu, highlight the menu item you want by moving the 
pointer over it; then release the mouse button. 

o To dismiss a menu without choosing a menu item, move the pointer to the 
left so that no menu item is highlighted; then release the mouse button. 
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possible - for example, if it requires a selection and there isn't one - no action 
is taken 

NOTE Last Selection is very nice if you're careful and experienced, but it can get 
you into real trouble. If you use this option, be sure you know what the default is 
when you choose a pull-right menu without opening it. 

Stay-Up Menus If you get tired of holding the mouse button down while you look at a menu, you 
can change the Menu/ Stay_ up option in the Defaults Editor from False to 
True. Then your menus will appear when you click the RIGHT mouse button 
and disappear when you click it again. With stay-up menus, you click in a 
highlighted menu item to choose it. 

Menus in Panels Many panel items have menus associated with them. These work just like the 
standard Sun View menus. To bring up a menu in a panel, move the pointer over 
a panel item and hold down the RIGHT mouse button. The current choice in the 
menu may be indicated by a check mark. 
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The 'Shells=>' 
Menu 

The 'Editors=>' Pull-Right 
Menu 

The 'Tools=>' Pull-Right 
Menu 

The 'Services=>' Pull-Right 
Menu 

'Redisplay All' 

'Printing=>' 

or other 

choose its menu item. 

':lrlfl1T1noTI':ll 1TIT,r\V"n'\':lT"ll"\TI about tools in menu, see Chapter 11, All 
and the SunOS Reference 

A shell is a window accepts commands. The 'Shells=>' pull-right 
menu contains menu items for the following Sun View shells: 

'Command Tool' 
'Shell Tool' 
'Graphics Tool' 
'Console' 

To bring up a shell, just choose its menu item. You can have several shells open 
at the same time. 

The 'Editors=>' pull-right menu contains menu items for tools that create and 
revise documents, icons, and fonts, plus a tool that lets you change Sun View 
defaults. The following editors are included: 

'Text Editor' 
'Defaults Editor' 
'Icon Editor' 
'Font Editor' 

The 'Tools=>' pull-right menu contains menu items for additional important 
applications, including: 

'Mail Tool' 
'Dbx (debug) Tool' 
'Performance Meter' 
'Clock=>' 

You can choose either a round or rectangular clock face from the 'Clock=>' 
pull-right menu, which contains icons instead of menu-item names. 

The 'Services=>' pull-right menu contains a variety of useful options. 

Choose 'Redisplay All' to refresh the screen. This is useful if the screen image 
appears to have become corrupted. 

The 'Printing=>' pull-right menu lets you check the status of print jobs and print 
a selection. 

o 'Check Printer 
dow. 
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o 'Print Selected Text' sends the current selection to the printer. 

NOTE Don't change the selection until you see the Selection printed message in 
the Console window. 

'Remote Login=>' The 'Remote Login=>' pull-right menu lets you bring up a new Command Tool 
or Shell Tool and connect to a remote host. Type the name of the remote host in 
response to the prompt. 

'Save Layout' 

The . sunview file. 

'Lock Screen' 

'Exit Sun View' 

When you've finished the. session on the remote host, type exit to end the ses­
sion. The Command Tool or Shell Tool quits automatically. 

Choose 'Services=:>Save Layout' from the SunView menu to save the current 
Sun View screen layout in the - I. sun view file. 

The . sunview file contains the locations of your open and closed frames. 
Whenever you restart Sun View, the startup screen is laid out according to the 
. sun view file. For example, if a frame was open when the . sunview file 
was created, it will be opened whenever you start SunView.8 

If the . sunview file doesn't exist, the standard startup screen is produced. 

'Save Layout' executes the toolplaces command, described in the SunOS 
Reference Manual. 

Choose 'Lock Screen' to display a randomly moving Sun logo on a black back­
ground. This prevents the screen from burning in a constant image. Locking the 
screen also provides privacy, since no one can unlock the screen without know­
ing your password. 

To unlock the screen, click any mouse button or press any keyboard key except 
(fl] or [Qiii], then type your password and press I Return I. 

Choose 'Exit SunView' to return to the SunOS shell. 

If there's a serious system problem and you can't bring up the Sun View menu, 
you may be able to "bail out" - this works only if the pointer is over the gray 
background, not over a frame or icon: 

o Type ( Control-D) followed by ( Control-Q) for an emergency exit of Sun­
View. (It's not a good idea to exit Sun View this way unless you have to.) 

8 For compatibility with previous releases, if the . sunview file isn't found, Sun View looks for a 
. sun too 1 s file from which to restore the screen layout. 
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0 new file to Defaults 
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o Restart 

you can new Sun View menu. 

menu restarted Sun View, you can 
see them immediately-you don't have 

to restart Sun View again. 

Making a rootmenu Figure 8-1 shows you the standard Sun View menu file. 
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Figure 8-1 Sun View Menu File in /usr I lib/ rootmenu 

I 
I 
I 
I 
"Shells" 

@(l)rootmenu 15. 7 tl I /08/19 SMI 

sunview root menu 

"Command Tool" 
"She 11 Too 1" 
"Graphics Tool" 
"Console" 

MENU 
cmdtool 
shelltool 
gfxtool 
cmdtool -C 

"Shells" END 
"Edi tors" MENU 

"Text Editor" 
"Defaults Editor" 
"Icon Editor" 
"Font Editor" 

"Editors" 
"Tools" 

END 
MENU 

textedit 
defaultsedit 
iconedit 
fontedit 

"Mail Tool" mailtool 
"Dbx (debug) Tool" dbxtool 
"Performance Meter" MENU 

"Percent CPU Used" 
"Ethernet Packets" 
"Swapped Jobs" 
"Disk Transfers" 

"Performance Meter" END 
"Clock" MENU 

<lusr/include/images/clock.icon> 
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perfmeter -v cpu 
perfmeter -v pkts 
perfmeter -v swap 
perfmeter -v disk 

"Clock" 
<lusr/include/images/clock.rom.icon> 

END 

clock 
clock -r 

"Tools" END 
"Services" MENU 

"Redi sp 1 ay A 11" REFRESH 
"Printing" MENU 

"Check Printer Queue" sh -c "echo; echo '-----------------';echo 
'Printer queue'; lpq; echo '-----------------'"G" 

"Print Selected Text" sh -c "get_selection I lpr ; echo 'Selection 
printed' ,AG" 

"Printing" END 
"Remote Login" MENU 

"Command Tool" cmdtool csh -c "echo -n 'Hostname? '; exec rlogin $< 

"Shell Tool" shelltool csh -c "echo -n 'Hostname? '; exec rlogin 
S<" 

"Remote Login" END 
"Save Layout" sh -c "mv -f "'/.sunview -/.sunview-;toolplaces>.sunview; ech 

o 'Screen layout saved (Previous layout in .sunview-) '" 
"Lock Screen" 1ockscreen 

"Services" 
"Exit SunVi ew" 

END 
EXIT 

The name of each menu item is surrounded by double quotation marks ("). Each 
pull-right menu with a MENU statement and ends with an END statement. 

The Sun View menu file must not contain any an otherwise 
line a pound (#). okay to start a line with a Tab character or 

space, as long as the rest of the line isn't blank. 

For each menu item, supply the name of the menu item in quotes followed by the 
command you want Sun View to execute when the menu item is chosen. If the 
command has options, you can specify them right after the command name. 

The command consists of one or more shell commands. Let's say you have writ­
ten a program called peacenow and you want it to be the default in the 'Edi­
tors=>' pull-right menu. To include your program and its options in the 

sun 
microsystems 

Revision A of 9 May 1988 



Icons the 

Guide REFERENCE 

menu, 

0 a nText Edi-

0 ~·~0~~.~~'as-/rootmenu. 

-you to 

0 change the 

D Push Save 

D and restart. 

Now you can open the Sun View menu 
with the options specified. 

choose , which 

"Clock" MENU 8-1 displays not menu 

run 

names. can menu to display the icons of all 
the tools it contains, or you can create your own icons using the Icon Editor. 

The standard icons are found in the I directory. 

To replace a menu item name with its corresponding 

o include I images to find the icon you want (or make your 
own). All of the filenames ending in . icon are icons. 

o Replace the menu item name in your SunView menu file c- /rootmenu, 
described above) with the name the icon enclosed in < > brackets; for 
example: 

</usr/include/images/textedit.icon> 

o Save the - I rootmenu file. 

o Bring up the Sun View menu to see new icon. 
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The Frame menu is used to open or close, move, expose, hide, and 
redisplay frames. It also lets you quit the tool that owns the frame. You can 
bring up the frame menu over an open frame or over an icon. 

o To bring up the Frame menu, move the pointer over the frame header or any 
other part of the frame border so that the pointer changes to a target. Then 
hold down the RIGHT mouse button. 

When you bring up a tool, its frame is open and the Frame menu contains the 
'Close' menu item. 'Qose' closes the frame to an icon. 

The tool can continue to process while in iconic form. For instance, you can 
compile a program by typing a compiler command in a Command Tool and then 
closing the Command Tool - the compilation continues. 

When the Text Editor is closed, its icon shows the name of the file being edited. 

'Open' toggles to 'Qose'. That is, when the frame is closed, the Frame menu 
you bring up over its icon contains 'Open' instead of 'Close'. 

'Open' opens the frame and places it on the screen in the location it occupied 
when you last closed it. 'Open' does not clear the window. If the tool was inac­
tive while closed, the window looks just the way it did before you closed it. If 
the tool was active, the results of the activity, such as a compilation, are reflected 
in the window. 

Here are the accelerators for 'Open' and 'Close': 

o To open an icon using the mouse, move the pointer over the icon and click 
the LEFT mouse button. 

o To open an icon using a function key, move the pointer over the icon and 
press the~ function key. 

o To close a frame, move the pointer anywhere over the frame (including the 
windows and the frame border) and press ~. (The ~ function key 
toggles to 'Close'. 

The 'Move=>' pull-right menu lets you specify whether the frame moves on one 
axis (constrained) or both (unconstrained). All moving and resizing is done 
using the MIDDLE mouse button. 

When you choose 'Move=>', an alert window displays a message that tells you 
how to move the frame or icon. 

When you move or resize a frame, the bounding box - an outline the size and 
shape of the frame - shows you where the frame will be located. The bounding 
box moves or changes size as you move the pointer while holding down the MID­

DLE mouse button. When you release the mouse button, the frame moves to the 
location of the bounding box. 

When you hold down the MIDDLE mouse button, the pointer shape changes to 
show you the kind of move or resize you've requested-the solid outline 
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The 'Resize=>' ....................... .. 
Menu 

'Resize=> Unconstrained' 

D 

D 

MIDDLE mouse 

renres(!nts the bounding box. The 
,...,,.,.,,,.,...-,,,.. or constrained Of UU.\,,V.l.Jli:>&..l.a.l.1.JlvU.9 

or on 

pointer over 
Continue to hold down 

the mouse button. 

dimensions of a 

'"' ... ,,-t,......,.., "'"'"',,'"""' with instructions 
before you release the 

You can't change the size of an icon. 

, the to a frame freely, changing 
auner1sums at once, grabbing near a comer of the frame. The comer you 
moves, the opposite comer remains example, to make a 

square frame into a pointer diagonally from any comer 
of the frame toward 

for 'Resize=:>Unconstrained' is: 

o Hold 

o While down MIDDLE mouse button, grab the frame border near 
the corner you want to stretch or and move the pointer toward or 
away from the opposite comer. 

o Release the mouse button and the ~~~ key when the bounding 
location is ""L .... :u.•'4'-''-'V• 
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Choose to resize one dimension a frame by grabbing 
near the middle of a side of the frame. The side you 're grabbing moves, while 
the opposite side remains fixed. You can change height or the width 
while holding the other constant. 

accelerator 

o Hold 

0 mouse button 
... v'"'"""'"' .... is satisfactory. 

To resize a Text 

bounding 

o horizontal space het1wef~n 

o Hold down the (Control I key. 

windows is actually part 
u ..... HjLU .. vA changes to a target. 

o Hold down the MIDDLE mouse button while dragging downward until the 
Editor frame looks like 8-2. Then release the (Control) key and 

the mouse button. 
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'Resize=>UnZoom' 

'Resize=>FullScreen' 
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Figure 8-2 

cratch window 

Choose 'Resize=>Zoom' to resize a frame to the full height of the screen. When 
you have zoomed a frame, the menu item toggles to 'UnZoom', which 
remembers the former location of the frame. 'Zoom' and 'UnZoom' are handy 
when you want to list a large directory in a Command Tool, look at it briefly, and 
then restore the Command Tool frame to its former size. 

'UnZoom' also restores a frame that was enlarged by 'Resize=>FullScreen'. 

Here are accelerators for 'Zoom' and 'UnZoom': 

o To zoom a frame, move the pointer over the frame border. The pointer 
shape changes to a target. 

o Hold down the ( Control ) key while clicking the LEFf mouse button. The 
frame zooms to full height. 

o To restore a zoomed frame to its original size and location, follow the same 
procedure: Click with the pointer on the frame border. 

'FullScreen' enlarges a frame so that it occupies the entire screen. To restore the 
frame to its former size, choose 'Resize=>UnZoom' or use the Zoom/UnZoom 
accelerator. 
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Think of the frames on a screen as sheets of paper on a horizontal surface, like a 
desk. Some of the sheets overlap. Now imagine rotating the smface ninety 
degrees so that it's standing up, like a screen. The overlapping sheets or frames 
that were on top are in front; those that were on the bottom are in back. 

'Front' changes the overlap by exposing a frame, bringing it forward, in front of 
other frames. The frame from whose Frame menu you choose 'Front' is the 
frame that is acted upon. 'Front' and 'Back' also work on icons. 

An accelerator equivalent for the 'Front' menu item is: 

o Move the pointer anywhere over the frame you want to bring forward. 

o Press the ( Front J function key. 

'Back' changes the overlap by hiding a frame, sending it in back of other frames. 
The frame from whose Frame menu you choose 'Back' is the frame that is acted 
upon. 

It's possible to have a frame that's in front of one frame and in back of another. 
In Figure 8-3, the Text Editor frame is in front of the Console frame and in back 
of the Command Tool frame. If you choose 'Back' from the Command Tool's 
Frame menu, the Text Editor frame will overlap the Command Tool frame but 
remain in front of the Console frame. If you choose 'Back' from the Text 
Editor's Frame menu, on the other hand, the Text Editor frame will be over­
lapped by both other frames. 
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redraws the and contents. It's needed only the screen 
image seems to have become corrupted. 

screen 

'Quit' sends away the tool that owns the frame. No icon To start the 
tool again, it the SunView menu or name in a shell com-

An want to 
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'Save 

Backup Files 

Remember to Save Frequently 

'Store as New File' 
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You can bring up a Text menu in any text window or command window. Some 
windows have limits on the features you can use, and others have special 
features. For example, you can't use 'Load File' in a scratch window, and you 
get an extra pull-right menu, 'Cmd Modes=>', in a command window. The stan­
dard Text menu pull-right menus are 
and 'Extras=>', plus 'Cmd Modes=>' in command windows. 

The 'File=>' pull-right menu contains commands for saving 
setting the directory, starting a new document, plus some fast 
session. 

retrieving files, 
to end a work 

When you 're ready to save your work, bring up the Text menu choose 
'File=>Save Current File'. This saves the document in the window under the 
filename that appears in the frame header. If the frame header says (NONE), 
there's no current file-type the new filename, select it, and choose 'File=>Store 
as New File' instead. The new filename can be in any window. 

Each time the Text Editor does a save or store, it first copies the old version of 
the file to a file named filename%. The percent sign(%) means this file was 
created as a backup file. The backup file is saved in the current directory. 

The next time you save or store, the Text Editor replaces filename% before it 
saves the new filename. Backups are automatic. You simply continue edit­
ing. 

Backup files don't go away until you delete them. 

When you have been working in the Text Editor for a long time, the internal data 
structures may become fragmented so that you notice a degradation in perfor­
mance. Save the document you 're working on, and performance will return to 
normal. 

Frequent saving is probably a good idea in any case - if the system crashes, the 
edits you made since the last Store or Save will be lost. 

If you'd rather have Sun View do the saving, you can use the Defaults Editor to 
request checkpointing. Change the Checkpoint_£ requency default line in 
the Text category from its default of Oto a positive integer n. This causes a 
checkpoint file to be written every n edits. The name of the checkpoint file is the 
name of the file you're editing with the suffix%% added. See Chapter 10, The 
Defaults Editor, for instructions on how to change a default. 

This menu item lets you create a new file. If the filename you select is the name 
of an existing file, an alert window gives you a warning message. 

To store a document in the window as a new file: 

o Select the filename in any window. You may have to type it, in which case 
the Text Editor's scratch window is a handy place to do that. 
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o Choose 'File=>Store as New File'. The document is stored to the selected 
in 

To load a in the Text 

0 filename in any window. 
ue==>.:::>1et Directory' first or 

not in current directory, 
the full pathname. 

o Choose 'File=>LOad File'. 

The frame header shows the new filename. 

Here's an accelerated way to load a file: 

o Move the pointer into the text window where you want the file loaded. 

o Type the filename by itself on the first line in the text window. 

o Press the~ key. The file is loaded into the text window. 

See 'Set Directory' in this chapter for a way to use 'Load File' to set the direc­
tory. 

'Include File' lets you put a file in a text window at the insertion point. The 
filename in the frame header doesn't change. You can include many files in a 
single document and then save the document as a new file. 

To include a file: 

o Set the insertion point where you want the file to go. 

o Select the filename in any window. 

o Choose 'File=>lnclude File'. The file appears at the insertion point and the 
window scrolls to the end of the inserted file. 

Here's an accelerated way to include a file in the middle of a document: 

o Move the pointer into the text window where you want the file included. 

o Type the filename by itself on the line where you want the file inserted. 

o Press ( Shift-Esc I. 

The file is inserted into the text window, replacing its name. 

The current directory for the Text Editor appears on the right side of the frame 
header. The default is your working directory. 

To change the current directory: 

o In any "'"''rt"'"' select the name of the new rt'""°''"''"'"..,., Type it first if you 
need to. 
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'Finishing Up=>' 
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o Move the pointer into edit window and up Text menu. Make 
sure the pointer is in the edit window, not the scratch window. 

o Choose 

The new directory name appears in the frame header. 

'Set Directory' follows the same rules as the SunOS cd (change directory) com­
mand. For example, if you're in your home directory, 
I cinammon/ nutmeg I sage, and you want to change the directory to 
I cinammon/ nutmeg I sage /parsley, select the word parsley and 
choose 'Set Directory'. You can change back to your home directory by select­
ing . . or - and choosing 'Set Directory' again. 

There are two accelerators for 'File=>Set Directory': [ Esc J and 'File=>Load 
File': 

o To set the directory using the I Esc J key, type the directory name by itself on 
the first line in the window, then press ( Esc I. 

o Select the directory name in any window, then move the pointer into the edit 
window whose directory you want to change and choose 'Load File'. The 
directory is changed and the new directory appears in the frame header. 

To set the directory using 'Load File', you must first change the Defaults 
Editor setting for Text/Load_file_of_directory from Is_error 
to Is_set_directory, then bring up a new Text Editor frame. 

Sometimes you 're editing an existing file and you want to start a brand-new 
document. The way to do that is to save the file you 're working on and then ask 
for an empty document- a text window with no text in it and no filename asso­
ciated with it. 

To empty the text window: 

o Choose 'File=>Empty Document'. The filename is changed to (NONE). 

If you haven't saved your most recent edits in that window, you'll receive an 
alert message asking if you really mean to discard them. 

Getting an empty document is just like bringing up a new Text Editor. You can 
create a new document from scratch. When you save it for the first time, you'll 
have to choose 'Store as New File' because there isn't a current file yet. 

The 'Finishing Up=>' pull-right menu lets you specify a combination of Save or 
Store together with another action. 

The menu items are: 

o 'Close, then Save Current File' 

o 'Save Current File, then Quit' 

o 'Save, then Empty Document' 
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through a document, 
operations 'Again' repeats 

it does so without a mouse 

'Again' with 'Find' is useful when you want to search for special characters like 
Tab and Return that the and Replace frame doesn't handle. 

For example, you can indent a series of lines by searching for the Return charac-
ter in the first replacing it by pressing ( Return ) followed by Cliili], then 

each additional line to be indented. 

When 'Find' doesn't find matching text, the rest of the operations that 'Again' is 
repeating are not executed. 

Here's an example combining (Again l with (Find], keyboard control of the caret, 
and erase accelerators (described in Chapter 9, All About Accelerators). You'll 
be able to adapt the techniques shown here to automate previously tedious 
search-and-replace operations by setting up a model and repeating it almost 
effortlessly with 'Again'. 

The example edits a document on women's suffrage containing the phrases 
many women should vote, some women should vote,and most 
women should vote, changing all of these phrases to all women 
should vote: 

o Select the word women in the first phrase and press ~ to put it on the 
Clipboard. 

. ' . I • . ' ... 
lidarity with Elizabeth Cady Stanton, we declare that many 
should vote. 

urely it is only just that some women should vote. \ 
n fact we believe it is for the good of the nation that most 
omen should vote. 

o Press the (Find) function key to select the next occurrence of women in the 
document. 

! In solidarity with Elizabeth Cady Stanton, we declare that many 
women should vote. 
Surely it is only just that some ~should vote. \ 
In fact we believe it is for the good of the nation that most 

~women should vote. 
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o (Find I 
move 

caret at the 
thew. 

so ( Control-comma I to 

D 

0 

D 

In solidarity with Elizabeth Cady Stanton, we declare that many 
women should vote. 
Surel it is only just that some should vote. \ 
In we believe it is for the f the nation that most 
women should vote. 

~==.:;;......:....:..-<to erase the previous word- some, many, or most. 
is erased 

In solidarity with Elizabeth 
women should vote. 

Stanton, we declare that many 

Surely it is only just that 
In fact we believe it is 

should vote. ~ 
of the nation that most 

women should vote. 

all by a space to 

In solidarity with Elizabeth 
women should vote. 
Surely it is only just that all 
In fact we believe it is for 
women should vote. 

erased. 

we declare that many 

should vote. \ 
of the nation that most 

lilllli.!~m![Q!:-.fQmI!.ill..J to move women in the phrase 
find the same 

In solidarity with Elizabeth we declare that many 
women should vote. 
Surely it is only just that all women 
In fact we believe it is for the 

d vote. ~ 
the nation that most 

women should vote. 
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o Now press the ( Again I function key to repeat the entire series of operations. 
Keep pressing ( Agam ) until no more women can be found to enfranchise. 

In solidarity with Elizabeth Cady Stanton, we declare that all 
women should vote. 
Surely it "'is only just that al 1 women should vote. \ 
In fact we believe it is for the good of the nation that all 
women should vote. 

The 'Undo:=;>' pull-right menu lets you undo the last edit you made, or all edits 
since the last 'Save' or 'Store as New File'. 

'Undo Last Edit', the default, undoes the effect of the most recent editing opera­
tion: 'Cut', 'Paste', or typing. 

The accelerators for 'Undo Last Edit' are the (Undo) function key and I •-U I. 

The range of 'Undo Last Edit' goes back to the last time you clicked LEFT to 
change the insertion point. If the most recent edit was the only one since the last 
'Save' or 'Store as New File', the (edited) signal is removed from the frame 
header. 

You can choose 'Undo Last Edit' repeatedly to undo a series of edits. 

The range of 'Undo All Edits' goes back to the last time you saved or stored the 
document. You can think of 'Undo All Edits' as the equivalent of 'Empty Docu­
ment' plus 'Load File' to reload the last saved version. 

'Undo All Edits' can rescue you, for example, when you push the Replace AH 
button in the Find and Replace frame, then change your mind. Hint: You need 
to have chosen 'Save' or 'Store as New File' just before the replacement, which 
is always a good idea. 

'Copy', 'Paste', and 'Cut' all work with the Clipboard, a buffer shared by all 
frames. 

o 'Copy' places the selection on the Clipboard. Its accelerators are the~ 
function key and ~. 

o 'Paste' places the contents of the Clipboard at the insertion point. Its 
accelerators are the I Paste ) function key and ( • -V J. 

o 'Cut' deletes the selection and places it on the Clipboard. Its accelerators 
are the CTdil) function key and ~. 'Paste' undoes 'Cut' as long as you 
don't move the caret. 
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'Copy then Paste' 

8.8. The 'Display=>' Pull­
Right Menu 

'Select Line at Number' 

'What Line Number?' 

For contvernertce. 'Show CllDIX>arc1=> 
menu. 

menu current 

the first several characters are 

pull-right 

'Copy then Paste' gives you two operations for the price of one menu item. 
When the active caret is not with the selection - for example, when you make a 
selection and then move keyboard to another window- 'Copy then 
Paste' copies the selection to the caret. 

In a command window, you can also use handy combination to copy a previ-
ous command to the command line in order to edit it or execute it again. That's 
because the caret stays on the command line when you select text in the tran­
script (unless you've selected 'Enable Editing'). 

An aceelerator for 'Copy then Paste' is [ + -P ). It works like 'Stuff' in the Tty 
menu. Some people think ( +-P I is the most useful accelerator there is. 

The 'Display=>' pull-right menu provides commands for changing the text 
display. You can scroll to the text that contains the caret; move the caret to the 
top or bottom of the document and scroll there; split the window into scrollable 
sections; and change the way text wraps at the right window edge. 

'Select Line at Number', the default, scrolls the document so that the line whose 
number you specify shows in the window. This menu item requires a selection 
containing the line number you want. 

A quick way to correct errors in a compilation is to use two windows. One con­
tains the source program, the other contains the error listing. Starting from the 
last error shown, so that you won't change earlier line numbers when you make 
corrections: 

o In the error-listing window, select the number of a line containing an error. 

o In the source-program window, choose 'Select Line at Number'. The line 
scrolls into view. 

o Correct the error in the source listing. 

o In the error-listing window, select the next number, and so on. 

'What Line Number?' is a request for the line number of the line that contains 
the selection or the beginning of a multi-line selection. An alert window appears, 
telling you the line number. Push the Continue button after you've read the alert 
message. 

'Select Line at Number' and 'What 
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'Split View' 

Many views, one caret. 

Why Split a View? 

Figure 8-4 
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characters. Therefore the line number changes only if you add or delete a Line 
Feed or Return, not jf,you merely change the line wrap or the window width. 

You can split a text window or command window into an (almost) infinite 
number of sections and scroll each one independently. Each section is known as 
a view. Before you split it, the view consists of the entire window. 

A window contains only one caret, representing the insertion point, no matter 
how many views you have. 

To split a view: 

o Move the pointer into the view. 

o Bring up the Text menu and choose 'Display=>Split View'. An alert win­
dow appears: 

Split View Alert Window 

Move pointer to where new view should 
begin, then click the left mouse button. 

Otherwise, push "Cancel Split View". 

(cancel Split View) 
I'\; 

o Click LEFT anywhere in the view. A horizontal line appears, splitting the 
view at the point where you clicked. 

Split views come in really handy. Here are examples from two different tools. 
As you work with text windows, you '11 probably find additional uses. 
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Figure 8-6 

'Destroy View' 
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o In an edit window in the Text Editor, you can load an outline of a document, 
duplicate it in the window, then split the view so you can continue to see the 
outline in the top view while writing the sections in the bottom view. 

Split View in Text Editor 

~ cratch window 
HOW TO RETIRE IN FIVE YEARS 

A. Join a Silicon Valley startup. 
B. Work 90 hours a week. 
C. Eat at Macdonald's. \i D. Save money in my mattress. 

·· E Exercise stock options when company 

I:~ :~YR::::E~::~::::rv::::lles. 
~ B. Work 90 hours a week: 

1. Take lots of vitamins. 
2. Get a massage every week. 
3. Get up early and jog or swim. 
4. Turn off my telephone and tell 

my friends I've left town. 
5. Find a comfortable chair for my office. 
6. Chant affirmations for success . • 

To unsplit a view: 

o Move the pointer into either half of the split view. 

o Bring up the Text menu and choose 'Display=> Destroy View'. 

'Show Caret at Top' 'Show Caret at Top' moves the line containing the insertion point to the top of 
the window. This is a good way to retrieve a "lost caret" when you've been 
scrolling through history in a Command Tool. 

'Move Caret to Start' 'Move Caret to Start' moves the caret in front of the first character in the docu­
ment and displays it at the top of the window. Sometimes it's helpful to do this 
before beginning a find and replace operation. 

NOTE 'Move Caret to Start' and 'Move Caret to End' do not affect the current selec­
tion, even though it may no longer be visible in the window. You can inadver­
tently delete or change a pending-delete selection by assuming that you' re work­
ing at the caret. 
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'Move Caret to End' 

'Change Line Wrap=>' 

'Wrap at Character' 

'Wrap at Word' 

'Clip Lines' 

8.9. 'Find=>' 
Right Menu 

The Find and Replace Frame 

Accelerators for 'Move Caret to Start' are [ Home I (R 7) and 
( Shift-Control-Return). 

'Move Caret to End' moves the caret to the end of the last line in the document 
and displays it at the bottom of the window. This is a good way to get to the end 
of a text window when you want to type or include more text. 

Accelerators for 'Move Caret to End' are (]fil[) (R13) and I Control-Return l. 

The 'Change Line Wrap' pull-right menu lets you change the way physical lines 
are displayed in a window. 

Wrapping means that the portion of a line that extends past the right edge of the 
window flows to the next line in the window, starting at the left. 

'Wrap at Character', the default, causes characters that do not fit on a line in the 
window to wrap around to the following window line. A single physical line 
may be wrapped onto several window lines, depending on the width of the win­
dow. 

'Wrap at Word' operates like 'Wrap at Character' with words ratherthan charac­
ters as the basic unit. In most text windows, 'Wrap at Word' is a lot easier on the 
eyes - but remember that the actual length of physical lines may be obscured, 
so you may get strange results when you print the text. In Command Tool, you 
may prefer 'Wrap at Character' when reading long command lines. 

When you don't want wrapping of long lines, choose 'Change Line Wrap=>Clip 
Lines'. This menu item causes characters that do not fit on the line to "disap-
pear" on the right side of the window - still there, but you can't see 
them. 

wrap the lines in the document again, choose 'Wrap at Character' or 'Wrap at 
Word'. 

You can permanently divide long lines into shorter ones by piping the text 
through the frnt command. To do this, text to be formatted, make it 
pending-delete, and choose 'Format' pull-right menu. 

The 'Find=>' pull-right menu offers many ways to find and replace text. This 
menu includes two menu items that bring frames for specialized Find 
operations. 

Choose 'Find and Replace', the default, to bring up the Find and Replace pop­
up frame, shown in Figure 8-7. An accelerator to bring up the frame is 
I Control-Find ). In the and panel text items, type or paste the text 
you want to find then push panel buttons to do the 
work. 
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The AH Text cycle item. 
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The Find and Replace Frame 

When searched-for text is found, the text is selected and the window is scrolled 
to display it. 

o text 
panel text 

end 

the next 

If there's no match, the owner frame 

o want to use as a 
A"-'i::IU'l«ll'-1!:: button to replace the selection. 

o Push button to find and immediately replace the next 
occurrence. If you goofed, you can choose 'Edit:=> Undo' to correct the mis­
take. 

o Push the Replace then Find button to replace the found selection and 
immediately find the next occurrence. 

o Push the Replace AH button to change every occurrence in the document. 
It's a good idea to save or store just before you do this, in case the results are 
different from what you expected. 

The cycle item is set to All Text. This means that no matter where the caret is 
when you begin searching, the search doesn't stop at the end of the document but 
wraps around to the top and continues back to the caret. If you want the search to 
stop at the end of the document, click LEFT on the cycle item to set it to To End. 

Pushing the Blink Owner button blinks the owner's frame to show you where it 
is, in case you have more than one open text window or command window. 

The Done button closes the Find and Replace frame. 
though, and use it to search for different text. When 

frame closes too. 
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'Find Selection=>' 

'Find Clipboard=>' 

Accelerator for 'Find=>'. 

'Show Clipboard=>' 

The Find Marked 

Guide REFERENCE 

Frame 

Figure 8-8 

Choose 'Find Selection=>' to search from the caret and select the next occurrence 
of the current selection. The default direction is forward, but you can choose 
'Find Selection=> Backward'. 

Choose 'Find Oipboard=>' to search from the caret and select the next 
occurrence of the Clipboard contents. The default direction is forward, but you 
can choose 'Find Clipboard=> Backward'. 

I Find I function acts as an accelerator. Here's how it works. 

o If there's a selection, CEilliI) is the equivalent of 'Find Selection=:>Forward' 
and (Shift-Find I is the equivalent of 'Find Selection=:> Backward'. 

o If there's no selection, (Find) is the equivalent of 'Find 
Clipboard=>Forward' and ( Sfoft-Fmd I is the equivalent of 'Find 
Clipboard=> Backward'. 

o If you make a secondary selection by holding down the ( Find I key while 
selecting text, the secondary selection is searched for when you release the 
function key. The search is in a forward direction, but you can reverse it by 
holding down I Shift-Find) while making the secondary selection. This is a 
handy way to search without changing the Clipboard or the current primary 
selection. 

Highlight 'Show Oipboard=>' and pull right to see the current contents of the 
Clipboard. 

For convenience, this menu item appears in both the 'File=>' and 'Edit=>' pull­
right menus. A more complete description is found under Section 8.7, The 
'Edit=>' Pull-Right Menu. 

Choose 'Find Marked to search for text bounded by certain delimiters. 
'Find Marked Text' brings up the Find Marked pop-up frame, shown in 
Figure 8-8. 

The Find Marked Text Frame 

(lJ{} UJ[] 

There's a choice button to the left of each delimiter pair in the Find Marked 
Text frame. The pairs are ( ) , " " , , , , ' ' , { } , [ ] , 
I > < I , and I * *I. Click LEFT on the choice button to indicate which pair to 
search for. The choice button highlights. Then push Forward or Backward to 
search in the requested direction. The next occurrence of text within the 

is highlighted. 
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'Match Delimiter' 

'Replace l>field<I=>' 

8.10. The 'Extras=>' Pull­
Right Menu 

'Format' 
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The Expand button finds the next outer pair of the specified delimiters, searching 
in both directions from the caret. 

The Blink Owner and Done buttons work just as they do in the Find and 
Replace frame. 

Select a delimiter, then choose 'Match Delimiter' to find the matching end of the 
delimiter pair. The delimiters and the text between them are selected. The del­
imiters recognized by 'Match Delimiter' are the same as those displayed in the 
Find Marked Text frame. 

If the beginning and ending delimiters differ, like open bracket and close bracket 
([ and ]), 'Match Delimiter' searches forward if the selection is a beginning del­
imiter and backward if the selection is an ending delimiter. If there's no differ­
ence, 'Match Delimiter' searches forward. 

Choose 'Replace l>field<I=>' to find a field and select it as pending-delete. The 
search begins at the caret. Afield is any text between I> and <I delimiters. 

'Expand', the default, searches in both directions, expecting the caret to be 
within, a delimiter pair. 

'Next' searches forward from the caret. An accelerator for 'Replace 
l>field<l::::>Next' is (Control-Tab I. 

'Previous' searches backward from the caret. An accelerator for 'Replace 
l>field<l=>Previous' is I Shift-Control-Tab l. 

The 'Extras=>' pull-right menu contains some useful formatting commands. The 
menu gives you a way to use text filters without having to map them to keys. 

When you make a selection and choose an 'Extras=>' menu item, the selection 
becomes the standard input (stdin), and the resulting standard output 
(stdout) is inserted at the caret. If the selection was pending-delete, the stan­
dard output replaces the selection. For more information on the standard input 
and the standard output, see Doing More with SunOS: Beginner's Guide. 

'Fonnat' uses the fmt command to refonnat long lines of text. 

Make a pending-delete selection, then choose 'Fonnat' to format the lines in the 
selection with a line length that can be printed and viewed more easily. 

NOTE To make a selection pending-delete, hold down the I Control) key while making 
the selection. 

The f mt command divides text into physical lines of not more than 72 charac­
ters; it does not split words between lines. See the fmt command in the SunOS 
Reference Manual for more information. 
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rnicrosystems 

Revision A of 9 May 1988 



154 

'Pretty-print 

'ABCD->abcd' 

Guide REFERENCE 

...,.,.,,.TT'<l'_ru-.ru C' uses the indent command to ,._.,. ... ,u ....... C program listings. It for-
"'·""-'"""",lVA.1. according to standard you have a 
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delete selject:Lon 

'Shift Lm1es==> KJ.gm 

line. 

JLVA.U.U.•O.O. ... •U '-'''-''-'"-'-1.'Y<JUA .... to specifications in 
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extras. Once you've created a custom file and told the Defaults Editor about it, 
you can make changes to the file and see them immediately implemented in the 
'Extras~· pull-right menu. 

'Extras~' Menu File in /usr/lib/. text_extras menu 

ratch window 
@(#)text_extras_menu 1.5 87/11/24 SMI 

Copyright (c) 1987 by Sun Microsystems, Inc. 

Text "Extras" menu 

"Format" f mt 

"Capitalize" MENU 
capitalize -u 
capitalize -1 
capitalize -c 
END 

"abed -> ABCD" 
"ABCD -> abed" 
11 abcd -) Abcd 11 

"Capitalize" 

"Shift Lines" MENU 
"Right" shift_ lines -t 1 
"Left" shift_lines -t -1 

"Shift Li nes 11 END 

"Pretty-print C11 indent -st 

"Insert Brackets" MENU 
11 

( )
11 insert_brackets ( ) 

11 
[ ] 

11 
; nsert_brackets \ [ \] 

11 
{ } 

11 i nsert_brackets { } 
11

' " ' 
/ 11 i nsert_brackets \ 11 

\ 
11 

"Insert Brackets" END 

"Remove Brackets" MENU 
11 

( )
11 remove_brackets ( ) 

11 
[ ]" remove_brackets \[ \] 

11 
{ }

11 remove_brackets { } 
"' " ' 

/ 11 remove_brackets \ 11 
\ 

11 

"Remove Brackets" END 

The name of each 'Extras~' menu item is surrounded by double quotation 
marks ("). Each pull-right menu begins with a MENU statement and ends with an 
END statement. 

To include a backslash (\) character in the . text_ extras_ menu file - as in 
the troff inline font specifications \fB and \fP -you must usefour 
backslash characters; for example: 

insert brackets \\\\fB \\\\fP 
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'Enable Editing' 

'Disable Scrolling' 

Guide REFERENCE 

The Text menu in windows .... v ... , .... u..i. .... ., a special pull-right menu, 'Cmd 
Modes~', in addition to those described 

The text in a command window is usually read-only except for the command 
line. To allow all text in a command window to be edited, choose 'Enable Edit-

When you enable editing, you can use the command window as a scratch pad and 
cross off items you 're done with by deleting them. For instance, use the f gr ep 
command to find and display all occurrences of a certain text string in a set of 
files. Then delete each display line in the command window as you update the 
files in a Text Editor window. 

The menu item toggles to 'Disable Editing' (the normal condition in a command 
window). 

Scrolling is the default in a command window. Most tools that need to disable 
scrolling, such as do it themselves and restore scrolling automatically when 
they're done. Therefore you normally will never need to disable scrolling. 

However, if you have software that requires you to disable scrolling and you 
want to run it in a command window, choose 'Disable Scrolling' before you type 
the command that starts the software. If you disable scrolling by choosing this 
menu item, you must reenable it the same way. 

'Disable Scrolling' toggles to 'Enable Scrolling', so you can reset the scrolling 
facility when you're done. 

You may decide instead to run non-scrolling software in a tty window instead of 
a command window - for instance, in Shell Tool rather than Command Tool. 
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'Stuff' 

'Enable Page Mode' 

'Copy then Paste' 
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windows such as Shell Tool have their own menu, the Tty menu. Its menu 
items are 'Stuff', 'Enable Page Mode', and 'Copy then Paste'. 

When you disable scrolling in a command window, you get a Tty menu instead 
of a Text menu. The command window's Tty menu is just like the one in a tty 
window except that it has an additional menu item, 'Enable Scrolling', to take 
the window back to nonnal command window operations. 

'Stuff is provided for compatibility with previous releases. Instead use 'Copy 
then Paste' or its accelerator ( • -P l to insert the selection at the block cursor. Or 
use secondary Paste, a quick-editing technique described in Chapter 6, All About 
Selections. 

'Enable Page Mode' shows you only a page (windowful) of text at a time, like 
the more command. 

When you choose 'Enable Page Mode', the pointer changes to a stop sign when 
the window fills up. Instead of continuing to flow the lines through the window, 
the display stops so that you can look at it as long as you like. 

'Enable Page Mode' toggles to 'Disable Page Mode', so you can switch back and 
forth at your convenience. 

When you've finished looking at the current page (or windowful), press any key 
to see the next page. In addition, 'Enable Page Mode' toggles to 'Continue' 
whenever there's more infonnation to be displayed. You can choose 'Continue' 
from the menu to display the next page of information. 

'Copy then Paste' inserts the selection at the block cursor. It works just like the 
menu item of the same name in the Text menu's 'Edit=>' pull-right menu. 
You'll find a description of 'Edit=>Copy then Paste' in Section 8.7. 
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9.1. Function Key 
Accelerators 

All About Accelerators 

This chapter describes: 

o Function key accelerators - menu actions you perform by pressing a func­
tion key on the left side of the keyboard. 

o Mouse button accelerators - Frame menu actions you perform by clicking 
or holding down a mouse button. 

o Keyboard accelerators - keyboard combinations you press to erase text, 
move the caret, and perform Text menu actions without using the mouse. 

o Alert button accelerators - ways to push the button in an alert window 
from the keyboard, without using the mouse. 

Accelerators are alternative ways of doing things in Sun View. Their name stems 
from the fact that they're often easier and faster. For example, 

o Pressing the CQlliiQJ function key 

is the accelerator equivalent of 

o Bringing up the Text menu. 

o Pulling right on the 'Edit=>' menu. 

o Pulling right on the 'Undo=>' menu. 

o Highlighting 'Undo Last Edit' and releasing the mouse button. 

See the 'Again' menu item in Section 8.7 for an example of how to repeat a com­
plex series of actions using function key accelerators, erase accelerators, and 
caret accelerators. 

The function key accelerators, which are described in detail in Chapter 2 in the 
Lessons section, let you perform menu operations very quickly just by pressing a 
function key. The menu operations themselves are described in Chapter 8, All 
About Menus. 

Function keys aren't the only way to perform menu operations in Sun View. See 
Table 9-5, Menu Accelerators, for additional possibilities. 
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Table 

from 'Front' to 'Back'. 

an accelerator. For exam­
function key from 'Forward' 

( Front ) function 

toggles many other accelerators as well. For instance, 
"'-="" .......... -=--_,,......,,,,....... reverses the direction of the caret action 

to 

Function Accelerators 

Menu Action 

D 

0 if 

D to the back. It 

D 

but in 
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Table 9-2 
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o (+-Fl and ( Shift-+-F ), shown in Table 9-5, Menu Accelerators, are keyboard 
accelerators that operate just like the function key accelerators [ Find J and 
( Shift-Fmd I. 

o ( Control-Find ) brings up the Find and Replace frame. 

Mouse button accelerators let you perfonn Frame menu actions using the mouse. 
These accelerators are described in Table 9-2. 

Mouse Button Accelerators 

Frame Menu Equivalent 
Open aframe: 
Move aframe unconstrained: 

Move aframe constrained: 

Move an icon (always unconstrained): 

Resize a frame unconstrained: 

Resize a frame constrained: 

Zoom a frame to full height: 

U nZoom a zoomed frame: 

Bring frame to front: 

sun 
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Mouse Action 
Point to the icon and click LEFT. 
Point to a side of the frame 
border near the comer, hold 
down MIDDLE and drag the 
frame, release when the bound­
ing box is the desired size. 
Point to a side of the frame 
border near the middle, hold 
down MIDDLE and drag the 
frame, release at the desired 
position. 
Point anywhere in the icon, 
hold down MIDDLE and drag the 
icon to the new location. 
Point to a side of the frame 
border near the comer, hold 
down I Control )-MIDDLE and 
resize the frame, release at the 
desired position. 
Point to a side of the frame 
border near the middle, press 
( Control )-MIDDLE and resize the 
frame, release at the desired 
position. 
Click l,....,C"""o_n_tr_o.,....,,1 )-LEFT on the 

frame border. 
Click ( Control )-LEFT on the 
frame border a frame that has 
been zoomed. 
Click LEFT on the frame border. 
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Meta 
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Table 9-3 

There are 
type from 
action 

o Erase actions remove text 

D actions 

0 actions. 

A command 
commands is to 

Meta 

Erase Accelerators 

Erase Action 

accelerators let 

over text to reposition caret. 

nr>
1

·
1
""''" or commands, that 
you'll find the following 

caret. 

all menu items have accelera-

The best way to see 

9 

,,.,...,, ...... ,n,.,1"·•,..,.,,... with one or more 

...,_,.., .......... ~.IA.""· ~' an accelerator 
typing the letter C. 

text is erased 

I Delete I 
(Shift-Delete) 
( Control-W l 

is not 

9 On some Sun keyboards, the Meta keys are labeled Left and Right. 
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Table 9-4 Caret Accelerators 

Caret Action Keyboard Equivalent 

Go_Char_Backward CRilD (left arrow) 
( Control-B J 

I Shift-Control-FI 
Go_Char_Forward CR1I) (right arrow) 

(Control-FI 
( Shift-Control-B) 

Go_ Word_Backward I Control-comma ) (,) 
I Sh1ft-Control-slaSh) (/) 
( Shift-Control-period J (.) 

Go_ Word_End ( Control-period) (.) 
Go_ Word_Forward I Control-slash ) (/) 

(Shift-Control-comma)(,) 

Go_Line_Backward I Control-A J 

( Sh1ft-Control-E) 
Go_Line_End I Control-E I 

(Shift-Control-A I 
Go_Line_Forward CRID 

I Control-semicolon ) (;) 
Go_Column_Backward ( R8) (up arrow) 

I Control-P) 
(Shift-Control-NI 

Go_ Column_Forward ffiI!) (down arrow) 
I Control-N ) 

I Shift-Control-P) 
Go_Document_Start I R7 I ( I Home 1 ) 

(Shift-Control-Return) 
Go_Document_End (]JJ] ( CElliD ) 

( ~Qntrol-Remm l 

NOTE Caret actions do not affect the selection if there is one. 

The indented caret action commands use the Cfiliill) key as a toggle. For exam­
ple, (Shift-Control-FI (Go_Char_Backward) reverses the action of ( Control-F J 

(Go_Char_Forward). By using the (Shift) key, you can reduce the number of 
commands you need to remember. 

The following caret commands are described relative to the current position of 
the caret. If the caret is in the middle of a word, it moves to the beginning or end 
of that word. 

o Go_ Word_Backward moves the caret to the left until it's at the beginning of 
a word. 

o Go_ Word_End moves the caret to the right until it's at the end of a word. 

o Go_ Word_Forward moves the caret to the right until it's at the beginning of 
a word. 
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0 

down. 

D 

The Home 

Arrow The actions: 

10 emacs is an editor that can be used in tty and command windows. 

caret is 
next line 

to 
to End'. 

names are 

For 
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Table 9-5 contains menu accelerators for the Text menu. Additional menu 
accelerators for the Text and Frame menus are shown in Table 9 .1, Function Key 

Menu Action 

'File:::::::>Store as New File' 
... _._..., __ .LJ•uuu File' 

'File:::::::> Include File' 

'File:::::::>Set Directory' 
'File:::::::> Empty Document' 
'Edit:::::::> Again' 
'Edit:::::::> Undo' 
'Edit:::::::>Copy' 

'Edit:::::::> Copy then Paste' 
'Display:::::::>Move Caret to Start' 

'Display:::::::>Move Caret to End' 

o is an accelerator for File' 
on the first line in 

Keyboard Equivalent 

menu with 

name of a the line will automatically and 
contents of the file. If the is the name a direc-

rh r.Pf't.nru will be changed and the new name will in 

o is an accelerator for 'Include 
the line in the document where you want 

on the same line.) Then 
automatically and vj..IA.U'-'\.'U 

u.iv;u ... 1..UAV by itself on 
inserted. (The caret must 

The filename will selected 
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D and apply to 

D 

Accelerators 

Table Other Keyboard Accelerators 

9.8. SunOS 3.x Keyboard 
Accelerators 

Table 9-7 

o The CID key works like a function It operates on the text you type. 
Normal typing produces capital only when you press the Cfiliiff) key. 
The key lets you produce all capital letters or toggle back to normal 
typing, as the (Caps Lock I key does. However, CID is a Sun View software 
feature that operates on one window at a time, while I Caps Lock J is a key-
board hardware feature that affects windows. Press the CID key with the 
keyboard focus in the window whose you want to affect. When the 
window toggles to all capital letters, the word [ CAP s ] appears in the frame 
header. Pressing again toggles the window back to normal typing. 

o (Quote) lets you "quote" a keyboard accelerator in text instead of exe-
cuting (The character that represents the keyboard accelerator may not 
be a printable character.) For example, type ~ ~ to enter the char­
acter string that represents ~ (Meta-S) as text. 

For reference, Table 9-7 shows the keyboard commands available for Sun View 
in SunOS 3.0, 3.2, and 3.4: 

SunOS 3 ..x Keyboard Accelerators 

Erase Action 
Erase_Char_Backward 
Erase_ Char_Forward 
Erase_ Word_Backward 
Erase_ Word_Forward 

3.x Keyboard Equivalent 
(Delete I 
[Shift-Delete) 
(Control-WI 
( Shift-Control-W) 
( Control-U) 
( Shift-Control-U ) 
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Caret Action 3.x Keyboard Equivalent 
Go Document End I (Control-Return ) 

Menu Action 3.x Keyboard Equivalent 
Get_Filename_and_Load (Esc) 

Find_B ackward ( Shift-Control-F J 

Find_Forward ( Control-F J 

'Paste' [ Control-G ) 
'Cut' [Control-DI 
'Copy then Paste' [ Control-P I 
Caps_Lock WJ 

Additional 3.x accelerators are listed in Table 9-1. 

You can respond to alert buttons from the keyboard. 

Alert Buttons 

The text has been edited. 
Empty Document will discard these edits. Please confirm. 

Cancel 

o To reply to the alert message by responding Confirm or another obvious 
yes, press the I Return I key. The button that responds to I Return )-the yes 
choice - has a double outline, as shown in Figure 9-1. 

o To reply to the alert message by responding Cancel or another obvious no, 
press the CfilQiD function key. 
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10.1. Starting the Defaults 
Editor 

Figure 10-1 

Editor 

The Defaults Editor is the key to using Sun View comfortably and efficiently. A 
default is a standard way of doing something. For example, pull-right menus are 
the standard in Sun View. The Defaults Editor lets you change the Sun View 
defaults to suit your preferences. 

It's a good idea to experiment with the default settings and find out which ones 
you like best. Later in this chapter you'll find a list of defaults that are likely to 
be interest to you. 

The preferred way to start the Defaults Editor is to bring up the Sun View menu 
and choose 'Defaults Editor' from the 'Editors=>' pull-right menu. 

You can also start the Defaults Editor in the background from a Command Tool 
or Shell Tool by typing: 

When you're done changing defaults, choose 'Quit' or 'Oose' from the Defaults 
Editor's Frame menu. If you choose 'Close', you'll see an icon that looks like 
this: 

The Defaults Editor I con 
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frame contains panels and a scratch window, as shown 

Figure 10-2 The Defaults Editor Frame 

C SunView (Edit item) 

t tElP by clicking the left buttoo on the appropriate label or string 

Item 

Click_ to_ Type (Disabled): 
foot (): 

Walking_Menus (Enabled): 
Rootllllenu_filenaae (): 

Icon_gravity (North): 
Icon_close_level (Ahead_of_all): 
Julllp_cursor_on_resize (Disabled): 
Alert Bell (1): 

Audible_Bell (Enabled): 
Visible_Bell (Enabled): 
Emholden_labels (Disabled): 
Ttysuh.!irldow/Retained 
Root_Pattern (on): 

Confim11_Property_Changes (Disabled): 

The 

a . defaults 
button in the Default 
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C Di sabled 

Enabled 
/usr/view/1.75/usr/lib/rootmenu 
C North 
C Ahead_of_all 
C Disabled 

C Enabled 
C Enabled 
C Enabled 

C Di sabled 
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If you want to return to all the standard Sun View defaults, just rename or delete 
the - I. defaults file. 

You can make as many changes to a category as you like, and then change your 
mind. Changes don't become permanent until you push the Save button. 

Pushing the Quit button is the equivalent of choosing 'Quit' from the Defaults 
Editor's Frame menu. 

If you've made changes to a category and you want the defaults to return to the 
way they were the last time you pushed the Save button, push the Reset button. 

The Edit Item button is for experts who need to modify default lines in the 
Defaults panel. That's probably all you need to know about it. If you're one of 
the rare few, you'll find a description in Section 10.7, Editing Default Lines. 

The Message panel is where the Defaults Editor displays text such as the help 
messages that tell you how a particular default works. 

The main element in the Defaults panel is the default line. From left to right, the 
default line contains the default name, the standard Sun View setting (in 
parentheses), and a default value- a text item or cycle item where you specify 
the changed default. 

When you click LEFT on the default name or the default value, a help message 
appears in the Message panel. The help message for the default name explains 
the purpose of the default. For cycle items, the help message for default 
value explains the effect of a particular setting. 

from to category. For instance, in the Com-
oat:ibiilitv category it also contains explanatory text, and in the 
category it also contains a panel button. 

",.. .. ,.,,.,.. .... window in is to 
frame. a text window used temporary editing. 

one in Text 

The scratch window is provided so that you can easily long text items that 
are not fully visible in the Just copy the text into the scratch 

edit it there, and paste it back where it came from. 

The defaults that the Editor works with are divided into categories -
related defaults are grouped together. 

It's a good idea to familiarize yourself with the various categories by going down 
the list of default names in each category and viewing the help messages associ­
ated with them. 

sun 
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To cycle to a category, click the LEFT mouse button on the cycle symbol until the 
category you want is displayed. Dick or hold down Cfilll[)-LEFT to cycle back­
ward. 

You can also cycle directly by holding down the RIGHT mouse button on the 
cycle symbol to open the Category menu, then choosing the ~ategory you want 
displayed. 

The categories are described below in alphabetical order: 

The Compatibility category lets you change Sun View defaults to correspond to 
previous releases of Sun View. For example, you can request the Sun View 3.0 
Text menu instead of the Text menu described in this manual. 

The Defaults category contains defaults that affect the use of the Defaults Editor 
itself. It's used mainly by software developers. 

The Indent category sets defaults for the indent command, described in the 
SunOS Reference Manual. This category affects the action of the 'Pretty-print C' 
menu item in the 'Extras=>' pull-right menu. 

The Input category is concerned with defaults for the mouse and the keyboard. 

The normal way to change input defaults is through the Defaults Editor. How­
ever, if you have changed input defaults in the SunOS operating system by using 
the stty command, you can tell the Defaults Editor to read in those changes by 
pushing the panel button, Click to start setup program: defaults_ from _input. 

The Mail category sets defaults for Mail and Mail Tool. The defaults are 
described in the Mail and Messages: Beginner's Guide manual. 

The Menu category lets you change the appearance of menus, determine how 
menu defaults are set, and specify what happens to the pointer after you choose 
from a menu. 

The Scrollbar category lets you change the appearance of the scrollbar. For 
example, the default is to display the scrollbar all the time, but you can have the 
scrollbar displayed only when you're scrolling. 

The scrolldefaul ts program demonstrates the effect of the defaults in this 
category. To start the program, push its button in the Defaults panel. 

SU 
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The category lets you change defaults that are universal throughout 
Sun View such as font that is used in frame headers and elsewhere. For exam-
ple, this is where you change the defaults for icon gravity and keyboard focus. 

The category lets you change characteristics of text windows and command 
windows. 

The Tty category lets you change certain characteristics of tty windows and com­
mand windows. 

You can change defaults one category or several categories. 

Default values are set either by text items or cycle items. 

o To change a default value that's a text item, type or edit as you would any 
panel text item. If the text is too long to be edited in the Defaults panel, 
copy it into the scratch window, edit it there, and then paste it back into the 
text item. This technique may be required for long pathnames. 

o To change a default value that's a cycle item, click LEFf on the cycle item or 
choose from its menu. Each new setting causes a new help message to 
appear in the Message window. 

To save the current category, push the Save button. You should save the changes 
before cycling to the next category you want to change. If you forget, an alert 
message will remind you. 

If you don't want to save changes - if you've changed your mind or made an 
error - push the Reset button. 

Changes to defaults take effect at different times, depending on the category, 
you 're changing. Table 10-1 shows when changes take effect for all the 
categories. 
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When a tool is started. 
Next time is 
Next time you run indent. 
Immediately. 
When you start Mail Tool or choose 'Source .mailrc'. 
Sun View menu: Next time Sun View is started. 
Other menus: When a tool is started. 

Scrollbar 
Sun View 
Text 

When a tool is 
Next time SunView is started. 
When a tool is started. 

Tty When a tool is started. 

Here are some defaults you should consider including in your experiments with 
the Defaults Editor. They're popular with many Sun View users. The name of 
the category precedes the default name in the following list: 

Input/Left_Handed 
If you've decided to put your function keys on the right side of the 
keyboard and use your mouse on the left side, you need to tell Sun-
View by setting Input/ Handed to Yes. The default is 
No. 

Menu/Center items 
default, names of menu items are left-justified. Some users find 

that centered menu items are easier to read. To center menu item 
names, set Center_string_items to True. 

Menu/Default Selectionand Initial Selection 
- -

The default setting for these menu items is Default. Change the 
setting to Last_ Se 1 e ct ion if you want the default for pull-right 
menus to be the menu item you chose last time you brought up the 
menu. Each pull-right menu has a separate default it "remembers." 
Caution: You have to remember too, because blind choices can get 
you into trouble. For instance, your last choice in the 'Edit=>' pull­
right menu may have been 'Undo All Edits'. 

Menu/Font, Text/Font,and SunView/Font 

sun 
microsystems 

you don't like the fonts you see on the screen, you can change 
them by specifying any of the fonts in the 
/usr I fonts/fixedwidthfonts directory, or by design­

your own fonts with the Font Editor. 
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Menu/Stay_up 
If you'd rather not keep holding down the mouse button while you 
decide on a menu item, you'll like stay-up menus. When you click 
RIGHT, the stay-up menu appears, and it stays there until you click 
RIGHT again. You can preview it at your leisure. To change to 
stay-up menus, set Stay_ up to True. 

Scrollbar/Vertical_bar_placement 
By default, the scrollbar is on the left side of the window. If you 
notice that the pointer often strays into the scrollbar when you're try­
ing to select the beginning of a line, see if setting 
Vertical_ bar _placement to East works better for you. 
That puts the scrollbar on the right side of the window. Another 
solution is to increase the width of the left margin - the space 
between the frame border and the leftmost text in the window - by 
changing the value of Text/Left_ margin from the default 
width of four pixels. 

SunView/Click_to_Type 
The default keyboard focus is Pointer-in-Window. To change to 
Click-to-Type, described in Chapter4, set Click_to_Type to 
Enabled. 

SunView/Embolden_Labels 
You can make the text in frame headers stand out more by changing 
SunView/Embolden_Labels to Enabled. The default is 
Disabled. 

SunView/Icon_gravity 
The default icon gravity, North, puts icons at the top of the screen 
when frames are closed. To keep icons on the left side of the, screen, 
cycle Icon_gravity to West, and so on. 

Text/Adjust_is_pending_delete 
If you want the primary selection to become pending-delete when­
ever you adjust it, set Adjust_is_pending_delete to 
True. Adjust_is_pending_delete has the same effect as 
holding down the (Control 1 key when adjusting a selection. This set­
ting is useful for editing, since ordinarily you adjust a primary selec­
tion prior to replacing or deleting it. You can make a pending-delete 
selection into a nonnal selection by adjusting it while holding down 
the (Control I key. The default setting for 
Adjust_is_pending_deleteisFalse. 

Text/Auto_indent 
If you want each new line of text you type to have the same white 
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space as the previous line, set Auto_indent to True. Lines 
insert using the ~ or ( Paste ) function keys are not affected. 

This setting is often preferred by programmers. The default setting 
forAuto indentisFalse. 

Text/Checkpoint_frequency 
You can ask to have your Text Editor document checkpointed every 
n edits. The checkpoint filename ends with the suffix%%. If you're 
editing the les sonl. lirner ick file and the 
Checkpoint_frequency default value is 20, a checkpoint file 
named lessonl. limerick%% is written every twenty edits. The 
default is O (no checkpointing). 

Text/Edit_back_char 
Edit back char is the delete character. The default is the value - -
produced by pressing the key. To make the ( Back Space ) 
key the default, change the Edit_ back_ char default value to 
\ '"'H. 

Text/Insert_rnakes_caret_visible 
You might prefer to have text windows set up so that when you 
insert text, the caret becomes visible even if it wasn't visible before. 
To do that, cycle Text/Insert_rnakes_caret_visible to 
Always. The default is If _auto_scroll. 

Text/Scratch window 
You can specify the number of text lines in the Text Editor's scratch 
window. Extra lines are useful if you do a lot of work in the scratch 
window. For example, when Scratch_ window is set to 5, a 
five-line scratch window is created whenever you start a Text Editor. 
The default value is a one-line scratch window. 

Tty/Text_wraparound ize 
The Console writes its history into the /trnp directory. The default 
buffer size is 0, which gives you an infinite buffer. You can avoid 
filling up /trnp by changing Tty /Text _wraparound_ size to 
a reasonable number of characters- say, 50,000- after which the 
space will be reused starting over at the beginning. 

10. 7. Editing Default Lines Nonnally, the default line is read-only except for the text item or cycle item 
where you set the default value. However, the Defaults Editor gives you the 
capability of editing default lines in the various categories. 

NOTE You shouldn't attempt using the Edit Item button unless you're a "power user." 
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The Edit Item button has a menu containing the following menu items: 

o 'Copy Item' duplicates the selected default line. (You select a default line 
by clicking LEFT anywhere in the line.) You can then edit the default name 
and the default value of the new item. Only items with text or numeric 
values can be copied. 'Copy Item' is useful when you want to change 
several instances of an item type - for example, to insert a new mail alias 
into the defaults database. 

o 'Delete Item' removes the selected default line from your private defaults 
database. You can't pennanently delete a default that's defined in the sys­
tem database, but you can make it behave like an undefined item by giving it 
the special value \255Undefined\255. The first and last bytes of this 
string have the ASCII code 2 5 5. 

o 'Edit Label' lets you edit the default name of the selected default line. 
When you choose 'Edit Label', the default name in the selected line changes 
from bold to nonnal font. You can then select the default name and edit it as 
you would any panel text item. 
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11.1. Starting a Tool 

Figure 11-1 

11 
All About Tools 

This chapter contains brief descriptions of the tools in the standard Sun View 
menu. A tool is a shell, editor, or other application that runs in Sun View. The 
tools are discussed in the same order as they appear in the Sun View menu. For 
more infonnation about a tool covered in this chapter, look up its command 
name in the Tool Names Cross-Reference, Table 11-1, then find the command in 
the SunOS Reference Manual. 

To start a tool, choose its menu item from the Sun View menu, as shown in Fig­
ure 11-1. 

Starting a Tool 

You can also start a tool from a SunOS command line, including a command line 
in Command Tool, Shell Tool, or any other Sun View command window. 

o To start a tool from a command line, type: 

command is the name by which the tool is known to the SunOS operating sys­
tem. The command names for all of the tools in the Sun View menu are cross­
referenced in Table 11-1. 

& is an optional parameter that causes the tool to run "in the background" - not 
the Sun View background display, but the SunOS job control background 
described in the Getting Started with SunOS: Beginner's Guide Doing More 
with SunOS: Beginner's manuals. 
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Table 11-1 

Table 11-1 the menu the SunOS com-
mand name """''f"\,..,,..,t-,,.ri with each one. You can look the command names up in 
the SunOS Manual for further 1nt-.n.rnn<>t-·•An 

Tool Names 

Dbx (debug) Tool 
Performance Meter 

cmdtool 
shell tool 

textedit 
defaultsedit 
iconedit 
font edit 
mail tool 
dbxtool 

clock 
lock screen 

names A shell is 
.., ........ u .................... ...,, such as Command Tool and Shell 

at the same time. 
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Figure 11-2 
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Command Tool is a command interpreter that displays a standard Sun View text­
based command window with scrolling. For more information on command win­
dows and the 'Cmd Modes=>' pull-right menu, see Sections 5.3 and 8.12. 

Command Tool is an enhancement designed to replace Shell Tool. You can do 
anything in Command Tool that you can do in Shell Tool. In addition, Com­
mand Tool gives you the advantages of scrolling and the availability of the full 
Text menu rather than the limited Tty menu. 

The Command Tool icon is shown to the left. The Command Tool Frame is 
shown in Figure 11-2. 

Command Tool Frame 

venus"f, Is "' . doc 
patrick henry.doc sched.doc 
venus% head -3 patrick_henry.doc 
I don't know why they always misquote me about liberty. 
What they say I said ain't what I said at all. 
Here are some of the remarks I've made recently on the subject. 
venus% fgrep -n "Give me liberty" *.doc 
patrick_henry.doc:4:Give me liberty or I'll give you what-for. 
patrick_henry.doc:5:Give me liberty or I'll give you a piece of my mind. 
patrick_henry.doc:7:Give me liberty or give me a salami on rye. 
patrick henry.doc:B:Give me liberty or give me a raise. 
patrick-henry.doc:9:Give me liberty or give me a free lunch. 
patrick=henry.doc:10:Give me liberty or give me a break. 
patrick henry.doc:11:What I want for my birthday is: Give me liberty. 
patrick=henry.doc:12:Vou know what I always say--Give me liberty! 
patrick_henry.doc:13:Give me liberty or I'll go on strike. 
patrick_henry.doc:14:"Give me liberty" seems to lose its meaning after a while. 
patrick_henry.doc:15:Maybe the boy who cried wolf really cried, "Give me liberty 
!" 
venus% cp patrick henry.doc liberty.doc 
venus% ls *.doc -
liberty.doc patrick henry.doc sched.doc 
venus% get selection I cat -
If liberty-is all it's cracked up to be, gimme some. 
Give me more 
and more 
and more 
and more 
and more 
and more 
venus"I • .. 
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Shell Tool 

nnm 
~ 
/bin/csh 

Figure 11-3 

Shell Tool is a command interpreter that displays a tty window. For more infor­
mation on tty windows and the Tty menu, see Sections 5.5 and 8.13. 

Command Tool has all of Shell Tool's features plus some that Shell Tool lacks. 
Even if you've grown accustomed to Shell Tool, you may want to try Command 
Tool for the same tasks and see if you prefer it. 

The Shell Tool icon is shown to the left. The Shell Tool Frame is shown in Fig­
ure 11-3. 

Shell Tool Frame 

venus% ls *.doc 
liberty.doc patrick henry.doc sched.doc 
venus% head -3 patrick_henry.doc 
I don't know why they always misquote me about liberty. 
What they say I said ain't what I said at all. 
Here are some of the remarks I've made recently on the subject. 
venus'.4 fgrep -n "Give me l iberty 11 *.doc 
liberty.doc:4:Give me liberty or I'll give you what-for. 
liberty.doc:5:Give me liberty or I'll give you a piece of my mind. 
1iberty.doc:7:Give me liberty or give me a salami on rye. 
liberty.doc:B:Give me liberty or give me a raise. 
liberty.doc:9:Give me liberty or give me a free lunch. 
liberty.doc:10:Give me liberty or give me a break. 
liberty.doc:11:What I want for my birthday is: Give me liberty. 
liberty.doc:12:You know what I always say--Give me liberty! 
liberty.doc:13:Give me liberty or I'll go on strike. 
liberty. doc: 14: "Give me 1 i berty" seems to 1 ose its meaning after a while. 
liberty.doc:15:Maybe the boy who cried wolf really cried, "Give me liberty!" 
Jatrick henry.doc:4:Give me liberty or I'll give you what-for. 
)atrick-henry.doc:5:Give me liberty or I'll give you a piece of my mind. 
Jatrick-henry.doc:7:Give me liberty or give me a salami on rye. 
Jatrick-henry.doc:8:Give me liberty or give me a raise. 
Jatrick-henry.doc:9:Give me liberty or give me a free lunch. 
oatrick-henry.doc:10:Give me liberty or give me a break. 
oatrick-henry.doc:11:What I want for my birthday is: Give me liberty. 
oatrick-henry.doc:12:You know what I always say--Give me liberty! 
oatrick-henry.doc:13:Give me liberty or I'll go on strike. 
oatrick-henry.doc:14:"Give me liberty" seems to lose its meaning after a while. 
oatrick=henry.doc:15:Maybe the boy who cried wolf really cried, "Give me liberty 
!" 
venus% rm liberty.doc 
~m: remove liberty.doc? y 
11enus•1.. O 
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Figure 11-4 
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Graphics Tool displays two windows for running graphics programs. 

The upper window is a tty window (just like Shell Tool) where you can type 
commands that run graphics programs and other SunOS commands. 

The lower window, which is gray when Graphics Tool starts, displays the graph­
ics output of the command running in the tty window. 

The Graphics Tool icon is shown to the left. The Graphics Tool frame is shown 
in Figure 11-4. 

Graphics Tool Frame 

v s usr demo 
ouncedemo@ cursor demo@ 
anvas demo@ f ramedemo@ 
enus%-/usr/demo/bouncedemo 

• • • • • • 
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Console The Console frame displays error messages and other messages from Sun View 
and SunOS. A Command Tool is the recommended system console, but you can 
start a Shell Tool as your Console frame. 

NOTE Always have one and only one Console frame. 

Figure 11-5 

The system messages that appear in the Console window are written into the 
/tmp directory. If your system generates a great many messages, they may use 
up all the available space in/tmp. You can avoid this potential problem by 
using the Defaults Editor to set wraparound_size to a reason-
able number; say, 50,000 characters. Then the space you've allocated has 
been used up, the Console frame will reuse it by wrapping around to the begin­
ning. 

The Console icon is shown to the left. The Console frame is shown in Figure 
11-5. 

Console Frame 

venus% .. 
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11.4. Editors 

Text Editor 

bedtime_ 

Figure 11-6 

11-All About Tools 

The 'Editors=>' pull-right menu contains the names of tools for creating and 
revising documents, icons, and fonts, plus a tool that lets you change Sun View 
defaults. 

The Text Editor lets you create and revise text files. This manual describes the 
Text Editor in detail. The Lessons section provides an introduction for first-time 
users of window-based editors. 

The Text Editor icon is shown to the left. The Text Editor frame is shown in Fig­
ure 11-6. 

Text Editor Frame 

Once upon a time there was a beautiful queen in a city by the 
sea. The queen was as good as she was beautiful, and all her 
subjects loved her. The city she ruled had fresh air, good harvests, 
and the blessings of peace. There was just one problem: the 
computers were always down! 

The baker said to the customers, "How can I te 11 if there's 
rye bread in the oven? My computer is down!" 

The blacksmith said to the stable owner, "How can I tel 1 if 
your horses will be shod next Tuesday at 3:00? My computer is down!" 

The quality of life in the city by the sea grew worse and 
worse. The queen sat on a balcony of the castle, looking down on her 
unhappy subjects, and she thought, and she thought, and she thought. 
All of a sudden she leaped from her bench. 

"I know," she cried, "I will make a network!" 

So she called in experts from all over the world. They 
brought powerful magic scrolls full of words like "abracadabra" and 
"coaxial cable" and "multiplexor box," and they unrolled the scrolls 
and chanted before the queen. And as they chanted, all the computers 
in the city by the sea began to talk to one another. 

"I'll trade you a dozen bagels for a pony ride," said the 
baker's computer to the stable owner's computer. 

"I'll meet you in the orchard when the moon rises," said the 
carpenter's computer to the schoolteacher's computer. 

All the people of the city gathered before the castle 
rejoicing. They looked up at the queen, who beamed dDl.lln upon them 
from her balcony, and they shouted, "The net works! Long live the 
queen!" 

The queen ruled for many years, and the computers never went 
down again, and they all lived happily ever after. 

The End 
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changing standard 
a description 

................ ..., .. ....., .. 10. 

The Defaults Editor icon is shown to the left. The Defaults Editor frame is 
shown in 11-7. 

Figure 1 Defaults Editor Frame 

Item) 

CHc:k_to_Type (Disabled): C Disabled 
Font (): 

Walking_Menus (Enabled): Enabled 
Rootmenu filename (): /usr/view/1.75/usr/lib/rootmenu 
Icoo_gravit.y (North): C North 
Icoo_close_level (Ahead_of_all): C Ahead_of _a 11 

Jl..;np_cursor_on_resize (Disabled): C Di sabled 
Alert_Bell (1): 

Audible Bel 1 (Enabled): C Enabled 
Visible_Bell (Enabled): C Enabled 
Embolden labels (Disabled): C Enabled 
Ttysubwindow/Retained 
Root Pattern (on): 
Confirm_Property_Changes (Disabled): C Di sabled 
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Icon Editor 

Figure 11-8 

11 -All About Tools 193 

The Icon Editor is a tool for creating and revising icon and cursor images. You 
can create a new icon or cursor and store it in a file. You can also load a file that 
contains an icon or cursor image, edit it, and save it. 

The Icon Editor icon is shown to the left. The Icon Editor frame is shown in Fig­
ure 11-8. 

Icon Editor Frame 

II Paint II Clear I Undo 
Points: Pick points to Paint or Clear. 

To load an image: 

Dir: /usr/include/images 

file: lockscreen.ico'i 

(Load)(Store)[Browse)(Quit) 

Size C Icon Grid 0 Off 

( Clear ) CTTID [Invert) 

~· 
D Fi 11 O Border 

0 F1 11 O Border 

abc fi 11: 

load Fill Proof 
0 Src 0 Src Osrc 

o In the File: text item in the control panel, type or copy the pathname of the 
file that contains the image you want. (You can find standard Sun View 
icons, pointers, and cursors in the /usr I include/ images directory.) 

o Push the Load button by clicking LEFf on it. The image appears in the 
drawing canvas, the large window on the left side of the Icon Editor frame. 

To store an image: 

o In the File: panel text item, type or copy the pathname of the file where you 
want to save the image. If you 're editing an existing file, the pathname is 
already there. 

o Push the Store button. 

SU 
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To create or change an image: 

o Set the control panel on the right side the frame to draw points, lines, rec­
tangles, circles, or text. Then click LEFT to draw a point or paste the fill text 
into the drawing canvas, or hold down LEFT and drag to draw a line, rectan­
gle, or circle. 

o Click MIDDLE or hold down and drag MIDDLE to erase. 

Every change you make in the drawing canvas is reflected in the proof window in 
the lower right corner of the Icon Editor frame. The proof window shows you a 
life-size version of the image as it would appear on the Sun View background. 

To save a new image: 

o Type its filename in the File: text item and push the Store button. If neces­
sary, type a new directory pathname. 

For more information on the Icon Editor, see the iconedi t manual page online 
or in the SunOS Reference Manual. 
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Font Editor 

Figure 11-9 

11 -All About Tools 195 

The Font Editor is a tool for creating and revising font images. 

The Font Editor icon is shown to the left. The Font Editor frame is shown in Fig­
ure 11-9. 

Font Editor Frame 

(Load) (Store)~ Font name: /usr/lib/fonts/fixedwidthfonts/serif .r.12. 
Max Width: 7 Max Height: 14 

Caps Height: 10 X Height: 7 Baseline: 10 ~ 

Operation: ~Single Pt !ii Pt Wipe ~Line ~ Rect ~Cut ~Copy ~Paste 

42:B 
B 

1 2 3 4 5 

A 

To load an existing font: 

1 2 3 4 5 

1 2 3 4 5 

o Type its pathname in the Font name: text item in the control panel. You 
will find the standard Sun View fonts in the 
/usr/ fonts/fixedwidthfonts directory. 

o Push the Load button. 

To load an individual character: 
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0 

D 

D in to indicate 

o Push the T'C>f"•-t".lr1m11".l .. 

ter. 

To save an entire font: 

of the charac-

o the name: text item if necessary, and push the lozenge-shaped 
button in the control panel. 

For further instructions on creating and editing fonts, see 
mand online or in the SunOS Reference Manual. 

f ontedi t com-

The 'Tools=}' pull-right menu contains the names of some important applica­
tions. 
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Mail Tool 

Figure 11-10 
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Mail Tool provides windows for sending and receiving mail messages over the 
network. The Mail and Messages: Beginner's Guide manual contains a complete 
description of this tool. You '11 enjoy reading the sample mail. 

The Mail Tool icon is shown to the left. The Mail Tool frame is shown in Figure 
11-10. 

Mail Tool Frame 

..... .... 

5 o martha ashington 
58 martha@washington 

> 59 abigail@adams 

Fri Oct 13:36 
Fri Oct 9 14:01 
Thu Oct 15 09: 47 

Show )( Next )(Delete)( Reply )(Compose) 

Save )( Folder ) Fi 1 e: -1-bugs., 

o: dolly©madison 

35/11 
29/885 
5412162 

Print )(New Mail) 
Misc )( Done ) 

Subject: A Most Grievous and Unfortunate Circumstance 

Dearest Dolly, 

Knowing your intimate friendship with the wife of General 
Washington, I write to tell you of a most scandalous situation. 
I am informed that the young men at the publicke house have been 
mocking the good general regarding his iron teeth. 

Do have a word with James, and if it is true, try to discover 
whether Martha can gently persuade the great man to try 
porcelain or gold instead. 

(Inc 1 ude )(be 1 i ve r ][ C 1 ear )(Re-address) C Stay Up 

• o: martha©washington 
Subject: How George May Be Aided in His Publicke Appearances 
Bee : ab i ga i l @a dam~ 

Dearest Martha, 
Thee oughtest talk to George-about his false teeth. 
My husband tells me the men at Fraunces Taverns 
spoke most unkindly of his appearance there. 

Such a great general and statesman as he 
deserves better treatment at the hand of his dentist. 
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Dbx (debug) Tool 

Figure 11-11 

Dbx Tool is a source-level debugger for C, Pascal, and FORTRAN 77 programs. 
See the dbxtool command in the SunOS Reference Manual for information on 
how to use the debugger. 

The Dbx Tool icon is shown to the left. The Dbx Tool frame is shown in Figure 
11-11. 

Dbx Tool Frame 

/* 

struct few few2 .. { 3, 4, NULL, "world" 
struct few few1 "' { 1, 2, &few2, "hello" 

* write a main program to use the structures 
*/ 
main() 
{ 

I* 
* declare the variable *fewp 
* to p[oint to a few-type structure 
*/ 

struct few *fewp; 
I"' 
* print out a message 
"'I 

! for (fewp = &fewl; fewp != NULL; 
pri ntf( "'ks ", fewp -> 

fewp -> next) { 

} 
} 

ea ing symbolic in ormation ... 
. . Read 155 symbols 
\ (dbxtool) run 
:t: Running: example 
~t hello world 
~\execution completed, exit code is 0 
\program exited with 0 
/{ (dbxtool) stop at "example .c" :29 
~t (2) stop at "example .c" :29 
\ (dbxtool) print fewp 
~f "fewp" is not active 
.;,: (dbxtool) 
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Perfmmance Meter is a tool for obseiving system perfonnance. 

The Perfonnance Meter icon, shown on the left, is a speedometer-like gauge 
whose needles move as system conditions change. The short needle tracks aver­
age perfonnance, the long one tracks current perfonnance. The moving display 
is updated about once a second. 

The perf onnance option being measured is shown in the lower left corner of the 
icon or frame. Its maximum value is shown in the lower right comer. For exam­
ple, since CPU perfonnance is measured as a percentage, its maximum value is 
100. 

The Perfonnance Meter frame, which is the same size as its icon, is a graph that 
changes as system conditions change. The 'Tools=>Perfonnance Meter' pull­
right menu contains the following options, shown in frame (open) fonnat: 

'Percent CPU Used' - processor perfonnance. 

'Ethernet Packets' - network perfonnance. 

'Swapped Jobs' - memory perfonnance. 

'Disk Transfers' - I/0 perfonnance. 

There are several additional options for Perfonnance Meter. For example, it can 
monitor perfonnance on a remote machine such as your fileseiver. To change the 
display, choose another option from its menu: 

o Move the pointer over the Perfonnance Meter icon or frame and hold down 
the RIGHT mouse button to bring up its menu. Highlight the option you 
want, then release the mouse button. 

For more infonnation, see the perfmeter command in the SunOS Reference 
Manual. 
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Clock 

XI XII I 

x II 

IX ) 
m 

vm 1111 

VII I v 

Guide REFERENCE 

Clock is a tool that displays a clock face icon C'hr'\uninn- the current time of day -
the hands move. 

You can choose either a round or a rectangular clock icon, as shown to the left. 
The SunView menu displays the icons without the 

The Clock frame displays the day, full date, and year as well as the time, as 
shown in Figure 11-12. 

To update the information displayed by the Clock, use the date command 
described in the SunOS Reference Manual. To add additional Clock options, 
such as a second hand and a day-and-date display, see the clock command in 
the SunOS Reference Manual to find out what options to specify, then customize 
your Sun View menu, as described in Chapter 8, to include the optional Clock 
features, 

Figure 11-12 Clock Frame 
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12.1. A Map of Sun View 

1 
Sun View Terminology 

This chapter contains a summary of tenns used throughout this manual. Related 
tenns are grouped together under the following headings: 

0 General Sun View tenns. 

0 Mouse and pointer tenns. 

0 Text tenns. 

0 Scrolling terms. 

0 Menu tenns. 

0 Frame and window tenns. 

Figure 12-1 contains a picture of a SunView screen, with arrows and labels for 
the various parts. 
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Figure 12-1 The SunView Screen Labeled 

Console window-~~ 
background 

Command Tool frame· 
command line 

caret 
command window 

scrollbar 
bar 

bubble 
scroll box 

icon-~~~~~~~ 

pointer-~~~~ 

pop-up frame-.""illllllllll 
panel~-ll-f:=F:+;;+:=~-e-"f'IW!"44--t:e--£:i-s:m---~~~~~~_...... 

panel text item -iii~~~~- :po11y 
panel button 

scratch window 

edit window 

selection 

menu-~~ 

menu item-~~ 

tty window 
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Terms 

12.4. Text Terms 

inverse 

LEFI 

MIDDLE 

RIGHT 

pointer 

point 

click 

hold down 

select 

selection 

secondary selection 

pending-delete selection 

extend the selection 

keyboard focus 
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text or in white on 
background. 

Display in inverse 
selected text or menu item that can be chosen. 

A panel that is displayed in to an action you 
request. It contains informative messages, warnings, and 
choices represented by panel buttons. 

The LEFT mouse button, used to select text, push panel 
buttons, and make choices. 

The MIDDLE mouse button, used to adjust or extend 
selections and move frames. 

The RIGHT mouse button, used to bring up menus and 
choose menu items. 

The distinctive shape, usually an arrow pointing "north­
west," whose position on the screen is moved by the 
mouse. The pointer shape is a target when it's on the 
frame border, a right arrow when a menu is up, and an 
hourglass when you must wait for an operation to com­
plete. The pointer takes other shapes when it's in the 
scrollbar and in certain applications. 

Position the pointer by moving the mouse. 

Press and release a mouse button. 

Press a mouse button and continue to hold it down while 
performing another operation - for instance, while pre­
viewing a menu or choosing a menu item. When this 
manual tells you to hold down a mouse button, keep 
holding it down until the manual tells you to release it. 

Highlight text by pointing and clicking LEFT. Selected 
text is marked for subsequent operations. 

Highlighted text that is recognized by Sun View for 
menu and function key operations. 

An underlined temporary selection that you make while 
pressing a function key. 

A grayed selection that can be deleted by typing or past­
ing. 

Adjust the current selection to include more (or less) text 
by pointing and clicking MIDDLE. 

Refers to the window where typing or pasting appears 
(normally the window that contains the pointer). 
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Click-to-Type keyboard focus 
Lets you click in a window to set the keyboard focus. It 
remains there, no matter where you move the pointer, 
until you click in another window. 

Pointer-in-Window keyboard focus 
The nonnal keyboard focus in Sun View - changes 
when you move the pointer into another window. 

Mouse-to-Type keyboardfocus 

insertion point 

caret 

Clipboard 

document 

erase text 

delete text 

scroll boxes 

s 
microsystems 

Another name for Pointer-in-Window keyboard focus. 

The place where next character you insert will go. 
To set the insertion point, position the pointer and click 
LEFf. 

indicator. In a window that has the 
caret is a blinking black triangle. In 

a window keyboard focus, the caret is an 
unblinking gray diamond. 

Stores text you copy or cut. 

Remove text 

Remove text from a a04:;urne11t and place it on the 

The boxes at either end of the scrollbar. 
.......... .., ........... "' ....... a or a 

so 

in 
at a 

bounded by the 
.,...,.,.c .. ..-.r • .,... the 
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12.7. Frame and Window 
Terms 
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menu A list of actions you can choose from. 

menu item The name of an action in a menu. 

bring up a menu Hold down the RIGHT mouse button. 

pull-right menu A submenu you bring up by pulling right on its menu 
item. 

pull-right menu item The menu item you pull right on in order to bring up a 
pull-right menu; for instance, you bring up the Text 
menu's 'File=>' pull-right menu-which contains 
several menu items - by pulling right on the 'File=>' 
pull-right menu item. 

highlight a menu item Indicate a menu item to be chosen. 

preview a menu Hold down the RIGHT mouse button to bring up a menu 
and highlight various menu items, including those in 
pull-right menus. 

choose a menu item With the desired menu item highlighted, release the 
mouse button. 

Sun View menu The menu you bring up over the gray background. Con­
tains menu items for starting shells, editors, and tools; 
obtaining various services; and quitting Sun View. 

Frame menu The menu you bring up over a frame or icon. Contains 
menu items for opening and closing, moving and resiz­
ing, changing an overlapping display, and quitting the 
tool. 

Text menu The menu you bring up in a text window or command 
window. Contains menu items for file operations, edit­
ing, displaying parts of a document, finding and replac­
ing text, and optional extras. 

frame 

icon 

frame header 

window 

text window 

edit window 

sun 
microsystems 

A Sun View object through which a tool interacts with 
the user. The frame is surrounded by aframe border 
where you move the pointer to bring up the Frame menu. 
A frame can contain one or more windows. 

An image that represents a closed frame. 

The black stripe at the top of the frame border that con­
tains information displayed by the tool, such as filename 
and directory. 

The part of the frame you work in. There are various 
types of windows. 

A window that lets you display and edit text. 

The main text window displayed by the Text Editor. 
Usually contains text from a file. 

Revision A of 9 May 1988 



208 Sun View 1 tle2rnrn!r· Guide REFERENCE 

scratch window 

command window 

dialog 

transcript 

panel 

panel text item 

panel button 

push a panel button 

choice item 

slider 

cycle item 

choose in a choice item 

SU 
microsystems 

An auxiliary text window displayed by the Text Editor, 
Defaults Editor, and other tools. Can used as a 
scratch pad for filenames and short strings of text. 

A text window that includes a command interpreter, 
such as a Command Tool window. 

The interaction between the user and the shell, as in a 
command window or a tty window. 

The record of the dialog in a command window. 

A type of window that can contain various items includ­
ing panel buttons, text items, cycle items and other 
choice items, depending on the application. These items 
can contain hidden menus. 

An area in a panel where you can type and edit text. 

A representation of an action choice, such as Replace 
All in the Find and Replace frame. 

Click LEFT on the button to make the choice. 

A panel item lets you specify a condition, such as 
the delimiter choice buttons in the Find Marked Text 
frame and the ca1re21orv cycle item in the Defaults Edi­
tor. 

A type of choice item that lets you slide a marker in a 
to choose a ............. ULL, ..... 

A type of choice that lets you cycle through a set of 
choices until you come to the setting you prefer. 

The you depends on the type of choice item, 
but every choice item also has a menu that you can bring 
up to make a choice. 
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Special Characters 
%% in checkpoint filename, 139, 180 
"" in backup filename, 139 
& runs tool in the background, 185 
> in Text Editor icon, 82 
+ keys, 164 

in text, 103 
I with get_ selection command, 115 

A 
aborting an operation, 106 
accelerator, 161 thru 169 

alert button, 87, 169 
caret, 53, 164 
Close, 133 
Copy, 145 
Cut, 145 
erase, 164 
Find Selection=>, 50 
Find=>, 152 
for menu items, 33 
Front, Back, 163 
function key, 161 
Include File, 140 
introduction to, 29 
keyboard, 164 
Load File, 140 
menu, 161, 164, 167 
mouse button, 53, 163 
Move,38, 134, 163 
Move Caret to End, 166 
Move Caret to Start, 166 
Open, 31, 133, 163 
Paste, 145 
Resize, 38, 134, 135, 163 
Set Directory, 141 
tutorial, 29 thru 53 
Undo Last Edit, 145 

Adjust_is_pending_delete default, 179 
adjusting a selection, 18, 94, 104 
adjusting with MIDDIB mouse button, 6 
advanced selecting, 103 
Again, in Text menu, 142 

ignores Undo, 142 
used with Find, 143 

alert window, 15, 86 
accelerators, 87, 169 

-209 

alert window, continued 
arrows, 86 
buttons, 86 
for Resize and Move, 36 

alias, using tty escape sequence, 76 
All Text, in Find and Replace frame, 48, 151 
arrow keys, 78, 166 
Auto_ indent default, 179 

B 
Back accelerator, 163 
Back Space key, 14, 180 
Back, in Frame menu, 32, 34, 137 
-background option in sunview command, 59 
background, SunOS job control, 185 
background, Sun View 

customizing, 59 
inverse video, 60 

backup files, 139 
backward, extending selection, 20 
bar, in scrollbar, 44, 119 
basic editing, 95 
basic scrolling, 119 
Blink Owner button, in Find and Replace frame, 46, 151 
Blink Owner button, in Find Marked Text frame 153 
block cursor, 87, 93 ' 
bold font in frame header, 179 
bounding box, 34, 133 
brackets in text 

inserting, 142, 154 
removing, 154 

bringing up a menu, 7, 125 
bringing up Sun View, 3, 59 
bubble, in scrollbar, 44, 119 
button, choice, 152 
button, mouse, 6 
button, panel 

in alert window, 16 
pushing, 16, 46 

c 
C debugger, 198 
canceling a secondary selection, 106 
canceling a view, 149 
canceling an operation, 106 
canvas, 87, 193 
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Capitalize=>, in Text menu, 154 
Caps Lock key, 168 
caret, 13, 93, 95 

blinking triangle, 95 
display and moving, 45 
insertion point, 95 
move to end of document, 150 
move to start of document, 149 
show at top of window, 149 

caret accelerators, 164 
categories in Defaults Editor, 175 
Category cycle item, in Defaults Editor, 174 
cd command, used in Sun View, 3 
Center string items default, 178 
Change Line Wrap:;, in Text menu, 48, 150 
changing command modes, 85 
changing defaults, 177 
changing direction with Shift key, 83 
changing keyboard focus, 73 
changing the rootmenu file, 130 
character, erasing, 96 
character, selecting, 94 
Check Printer Queue, in Sun View menu, 128 
checkpoint file, 139 
Checkpoint_frequency default, 180 
choice button, 152 
choosing a menu item, 10 
Click-to-Type keyboard focus, 73 
Click_to_Type default, 179 
clicking, 17 
clicking to select text, 103 
Clip Lines, in Text menu, 52, 150 
Clipboard, 20, 96, 145 

finding contents of, 152 
showing contents of, 152 

clipping long lines, 150 
Clock, 200 
clock command, used in Sun View, 186, 200 
Close, in Frame menu, 133 
closing a menu, 8 
Cmd Modes=> menu, in Text menu, 156 
cmdtool command, used in Sun View, 186, 187 
command 

cd, 3 
clock, 186, 200 
cmdtool, 186, 187 
date, 200 
dbxtool, 186, 198 
defaultsedit,186 
emacs, 166 
f mt, 150, 153 
f ontedi t, 186, 195 
get selection, 115 
gfxtool, 186, 189 
grep, 156 
head, 98 
iconedit,87, 186, 193 
indent, 154, 176 
lockscreen, 186 
lpr, 51 

-210-

command, continued 
mailtool, 186 
more, 157 
perfmeter, 186, 199 
rlogin, 114 
screendump, 59 
shell tool, 186, 188 
stty, 176 
sunview, 59 
swin, 74 
textedit, 186, 191 
toolplaces, 129 

command line, 84 
command modes, 85 
command names cross-reference, 186 
Command Tool, 187 
Command Tool, remote login to, 129 
command window, 84 
comparison of text handling, 114 
Compatibility category, in Defaults Editor, 176 
Console buffer size default, 180 
Console frame, 5, 190 
Constrained, in Frame menu, 35 
Continue, in Tty menu, 157 
Controlkey,83, 106, 162 
Control panel, in Defaults Editor, 174 
Copy then Paste, in Text menu, 146 
Copy then Paste, in Tty menu, 157 
Copy, in Text menu, 145 
Copy, secondary, 106, 111 
copying 

a selection, 98 
and pasting text, 98 
between windows, 101 

copying text, 97, 110, 111 
. cshrc file, 76 
cursor, block, 87, 93 
customizing the Extras=> menu, 154 
customizing the Sun View background, 59 
customizing the Sun View menu, 130 
Cut function key, 96 
Cut, in Text menu, 21, 145 
Cut, secondary, 106, 112 
cutting and pasting text, 99 
cutting text, 97 
cycle item, 45, 17 4 
cycling, in Defaults Editor, 175 

D 
date command, used in Sun View, 200 
Dbx (debug) Tool, 198 
dbxtool command, used in Sun View, 186, 198 
default directory in Text Editor, 23 
default, in Defaults Editor, 175 
Default Selection default, 178 
Defaults c-;-tegory, in Defaults Editor, 176 
Defaults Editor, 173 thru 181, 192 

Adjust_is_pending_delete,179 
Auto indent, 179 
Category cycle item, 174 



Defaults Editor, continued 
Checkpoint_frequency,180 
Click to Type,179 
Controlpanel, 174 
cycling through categories, 175 
Defaults panel, 175 
Edit Item button, 175, 180 
Edit back char, 180 
Icon=gravity, 179 
Input/Left Handed,178 
interesting defaults, 178 
left-handed keyboard use, 69 
Menu/Center_string_items,178 
Menu/Default Selection 178 
Menu/Font, 178- ' 
Menu/Initial Selection 178 
Menu/Stay up:-179 ' 
Message panel, 175 
Quit button, 175 
quitting, 173 
Reset button, 175 
Save button, 175 
scratch window, 17 5 
Scratch_window, 180 
Scrollbar/Vertical_bar_placement,179 
starting, 173 
SunView/Font, 178 
Text/Font, 178 
Text/Insert makes caret visible 180 
Text/Multi_click_~pace, 103 ' 
Text/Multi click timeout 103 
Tty/Text_wraparound size'.180 
when changes take effect, 177 

. defaults file, 174 
defaults in menus, 126 
Defaults panel, in Defaults Editor, 175 
defaultsedit command, used in Sun View, 186 
Delete key, 14, 96, 180 
deleting and pasting back, 96 
deleting line breaks, 96 
deleting text, 16, 96, 112 
delimiters 

finding with 'Find Marked Text', 152 
matching with 'Match Delimiter', 153 

Destroy View, in Text menu, 149 
diagram of function keys, 69 
diamond (•)keys, 164 
direct scrolling, 44, 120 
directory 

starting Sun View from, 59 
/usr/include/images, 132, 193 
/usr/lib/fonts/fixedwidthfonts, 178, 195 

directory, setting, 23, 140 
Disable Page Mode, in Tty menu, 157 
Disable Scrolling, in Text menu, 156 
dismissing a menu, 8 
Display:::::> menu, in Text menu, 146 thru 150 
Display:::::> menu, in Text Menu 

Change Line Wrap::::>, 48 
Clip Lines, 52 
Move Caret to End, 45 
Move Caret to Start, 45 
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Display:::::> menu, in Text Menu, continued 
Show Caret at Top, 45 
Wrap at Character, 50 
Wrap at Word, 51 

displaying the caret, 45 
document, 11 

emptying, 141 
including a file, 41 
saving, 22 

Done button, in Find and Replace frame, 151 
Done button, in Find Marked Text frame, 153 
double-clicking, 17, 103 

E 
Edit Item button, 180 
Edit Item button, in Defaults Editor, 175 
edit window, 11 
Edit::::> menu, in Text menu, 142 thru 146 
Edit::::> menu, in Text Menu 

Cut, 21 
Paste, 21 
Show Clipboard, 20 
Undo Last Edit, 24 

Edit_ back_ char default, 180 
(edited) in frame header, 23 

editing 
basic, 95 
enabling in command window, 156 
shortcuts, 108 
undoing, 24, 102 

editing defaults, 180 
editing panel text item, 86 
editor, 191 

Defaults Editor, 192 
Font Editor, 195 
Icon Editor, 193 
Text Editor, 10, 191 

Index Continued 

Editors:::::> menu, in Sun View menu, 128, 191thru196 
emacs command, used in Sun View, 166 
Embolden_Labels default, 179 
Empty Document, in Text menu, 15, 141 
Enable Editing, in Text menu, 156 
Enable Page Mode, in Tty menu, 75, 157 
Enable Scrolling, in Text menu, 156 
End key, 166 
erase accelerators, 164 
erasing text, 14, 96 
Esc key, 141 
escape sequence, 75 
escape sequences in • ttyswrc, 75 
Exit Sun View, in Sun View menu, 53, 62, 129 
exiting SunView, emergency, 62 
exposing a frame, 32 
exposing and hiding frames, 87 
extending a selection, 18, 94 
extending with MIDDLE mouse button, 6 
Extras:::::> menu, in Text menu, 153 thru 154 

customizing, 154 



Index - Continued 

F 
Fl key, 168 
l>field<I, 153 
file 

139 
. cshrc, 76 
. defaults, 174 
including in text window, 140 
. indent . 154 

40, 
rootmenu, 130 

22, 139 
. suntools, 129 
. sunview, 61, 88, 129 
. textswrc, 77 

74 
.text extras rnenu,154 

/usr/lib/defaults, 174 -
/usr/lib/rootmenu,130 

File::::) menu, in Text menu, 14, 139 thru 142 
Empty Document, 15 
Include File, 41 
Load File, 40 
Set Directory, 23 
Store as New File, 22 

filtering selections, 84 
Find and Replace frame, 46, 150 
Find Clipboard:::::), in Text menu, 152 
Find function key, 152 
Find Marked Text, in Text menu, 152 
Find Selection:::::), in Text menu, 152 
Find text item, in Find and Replace frame, 47, 151 
Find then Replace, in Find and Replace frame, 151 
Find::::) menu, in Text menu, 150 thru 153 
finding text, 45 
Finishing Up::::) menu, in Text menu, 141 
flash lines, 9 
fmt command. used in Sun View, 150, 153 
font, 178 

bold in frame header, 179 
Font default, 178 
Font Editor, 195 
fontedit command. used in Sun View, 186, 195 
Format, in Text menu, 153 
FORTRAN debugger, 198 
frame, 81 thru 88 

bringing to front, 13 7 
closing, 8 
command name, 11 
(edited), 23 

enlarging, 136 
exposing, 32, 87 
Find and Replace, 45, 46 
Find Marked Text, 152 
font in frame header, 179 
frame header, 8, 11, 23, 82 
grabbing to move or resize, 35 
hiding, 32, 87 
moving,34,87, 163 
opening,8 
opening, accelerator, 163 

-212-

frame, continued 

to 
subframe, 82 
Text Editor, 11 
tool name, 11 
unc:ovf~nn!!. 32 

Frame menu, 8, 133 thru 138 
Back and Front, 32, 34 

Ull..:J\,,H;;..,H, 39 
function for, 34 

frame, 45 

1'.t::lSIZt:::::::;>. 35 
UnZoom, 39 
Zoom, 39 

Front accelerator, 163 
Front, in Frame menu, 32, 34, 137 
FullScreen, in Frame menu, 39, 136 
function key, 33 

accelerators, 161 
Again, 142 
binding to a filter, 74 
Cut, 96 
Delete, 14 
diagram, 69 
Find, 50, 152 
labels, 69 
left-handed use, 69 
Paste, 96 
remapping, 74 
secondary selection with, 104 
Stop, 106, 169 

command, used in Sun View, 115 
gfxtool command. used in Sun View, 186, 189 
glossary, 203 thru 208 
grabbing a frame to move or resize it, 35 
Graphics Tool, 189 
gravity, icon, 9 
grayed menu item, 10, 21, 126, 138 
grayed selection, 104, 106 
grep command, used in Sun View, 156 

head command. used in Sun View, 98 
header, frame, see frame 
hiding a frame, 32 
highlighting, 7 

grayed for pending-delete, 106 
Home key, 166 
hot spot in pointer, 92 



I 
Icon Editor, 193 
icon files, 13 2 
icon gravity, 9 
Icon_gravitydefault, 179 
iconedit command, used in Sun View, 87, 186, 193 
icons in menus, 53, 132 
images directory, 132 
Include File, in Text menu, 41, 140 
including a file, 41 
Indent category, in Defaults Editor, 176 
indent command, used in SunView, 154, 176 
. indent. pro file, 154 
Initial_ Selection default, 178 
Input category, in Defaults Editor, 176 
input focus, see keyboard focus 
Input/Left_ Handed default, 178 
Insert Brackets=>, in Text menu, 154 
Insert makes caret visible default 180 
inserting text, 19, 95 - ' 
insertion point, 13, 19, 95 
inverse video, 7, 60 

key 
arrow, 166 
Back Space, 14, 180 
Caps Lock, 168 
Control, 83, 106, 162 
Delete, 14, 96, 180 
diamond, 164 
End, 166 
Esc, 140, 141 
Fl, 168 
Home, 166 
Line Feed, 96 
Meta ( • ), 71, 72, 164 
R13, 166 
R7, 166 
Retum,96, 169 
Shift, 162 
Stop, 169 

keyboard, 65 thru 78 
accelerators, 164 
function keys, 33 
Input/Left Handed default, 178 
labels, 69 -
labels for Type2, 72 
labels for Type3, 71 
labels for Type4, 70 
left-handed user, 6 
Type2,68 
Type3,67 
Type4, 66 

keyboard accelerators, 33 
keyboard focus, 13 
keyboard focus, changing, 73 
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L 
labels, 69 

Type2 keyboard, 72 
Type3 keyboard, 71 
Type4 keyboard, 70 

leaving Sun View, 53, 62, 129 
LEFf mouse button, 6 
left-handed function keys, 69 
left-handed user, 6 
Left_ Handed default, 178 
lessons, 3 thru 53 
limerick, 16 
line 

getting line number, 146 
selecting by number, 146 

line break, deleting, 96 
Line Feed key, 96 
line, erasing, 96 
list, reordering, 113 
Load File, in Text menu, 40, 140 
loading a file, 40 
Lock Screen, 25, 30, 62 
Lock Screen, in Sun View menu, 129 

Index Conlinued 

lockscreen command, used in Sun View, 25, 186 
login, 30 
login, remote, 129 
lpr command, used in Sun View, 51 

M 
Mail category, in Defaults Editor, 176 
Mail Tool, 51, 197 
mailtool command, used in Sun View, 186 
mapping keys, 74 
Match Delimiter, in Text menu, 153 
mechanical mouse, 92 
menu, 125 thru 157 

accelerators, 161 
bringing up, 7, 125 
Center_ string_ i terns default, 178 
closing, 8 
Cmd Modes=>, 156 
cycle item's, 48 
Default Selection default 178 
defaults, 126 ' 
dismissing, 8 
Display=>, 146 
Edit=>, 142 
Extras=>, 153 
File=>, 14 
font in, 178 
Frame, 8, 45, 133 thru 138 
grayed item, 10, 126 
icons in, 53 
in panel, 48, 127 
Initial Selection default 178 
opening, 7- ' 
popping up, 10 
previewing, 12 
previewing in panel, 48 
pull-right, 14 
stay-up, 8, 53, 127 



Index - Continued 

menu, continued 
Stay up default. 179 
Sun View, 24, 128 thru 132 
Text, 12, 139 thru 156 
Tty, 157 

menu accelerators, 164, 167 
Menu category, in Defaults Editor, 176 
menu item 

choosing, 10 
grayed, 21 
selection required, 21 

Message panel, in Defaults Editor, 175 
Meta (+)keys, 71, 72, 164 
MIDDLE mouse button, 6 
mnemonics for caret accelerators, 166 
more command, used in Sun View, 157 
mouse, 5, 91 

clicking, 17 
keyboard accelerators, 53 
left-handed user, 6 
mechanical, 92 
optical, 91 
pointer stuck, 6 

mouse button 
clicking, 6 
holding down, 6 
pressing, 6 

mouse button accelerators, 163 
Mouse-to-Type keyboard focus, 73 
mousing ahead, 84 
Move Caret to End, in Text menu, 45, 150 
Move Caret to Start, in Text menu, 45, 149 
Move, in Frame menu, 133 

accelerator, 38, 163 
alert window, 36 
Constrained, 134 
Unconstrained, 134 

moving a frame, 34, 87 
moving a selection, 99 
moving text. 21, 110, 111 
moving the caret. 45 

from the keyboard, 164 
multi-clicking, 103, 104 
Multi_click_space default. 103 
Multi_click_timeout default. 103 

new document, 141 
new file, saving, 22, 139 
newline character, 96 

Open accelerator, 163 
Open, in Frame menu, 133 
opening 

frame, 8 
menu, 7, 8 

optical mouse, 91 
overlapping frames, 31, 87 
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p 
pad,5 
page mode, in tty window, 157 
paging in a window, 120 
panel, 85 

alert window, 15, 86 
canvas, 87 
editing text item in, 86 
menus in, 48, 127 
panel button, 46 
panel items, 45 
text item, 46 

Pascal debugger, 198 
Paste function key, 96 
Paste, in Text menu, 145 
Paste, secondary, 104, 110 
pasting text. 95, 97 
pending-delete selection, 53, 106 
percent sign, 139 
perfmeter command, used in Sun View, 186, 199 
Performance Meter, 199 
pipe (I) symbol with get_selection command, 115 
piping, 150 
piping a selection to a command, 115 
pointer, 5, 92 

stop sign, 157 
target, 8 

pointer shapes, 92 
Pointer-in-Window keyboard focus, 73 
pop-up frame, 82 
popping up a menu, 10 
preserving the screen, 25 
Pretty-print C, in Text menu, 154 
previewing a menu, 12, 48 
primary selection, 93 
Print Selected Text, 25 
Print Selected Text. in Sun View menu, 129 
printing, 25 

checking the queue, 128 
Pnntnlg=~. in Sun View menu, 128 

25 
proportional scrolling, 44 

in Frame menu, 138 
pull-right menu, 14 
pushing a button, 16 
pushing a panel button, 6, 46 

quadruple-clicking, 17, 103 
question mark, 15 

editing, 108 
button, in Defaults Editor, 175 
in Frame menu, 138 

Sun View, 62, 129 
commands in text. 168 



R 
R13 key, 166 
R7 key, 166 
rearranging text, 113 
Redisplay All, in Sun View menu, 128 
Redisplay, in Frame menu, 138 
refreshing the screen, 138 
reinserting deleted text, 96 
remapping keys, 7 4 
Remote Login=>, in Sun View menu, 129 
Remove Brackets=>, in Text menu, 154 
repeating an operation, 142 
Replace l>field<I=>, in Text menu, 153 
Replace All, in Find and Replace frame, 151 
Replace text item, in Find and Replace frame, 47, 151 
Replace then Find, in Find and Replace frame, 151 
replacing text, 45, 46, 100, 110, 111 
rescuing a frame, 32 
Reset button, in Defaults Editor, 175 
Resize accelerator, 135, 163 
Resize, in Frame menu, 35, 134 

accelerator, 38 
alert window, 36 
Constrained, 135 
Unconstrained, 134 

resizing a frame, 34, 87 
resizing a scratch window, 83, 135 
Return character, 48 
Return key, 96, 169 
RIGIIT mouse button, 6 
rlogin command, used in Sun View, 114 
rootmenu file, 130, 132 
running Sun View, 3 

s 
Save button, in Defaults Editor, 175 
Save Current File, in Text menu, 139 
save frequently, 139 
Save Layout, in Sun View menu, 61, 88, 129 

a 22 
automatic backup, 139 

in Defaults Editor, 177 
cneckooint file, 139 
screen layout, 88, 129 
shortcuts, 141 

scratch window, 11, 22, 83, 175 
changing size, 83 
resizing, 135 
scrollbar, 42 

Scratch_window default, 180 
screen 

locking, 62, 129 
refreshing, 138 
saving the layout, 61, 129 

screen fonts, 178 
screen, locking, 25 
screen, unlocking, 30 
screendump command, used in Sun View, 59 
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scroll box, 42, 119 
scrollbar, 42, 119 

bar, 44 
bubble, 44, 119 
in scratch window, 42 
scroll box, 42 
Vertical bar placement,179 

Scrollbar category, in Defaults Editor, 176 
scrolldefaults,176 
scrolling, 42, 119 thru 121 

a line, 119 
a windowful, 119 
backward, 120 
basic, 119 
by line, 43 
by windowful, 43 
continuous, 120 
direct, 120 
directly, 44 
disabling in command window, 156 
down, 120 
enabling in command window, 156 
forward, 120 
paging, 120 
proportionally, 44 
returning to previous location, 120 
thumbing, 120 
to position in document, 120 
up, 120 
windowful, 120 

secondary Copy, 106, 111 
secondary Cut, 106, 112 
secondary Paste, 104, 110 
secondary selection, 104 thru 113 

canceling, 106 
problem, 106 
stuck, 106 
with Find function key, 106, 152 

Select Line at Number, in Text menu, 146 
selecting 

a character, 94 
advanced, 103 
basic, 93 
by line number, 146 
extending, 94 
word, 17 

selecting text, 16, 94 
selecting with LEFf mouse button, 6 
selc~ctlon. 91 thru 116 

adjusting, 18, 94 
caret, 95 
copying, 98 
extend by wiping, 18 
extending, 18 
extending backward, 20 
extending multi-click, 104 
filtering, 84 
finding, 152 
get selection, 115 
highlighted, 7 
highlighting characters, 95 
moving, 99 

Index ConJinued 
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selection, continued 
pending-delete, 53, 106 
piping to a command, 115 
primary,93 
printing, 129 
problem, 106 
replacing, 100 
required for menu item, 21 
secondary, 104 thru 113 
stuck on secondary selections, 106 

Services=> menu, in Sun View menu, 128 
Services=>, in Sun View menu, 25 
Set Directory, in Text menu, 23, 140 
Shell Tool, 188 
Shell Tool, remote login to, 129 
shells, 186 
Shells=> menu, in Sun View menu, 128, 186 thru 191 
shell tool command, used in Sun View, 186, 188 
Shift key, 162 
Shift Lines=>, in Text menu, 154 
Show Caret at Top, in Text menu, 45, 149 
Show Clipboard, in Text menu, 20 
Show Clipboard=>, in Text menu, 146, 152 
slider, 196 
Split View, in Text menu, 147 
standard input, 153 
standard output, 153 
starting a tool, 185 
starting Sun View, 3 
stay-up menu, 8 
stay-up menus, 53, 127 
Stay_ up default, 179 
stdin, 153 
stdout, 153 
Stop function key, 106, 169 
stop sign pointer, 157 
stopping a secondary selection, 106 
stopping an operation, 106 
Store as New File, in Text menu, 22, 139 
stty command, used in Sun View, 176 
Stuff, in Tty menu, 108, 146, 157 
subframe, 82 
. suntools file, 129 
Sun View 

Click to Type, 179 
emerge;cy exit, 62 
exiting,53, 62, 129 
font, 178 
Icon gravity, 179 
starting, 3 
starting and exiting, 59 thru 62 
tools, 4, 24, 186 

Sun View category, in Defaults Editor, 177 
sunview command, to start Sun View, 59 
. sunview file, 61, 88, 129 
Sun View menu, 24, 128 thru 132 

adding icons, 132 
customizing, 130 
editors, 128 
Exit Sun View, 62 
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Sun View menu, continued 
Lock Screen, 62 
printing, 25 
Save Layout, 61 
services, 128 
shells, 128 
tools, 128 

swapping text, 113 
swin command, used in Sun View, 74 

T 
Tab character, 50 
target pointer, 8 
terminology, 203 thru 208 
text 

copying,97, 110, 111 
cutting, 97 
deleting, 16, 96, 97, 112 
editing, 95 
erasing, 14, 96 
filtering, 84 
finding and replacing, 45 
font, 178 
handling in different windows, 114 
in panel, 86 
inserting, 19, 95 
long lines, 48 
moving, 21, 110, 111 
pasting, 95, 97 
quick editing, 108 
quoting commands, 168 
replacing, 46, 100, 110, 111 
saving, 22 
scrolling, 119 
searching, 45 
selecting, 16, 93 
swapping, 113 
wrapping, 48 

Text category, in Defaults Editor, 177 
Text Editor, 10, 191 

document, 11 
frame, 11 

text item, 46 
text item in panel, 45 
Text menu, 12, 139 thru 156 

Cmd Modes=> menu, 156 
Display=> menu, 146 thru 150 
Edit=> menu, 142 thru 146 
Extras=> menu, 153 thru 154 
File=> menu, 139 thru 142 
Find=> menu, 150 thru 153 

text window, 11, 12, 77, 82 
scratch window, 22 

. text_ extras_ menu file, 154 
Tty/Text_wraparound_size, 180 
textedit command, used in Sun View, 186, 191 
. textswrc file, 77 
thumbing, 120 
To End, in Find and Replace frame, 48, 151 
toggle, 10 

Open and Close, 133 
toggling, 162 



tool, 185 thru 200 
Clock, 200 
Console, 5 
Dbx (debug) Tool, 198 
editors, 191 
in Sun View menu, 24 
Mail Tool, 197 
Performance Meter, 199 
starting, 185 
Tools=> pull-right menu, 128 

tool names, 186 
toolplaces command, used in Sun View, 129 
Tools=> menu, in Sun View menu, 128, 196 thru 200 
triple-clicking, 17, 103 
Tty category, in Defaults Editor, 177 
tty escape sequences, 75 
Tty menu, 157 
tty window, 74, 87 
.ttyswrc error,75 
. ttyswrc file, 74 
tutorial, 3 thru 53 
Type2 keyboard, 68 
Type2 keyboard labels, 72 
Type3 keyboard, 67 
Type3 keyboard labels, 71 
Type4 keyboard, 66 
Type4 keyboard labels, 70 
typing all capital letters, 168 

u 
Unconstrained, in Frame menu, 35 
uncovering a frame, 32 
underlining for secondary selection, 104 
underscore ( ) in text, 103 
Undo All Edits, in Text menu, 145 
Undo Last Edit, in Text menu, 24, 145 
Undo operation, 102 
Undo=>, in Text menu, 145 
undoing editing, 102 
undoing scrolling, 120 
undoing, warning, 24 
UnZoom, in Frame menu, 39, 136 
/usr/include/images directory, 132, 193 
/usr/lib/ .text_extras_menu file, 154 
/usr/lib/defaults file, 174 
/usr/lib/fonts/fixedwidthfonts directory, 178, 195 
/usr /lib/ rootmenu file, 130 

v 
Vertical_bar_placement default, 179 
view, destroying, 149 
view, splitting, 147 

w 
What Line Number?, in Text menu, 146 
window, 81 thru 88 

command, 84 
edit, 11 
emptying, 14 
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window, conlinued 
resizing, 135 
scratch, 11, 83, 175 
text, 11, 77, 82 
text handling comparison, 114 
tty, 74, 87 

windows, copying between, 101 
wiping to extend a selection, 18 
word 

defined, 103 
selecting, 17 
wrapping at, 150 

word, erasing, 96 
Wrap at Character, in Text menu, 50, 150 
Wrap at Word, in Text menu, 51, 150 
wrapping long lines, 150 
wrapping text, 48 

z 
Zoom, in Frame menu, 39, 136 

Index - Conlinued 





Sun View 1 Beginner's Guide: Quick Reference 

Function Key Accelerators 

Type4 Keyboard Menu Action Menu Other Keyboards 

(]iQji) Stop - cm 
~ 'Props' Frame (ill 
(Front) 'Front', 'Back' Frame ~ 
~ '(}pen', 'Close' Frame (Q) 
(Find J 'Find::::} Find Selection::::} Forward', Text CID 

'Find::::}Find Clipboard::::} Forward' 

~ 'Edit::::} Again' Text (ill 
(Undol 'Edit::::}Undo::::}Undo Last Edit' Text (L4l 

~ 'Edit::::}Copy' Text CI&] 
I Paste I 'Edit::::} Paste' Text (IlJ 
(Cut) 'Edit::::}Cut' Text ( LlOJ 

( Shift-Front I 'Back' Frame (Shift-LS I 
( Shift-Find ) 'Find::::}Find Selection::::}Backward', Text ( Shift-L9) 

'Find::::}Find Clipboard::::}Backward' 
( Contr21-Find ) 'Find::::}Find and Replace' 

Mouse Button Accelerators 

Frame Menu Equivalent 

Open a frame: 
Move a frame unconstrained: 

Move a frame constrained: 

Move an icon (always unconstrained): 

Resize a frame unconstrained: 

Resize a frame constrained: 

'Zoom a frame to full height: 

Un'Zoom a zoomed frame: 

Bring frame to front: 

Text ( C2ntrol-L9) 

Mouse Action 

Point to the icon and click LEFf. 

Point to a side of the frame 
border near the corner, hold 
down MIDDLE and drag the 
frame, release when the bound­
ing box is the desired size. 
Point to a side of the frame 
border near the middle, hold 
down MIDDLE and drag the 
frame, release at the desired 
position. 
Point anywhere in the icon, hold 
down MIDDLE and drag the icon 
to the new location. 
Point to a side of the frame 
border near the corner, hold 
down I Control I-MIDDLE and 
resize the frame, release at the 
desired position. 
Point to a side of the frame 
border near the middle, hold 
down ( Control I-MIDDLE and 
resize the frame, release at the 
desired position. 
Click I Control J-LEFf on the 
frame border. 
Click ( Control l-LEFf on the 
frame border of a frame that has 
been zoomed. 
Click LEFf on the frame border. 



Text in Windows and Panels 

Window Command Window Window Panel Text Item 

Caret Block cursor Caret 

Text menu Text menu with 'Cmd menu No 
Modes=>' 

Select text 1 or more chars 1 or more chars 1 or more chars Entire item 
Insert text in command At end of command At end of item 

line line 
Erase text in command From end of command From end of item 

line line 

'Copy' 1 or more chars 1 or more chars 1 or more chars Entire item 
'Paste' in command To end of command To end of item 

line line 
'Cut' Anywhere in command No Entire item 

line 
'Undo' Anywhere in command No No 

line 

Pending-delete selec- Anywhere in command No No 
ti on line 
Secondary selection - 1 or more chars 1 or more chars 1 or more chars Entire item 
source 
Secondary selection - Anywhere Anywhere in command End of command line End of item 
destination line 

Menu Accelerators 

Menu Action Keyboard Equivalent 

'File=:>Store as New File' (tl) 
'File=:>Load File' ( •-Ll 

(EK) 
'File=:>Include File' C±Ll 

I Shift-Esc I 
'File=:>Set Directory' ( Esc) 

'File=:>Empty Document' [tl) 
'Edit=> Again' (ti) 
'Edit=:> Undo' ( +-U) 
'Edit=:>Copy' ( +-C) 

'Edit=> Paste' C!;y] 
'Edit=:>Cut' ~ 
'Edit=:>Copy then Paste' CtlJ 
'Display=:>Move Caret to Start' ~(Ci.ill) 

(Shift-Control-Return J 

'Display=>Move Caret to End' ( End I ( [ Rl3 ) ) 

( Control-Return ) 

'Find=:>Find and Replace' ( Control-Find ) 

'Find=:>Match Delimiter' (•-DI 
'Find=:>Replace l>field<l=>Next' (Control-Tab) 

'Find=> Replace I> field<!=> Previous' (Shift-Control-Tab) 

'Find=>Find Selection=:>Forward' or GB 
'Find=:>Find Clipboard=:>Forward' 
'Find=:>Find Selection=:>Backward' or ( Shifi-.-FJ 
'Find=:> Find Clipboard=:>Backward' 



Erase Accelerators 

Erase Action 

Erase_ Char_Forward 

Erase_ Word_Forward 

Erase_Line_End 

Caret Accelerators 

Caret Action 

Go_ Char_Backward 

Go_ Char_Forward 

Go_ Word_Backward 

Go_ Word_End 
Go_ Word_Forward 

Go_Line_Backward 

Go_Line_End 

Go_Line_Forward 

Go_Column_Backward 

Go_ Column_Forward 

Go_Document_Start 

Go_Document_End 

Other Keyboard Accelerators 

Other Action 

Caps_Lock 
Quote I 

Keyboard Equivalent 

( R 10 ) (left arrow) 
( Control-B ) 

I Shift-Control-F ) 
(fil2J (right arrow) 
I Control-F ) 

I Shift-Control-B I 
I Control-comma ) (,) 

I Shift-Control-slash l ({) 
(Shift-Control-period J (.) 

I Control-period)(.) 
( Control-slash ) ({) 

I Shift-C2ntr2h~omma ) (,) 
(Control-A) 

I Shift-Control-E ) 

I Control-EI 
I Shift-Control-A l 

CiillJ 
(Control-semicolon l (;) 
I R8 I (up arrow) 
I Control-P ) 

I Shift-CQntrol-N ) 
I Rl4) (down arrow) 
( Control-N ) 

( Shift-Control-P) 

I R7 J ( ( Home)) 

( Shift-Control-Return ) 
I R13 ) ( ( End I) 
I ~Qlllr21-R~tym l 

Keyboard Equivalent 
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